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Legal Information
The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this guide are the property of Schneider Electric SE or its
subsidiaries. All other brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and furnished
for informational use only. No part of this guide may be reproduced or transmitted in any
form or by any means (electronic, mechanical, photocopying, recording, or otherwise),
for any purpose, without the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide or
its content, except for a non-exclusive and personal license to consult it on an "as is"
basis. Schneider Electric products and equipment should be installed, operated,
serviced, and maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information
contained in this guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by
Schneider Electric and its subsidiaries for any errors or omissions in the informational
content of this material or consequences arising out of or resulting from the use of the
information contained herein.



Purpose of This Guide
This guide provides information about WorkStation, such as logging on, monitoring alarms,
and editing schedules. This information is intended to help you understand WorkStation so
you can perform common tasks.

The procedures described in this guide are intended to reflect best cybersecurity practices.
In the event that you suspect the information is not correct, please contact your Schneider
Electric representative and report your finding.



Safety Information
Important Information

Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following
special messages may appear throughout this bulletin or on the equipment to warn
of potential hazards or to call attention to information that clarifies or simplifies a
procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury
hazards. Obey all safety messages that follow this symbol to avoid possible injury
or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death
or serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.



Please Note
Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction,
installation, and operation of electrical equipment and has received safety training to
recognize and avoid the hazards involved.

Cybersecurity Safety Notice

NOTICE
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

• Change default passwords at first use to help prevent unauthorized access to device
settings, controls, and information.

• Change passwords regularly to help prevent unauthorized access to device settings,
controls, and information.

• Do not share accounts. Each user must have their own account.

• When creating user and display names, it is important to avoid using personal
information, and to consider regional privacy policies. Display names will appear in
event logs to identify who performed operations on the device.

• It is recommended that log files be encrypted before transmission to help with security
and privacy.

• Disable unused ports, services, and default accounts to help minimize pathways for
malicious attackers.

• Place networked devices behind multiple layers of cyber defenses (such as firewalls,
network segmentation, and network intrusion detection and protection).

• Use the recommended cybersecurity safety measures (for example, least privilege,
separation of duties) to help prevent unauthorized exposure, loss, modification of data
and logs, or interruption of services.

FailureFailure toto followfollow thesethese instructionsinstructions cancan resultresult inin lossloss ofof data,data, unauthorizedunauthorized systemsystem
access,access, oror equipmentequipment damage.damage.

How to Report a Cybersecurity Vulnerability
In the event that a security vulnerability is discovered or suspected, the portal found at
www.se.com/ww/en/work/support/cybersecurity/report-a-vulnerability.jsp is to be used for
reporting and to establish communication around suspected issues.

https://www.se.com/ww/en/work/support/cybersecurity/report-a-vulnerability.jsp


Where to Find Additional Information
All the technical EcoStruxure BMS information is available online, on WebHelp.

WebHelp is a web-based help system for the EcoStruxure Building Operation software and
SpaceLogic devices, the software and hardware that powers the EcoStruxure BMS.

By pressing F1 or clicking a Help button in the EcoStruxure Building Operation software
your web browser opens WebHelp with the latest, up-to-date, technical documentation.

Figure – Help in EcoStruxure Building Operation software

Some EcoStruxure Building Operation software products give you context-sensitive help
by opening a WebHelp page that explains the view or dialog box you have in focus. Some
programs open up an overview page. From these pages, you can follow the links to get
more detailed information.

WebHelp contains all the technical information that is in the guides, specification sheets,
and installation sheets.

The WebHelp site

One of the advantages with WebHelp is that you can reach Help without having the
EcoStruxure Building Operation software installed on your computer. By entering the URL
address https://ecostruxure-building-help.se.com/bms you can access WebHelp from any
computer, smartphone, or tablet connected to the internet.

Finding information

The easiest way to find information on WebHelp is to search for it.

Figure – Home page search

All technical information is gathered in one place, so you do not need to know which guide,
specification sheet, or installation sheet the information is in.

Filtering the information

To narrow down the search results, you can use these filters:

• Product

• Functionality

• Information type



Figure – Search filters
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1.1 WorkStation Overview
WorkStation is your main interface to your EcoStruxure BMS. You use WorkStation to
perform all work on a daily basis in the EcoStruxure BMS.

1.1.1 Log on to WorkStation

You log on to WorkStation to securely access the functions in WorkStation. You log on
to WorkStation as a Windows user or an EcoStruxure Building Operation user. Your
system administrator decides which type of user you log on as.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

1.1.2 System Registration

As the owner, you register your EcoStruxure BMS to ensure that you are informed of
the latest product news, relevant offers, and system updates. This information enables
you to optimize maintenance and functionality of your system, protect asset value, and
produce a healthier building for optimal comfort conditions.

For more information, see section 2.1 “System Registration” on page 25.
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1.1.3 User Experience

The Work area in the EcoStruxure Building Operation user interfaces may vary
depending on how it is set up. A typical EcoStruxure Building Operation workspace
contains panes and views.

For more information, see section 3.1 “User Experience” on page 30.

1.1.4 Customization

In WorkStation you can customize your workspace to some extent. You can, for
example, decide where workspace components, such as, Alarms are displayed.

For more information, see section 4.1 “Customization” on page 37.

1.1.5 Basic Functions

To get a better view of the objects in views and lists, you can use a number of functions
like filtering, grouping, and sorting.

For more information, see section 5.1 “Basic Functions” on page 42.

1.1.6 Handle Values

You can change and force values using a graphic or the Properties pane. Using the
Watch pane in WorkStation, you can dynamically monitor a value.

For more information, see section 6.1 “Modify Values ” on page 52.

1.1.7 How Alarms Work

You are notified by alarms when some important event occurs. For example, if the
temperature is too low or too high in a building, if a window is open, or if something is
broken, such as a fan. The system administrator sets up the alarms and decides to
whom the alarm is sent.

For more information, see section 8.1 “How Alarms Work” on page 60.

1.1.8 How Events Work

All system events, as well as information and circumstances, are recorded in the Event
log. These event records can be viewed in the Events pane or in an Event View.

For more information, see section 12.1 “How Events Work ” on page 82.

1.1.9 How Schedules Work

Schedules are used to schedule the operation of part of the building management
system, such as a fan, a door, or a setpoint. Using a schedule, a fan can be set to
operate between 08:00 and 17:00 every workday.

For more information, see section 16.1 “How Schedules Work” on page 149.
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1.1.10 How Trend Logs Work

You use trend logs to record values, such as a sensor. A trend log can also log
consumptions, such as energy consumption or water consumption.

For more information, see section 15.1 “How Trend Logs Work” on page 127.

1.1.11 How Graphics Work

You use graphics to display building overviews, display values from sensors, or change
setpoints. A graphic can also contain links to trend charts, trend log lists, Internet sites,
or views in WorkStation and WebStation.

For more information, see section 19.1 “How Graphics Work” on page 185.

1.1.12 How Documents Work

You can open documents stored on an EcoStruxure BMS server using the default
program associated with the file type. For example, a txt-file opens Notepad and a ppt-
file opens PowerPoint.

For more information, see section 20.1 “How Documents Work ” on page 188.

1.1.13 WorkStation Help

WorkStation Help provides you with information on how to handle and understand the
EcoStruxure BMS.

For more information, see section 7.1 “WorkStation Help” on page 58.

1.2 Starting WorkStation
You start WorkStation to be able to view the information in your EcoStruxure BMS.

To start WorkStation

1. Click Start, point to All Programs, and then click Schneider Electric
EcoStruxure.

2. Click Building Operation x.y.

3. Click WorkStation Building Operation x.y.

1.3 Log on to WorkStation or WebStation
You log on to WorkStation or WebStation to securely access the EcoStruxure Building
Operation functions.

1.3.1 Log on to WorkStation

You log on to WorkStation with your current Windows credentials, as another Windows
user, or as an EcoStruxure Building Operation user. Your system administrator decides
which type of user you log on as.
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To log on to WorkStation using an EcoStruxure Building Operation account, you need to
know the following account information:

• User name

• Password

• Domain

• EcoStruxure BMS server

To log on to WorkStation using a Windows account, you need to know the EcoStruxure
BMS server.

The account information for both the EcoStruxure Building Operation account and the
Windows account is provided by the system administrator.

IMPORTANT: Ensure that you have a working and available WorkStation license.
A working license is required to log on to WorkStation. For more information, see
the Licenses topic on WebHelp.

Remember me on this computer

For a faster log on in Workstation, use the Remember me feature to automatically fill in
your user name, password, domain and server. Both Building Operation users and
Windows users can use the Remember me feature.

Add a display name of the server address

When you log on to a new server, its IP address is added to the server list. You can add
a display name of the server address to make it easier to find your server in the list.

1.3.2 Log on to WebStation

To log on to WebStation, you need to know the following account information:

• User name

• Password

• Domain

• EcoStruxure BMS server

The account information for your account is provided by the system administrator.

1.4 Logging on to WorkStation using your Windows user
account

You log on to WorkStation to securely access the functions in the EcoStruxure BMS.

IMPORTANT: Ensure that you have a working and available WorkStation license.
A working license is required to log on to WorkStation. For more information, see
the Licenses topic on WebHelp.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.
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Continued on next page

To log on to WorkStation using your Windows user account

1. Select a Server hypertext transfer protocol option for communciation with the
EcoStruxure BMS server.

2. In the Server box, enter an EcoStruxure BMS server name or an IP address.

NOTE: You can also, in the scroll down menu, choose a server host name
from the list. When you start typing the host name or the IP number of the
server, you will be offered suggestions from the saved list.

NOTE: When you log on to a new server, its IP address is added to the server
list. You can add a display name of the server address to make it easier to find
your server in the list.

3. Select Log on as to log on under the Windows user account you used to log on to
the computer.

4. Select Remember me on this computer to have WorkStation remember your
settings.

5. Click Log on.

6. You can register the system now or later:

• Click Register now to register your system. For more information, see section
2.1 “System Registration” on page 25.

• Click Register later to skip registration and register at a later time.

1.5 Logging on to WorkStation as another Windows User
You log on to WorkStation as another user than the current Windows user logged on to
the computer to securely access the functions in the EcoStruxure BMS.

IMPORTANT: Ensure that you have a working and available WorkStation license.
A working license is required to log on to WorkStation. For more information, see
the Licenses topic on WebHelp.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To log on to WorkStation as another Windows user

1. In WorkStation, in the User name box, type the name of the Windows user
account you want to use to log on.

2. In the Password box, type the Windows password for the user account.

3. In the Domain box, type a Windows domain name. If you do not enter a domain
name, you are logged on to the local domain as an EcoStruxure Building
Operation User.
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Continued on next page

4. Select the HTTPS protocol option for communication with the EcoStruxure BMS
server.

5. In the Server box, enter an EcoStruxure BMS server name or an IP address.

NOTE: You can also, in the scroll down menu, choose a server host name
from the list. When you start typing the host name or the IP number of the
server, you will be offered suggestions from the saved list.

NOTE: When you log on to a new server, its IP address is added to the server
list. You can add a display name of the server address to make it easier to find
your server in the list.

6. Select Remember me on this computer to have WorkStation remember your
settings.

7. Click Log on.

8. In the Registering Your System Online dialog box, you can register the system
now or later:

• Click Register now to register your system. For more information, see section
2.1 “System Registration” on page 25.

• Click Register later to skip registration and register at a later time.

1.6 Logging on to WorkStation as an EcoStruxure Building
Operation User

You log on to WorkStation to securely access the functions in the EcoStruxure BMS.

IMPORTANT: Ensure that you have a working and available WorkStation license.
A working license is required to log on to WorkStation. For more information, see
the Licenses topic on WebHelp.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To log on to WorkStation as an EcoStruxure Building Operation
user

1. In the User name box, type the EcoStruxure Building Operation user name.

2. In the Password box, type the password.
3. In the Domain box, type a domain name. If you do not enter a domain name, you

are logged on to the local domain.

4. Select the Server hypertext transfer protocol option for communication with the
EcoStruxure BMS server.
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5. In the Server box, enter an EcoStruxure BMS server name or an IP address.

NOTE: You can also, in the scroll down menu, choose a server host name
from the list. When you start typing the host name or the IP number of the
server, you will be offered suggestions from the saved list.

NOTE: When you log on to a new server, its IP address is added to the server
list. You can add a display name of the server address to make it easier to find
your server in the list.

6. Select Remember me to have WorkStation remember your settings.

7. Click Log on.

8. You can register the system now or later:

• Click Register now to register your system. For more information, see section
2.1 “System Registration” on page 25.

• Click Register later to skip registration and register at a later time.

9. If the Select Default Workspace window is displayed, click the workspace you
want to have as the default.

1.7 Saving Log On Details
For a faster logon, use the Remember me feature to automatically fill in your logon
information.

NOTE:
• For security reasons, your password is not automatically filled in.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To save your log on details

1. In the Welcome window, select Remember me on this computer.

2. Click Log on.

1.8 Adding a Display Name of the Server Address
You add a display name of the server address to easier find your server in the list.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To add a display name of the server address

1. In the WorkStation window, on the server addresses drop-down list box,
highlight the IP address of the server you want to add the display name to.

2. Click the Edit button .
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3. In the Edit Server dialog box, in the Name box, type the display name of your
server.

4. Click OK.

1.9 Editing the Display Name of the Server Address
You edit the display name of the server address when you need to change it.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To edit the display name of the server address

1. In the WorkStation window, on the server addresses drop-down list box,
highlight the IP address of the server you want to edit the display name of.

2. Click the Edit button .

3. In the Edit Server dialog box, in the Name box, type the display name of your
server.

4. Click OK.

1.10 Deleting the Display Name and the IP Address of a Server
You delete the display name of the server address and/or the IP address of a server
from the list when you no longer need it.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To delete the display name and the IP address of a server

1. In the WorkStation window, on the server addresses drop-down list box,
highlight the IP address of the server you want to delete the settings of.

2. Click the Delete button .

1.11 Exporting the List of the Display Names and IP Addresses
of Servers

You export the list of the display names of server addresses and IP addresses of
servers to share it with other users of WorkStation and help them organizing their own
list of display names easier.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.
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To export the list of the display names and IP addresses of servers

1. In the WorkStation window, on the server addresses drop-down list box, click the

Export button .

2. In the Save as dialog box, browse to the location where you want to save your file.

3. Click Save.

1.12 Importing a List of the Display Names and IP Addresses of
Servers

You import a list of the display names and IP addresses of servers if you want to
organize your display list easier.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To import a list of the display names and IP addresses of servers

1. In the WorkStation window, on the server addresses drop-down list box, click the

Import button .

2. In the Open dialog box, browse to the location where your file is saved.

3. Click Open.

The display names and IP addresses of servers from the imported file are now visible in
the drop-down list box.

1.13 Clearing the List of the Display Names and IP Addresses of
Servers

You clear the list of the display names and IP addresses of servers when you do not
need the contents anymore.

For more information, see section 1.3 “Log on to WorkStation or WebStation” on page
17.

To clear list of the display names and IP addresses of servers

1. In the WorkStation window, on the server addresses drop-down list box, click the

Remove all button .

The server addresses drop-down list box is now empty.

1.14 Changing Your Password
You change your EcoStruxure Building Operation user password on a regular basis to
keep your information secure.
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To change your password

1. In WorkStation, on the File menu, click Change Password.

2. In the Change Password dialog box, in the Old Password box, type your current
password.

3. In the New password box, type your new password.

4. In the Confirm password box, type your new password again.

5. Click OK.

1.15 Logging Off WorkStation
You log off WorkStation so that unauthorized personnel cannot tamper with your
settings. Logging off does not close WorkStation.

To log off WorkStation

1. In WorkStation, on the File menu, click Log Off.

1.16 Exiting WorkStation
You exit WorkStation to log off and close the application.

To exit WorkStation

1. In WorkStation, on the File menu, click Exit.
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2.1 System Registration
As the owner, you register your EcoStruxure BMS to ensure that you are informed of
the latest product news, relevant offers, and system updates. This information enables
you to optimize maintenance and functionality of your system, protect asset value, and
produce a healthier building for optimal comfort conditions.

You register your EcoStruxure BMS online or offline through EcoStruxure Building
Operation WorkStation. If you register online, the registration information you provide is
displayed in the WorkStation and WebStation log on page.

For more information, see section 2.2 “Online Registration ” on page 26.

For more information, see section 2.5 “Offline Registration” on page 27.

You can verify and edit your registration details any time when needed.

There are several registration options:

• You can register a stand-alone Automation server.

• You can register an Enterprise Server together with connected Automation servers.

• You can register an Enterprise Central server together with connected Enterprise
Servers and Automation servers.

Regardless of your system complexity, you register only the server from the top level of
your hierarchy. Lower tier servers inherit registration information. The system will use
the existing registration whenever possible.

2.1.1 Online Registration

You register an EcoStruxure BMS online when the EcoStruxure Building Operation
WorkStation is connected to the Internet.

For more information, see section 2.2 “Online Registration ” on page 26.
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2.1.2 Offline Registration

You register an EcoStruxure BMS offline when the system is not connected to the
Internet. If there is no Internet connection, the system prompts you to offline
registration.

For more information, see section 2.5 “Offline Registration” on page 27.

2.2 Online Registration
You register an EcoStruxure BMS online when the EcoStruxure Building Operation
WorkStation is connected to the Internet.

After you register online, the registration information you provided is displayed at the
WorkStation and WebStation logon page.

2.3 Registering an Online System
You register an EcoStruxure BMS online when the system is connected to the Internet.

For more information, see section 2.2 “Online Registration ” on page 26.

To register an online system

1. On the WorkStation logon page, in the User name box, type a user name.

2. In the Password box, type the password.

3. Click Register.

4. At the registration website, at the Installation and System Information page, in
the Site/building name box, type the site/building name where the system is
being installed.

NOTE: Required information is marked with a red star.

5. In the Site company name box, type the company name.

6. In the Site/building address box, type the site or the building address.

7. In the Country box, select the country to which the site or the building belongs.

8. In the State/province box, select the state or the province to which the site or the
building belongs.

9. In the City box, select the city to which the site or the building belongs.

10. In the Zip/postal code box, type the zip or the postal code.

11. In the Email address box, type the email address.

12. In the Confirm email box, type the email address again.

13. In the Segment /application section, select the business segments you belong to.
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14. Click Submit.

NOTE: A confirmation of your registration is sent to the email address you
provided.

2.4 Editing Registration of an Online System
You edit your Installation and System Information to update your contact information.

For more information, see section 2.2 “Online Registration ” on page 26.

To edit registration of an online system

1. On the WorkStation logon page, in the User name box, type a user name.

2. In the Password box, type the password.

3. Click Edit registration.

4. At the registration website, at the Installation and System Information page, in
the Site/building name box, type the site/building name where the system is
being installed.

NOTE: Required information is marked with a red star.

5. In the Site company name box, type the company name.

6. In the Site/building address box, type the site or the building address.

7. In the Country box, select the country to which the site or the building belongs.

8. In the State/province box, select the state or the province to which the site or the
building belongs.

9. In the City box, select the city to which the site or the building belongs.

10. In the Zip/postal code box, type the zip or the postal code.

11. In the Email address box, type the email address.

12. In the Confirm email box, type the email address again.

13. In the Segment /application section, select the business segments you belong to.

14. Click Submit.

NOTE: A confirmation of your registration is sent to the email address you
provided.

You now updated your contact information.

2.5 Offline Registration
You register an EcoStruxure BMS offline when the system is not connected to the
Internet. If there is no Internet connection, the system prompts you to offline
registration.
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When you register offline, you access the registration website on a computer that has
Internet access.

After you register offline, the registration information you provided is not displayed at the
WorkStation and WebStation logon page.

2.6 Registering an Offline System
You register an EcoStruxure BMS offline when the system is not connected to the
Internet.

For more information, see section 2.5 “Offline Registration” on page 27.

To register an offline system

1. On the WorkStation logon page, in the User name box, type a user name.

2. In the Password box, type the password.

3. Click Register.

4. In the Registering Your System Offline dialog box, observe the System
Identifier.

5. In a computer with Internet in the browser go to
https://registration.smartstruxure.schneider-electric.com/ebo

6. In the Registering an Offline System window, in the System ID box, type the
system identifier.

7. At the registration website, at the Installation and System Information page, in
the Site/building name box, type the name of the site or of the building where the
system is being installed.

NOTE: Required information is marked with a red star.

8. In the Site company name box, type the company name.

9. In the Site/building address box, type the site or the building address.

10. In the Country box, select the country to which the site or the building belongs.

11. In the State/province box, select the state or the province to which the site or the
building belongs.

12. In the City box, select the city to which the site or the building belongs.

13. In the Zip/postal code box, type the zip or the postal code.

14. In the Email address box, type the email address.

15. In the Confirm email box, type the email address again.

16. In the Segment/application section, select the business segments you belong to.
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17. Click Submit.

NOTE:
• A confirmation of your registration is sent to the email address you

provided.
• WorkStation and WebStation display information that your system is

registered, but do not display registration details.

2.7 Editing Registration of an Offline System
You edit your Installation and System Information to update your contact information.

For more information, see section 2.5 “Offline Registration” on page 27.

To edit registration of an offline system

1. In a computer with Internet, in the browser, go to http://qa-
registration.smartstruxure.schneider-electric.com

2. In the Registering an Offline System window, in the System ID box, type the
system identifier.

3. At the registration website, at the Installation and System Information page, in
the Site/building name box, type the site/building name where the system is
being installed.

NOTE: Required information is marked with a red star.

4. In the Site company name box, type the company name.

5. In the Site/building address box, type the site or the building address.

6. In the Country box, select the country to which the site or the building belongs.

7. In the State/province box, select the state or the province to which the site or the
building belongs.

8. In the City box, select the city to which the site or the building belongs.

9. In the Zip/postal code box, type the zip or the postal code.

10. In the Email address box, type the email address.

11. In the Confirm email box, type the email address again.

12. In the Segment /application section, select the business segments you belong to.

13. Click Submit.

NOTE:
• A confirmation of your registration is sent to the email address you

provided.

You now updated your contact information.
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3.1 User Experience
The Work area in the EcoStruxure Building Operation user interfaces may vary
depending on how it is set up. A typical EcoStruxure Building Operation workspace
contains panes and views.

3.1.1 Workspaces

The workspace in WorkStation and WebStation is the area where you perform all tasks
at your site, such as acknowledging alarms and viewing trend logs.

For more information, see section 3.2 “Workspaces” on page 31.

3.1.2 Different Layouts Using Panes

A pane is a separate area in the workspace. You use panes to carry out commands,
navigate the system or display information. Panes can be moved, hidden, closed, and
repositioned.

For more information, see section 3.4 “Different Layouts Using Panes” on page 32.

3.1.3 WorkStation Shortcut keys

To ease the daily operation, you can use shortcut keys to most of the commands
inWorkStation.

For more information, see section 3.5 “Keyboard Shortcuts for WorkStation” on page
34.

3.1.4 Windows

You can navigate between the available open windows in the Work area. The windows
you can select using the Window menu are represented by tabs in the Work area.

For more information, see section 3.7 “Window Menu” on page 36.
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3.2 Workspaces
The workspace in WorkStation and WebStation is the area where you perform all tasks
at your site, such as acknowledging alarms and viewing trend logs.

The workspace is made up of different components, such as panes, lists, and views.
These components can be configured in a number of different ways. You can hide or
display components and create and save your own workspace. You can also reset the
workspace layout to the default layout for the user group your user account belongs to.

WebStation uses cookies to remember your workspace when you log off. When you log
on again, you get the workspace you used when you logged off. If you clear your web
browser, you will regain the default workspace.

Some objects have specific views in WorkStation and WebStation:

• Alarms

• Documents

• Graphics (TGML)

• Events

• Trend Charts

• Trend Log Lists

• Schedules

• Calendars

• Watch

When you open an object that does not have a specific view, the Properties dialog box
for that object is displayed.

3.2.1 Panels

Panels are a way to create workspaces that display two or more components in the
EcoStruxure Building Operation software, for example graphics, trend charts, trend list
and alarm views.

For more information, see the Panels topic on WebHelp.

3.2.2 Favorite Pages

You can add pages that you often visit as favorite pages. This makes the favorite pages
more accessible.

For more information, see the Favorite Pages topic on WebHelp.

3.2.3 External Contents

External contents, such as web pages, cannot be opened inside WebStation for
security reasons.
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3.3 Switching Workspaces
You switch workspaces when you want to use another workspace, such as one with
predefined functionality.

For more information, see section 3.2 “Workspaces” on page 31.

To switch workspaces

1. In WorkStation, on the View menu, point to Workspaces, and then click the
workspace you want to switch to.

3.4 Different Layouts Using Panes
A pane is a separate area in the workspace. You use panes to carry out commands,
navigate the system or display information. Panes can be moved, hidden, closed, and
repositioned.

A pane is integrated into the WorkStations workspace and can be moved around inside
the workspace. You can move a docked pane by dragging the pane in the Work area. A
blue rectangle shows where the pane can be placed.

Figure – Docked panes in WorkStation
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The docking tool helps you to position and reposition a pane.

Figure – Docking tool

Figure – Docked panes. System Tree pane (left), a graphic in the Work area (right) and the Alarms pane
(bottom).
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Auto Hidden Pane

An auto hidden pane is hidden in the workspace with the exception of a tab with the
name of the pane. When you place the cursor over the tab the pane will expand and be
visible.

Figure – An auto hidden pane is only represented in by a tab, in this case the System
Tree pane

Hidden Pane

A Hidden pane is completely hidden in WorkStation. The only way to make it visible is to
select it in the View menu.

Resizing a Pane

Panes can be resized by moving the borders of the pane.

3.5 Keyboard Shortcuts for WorkStation
To ease the daily operation, you can use shortcut keys to most of the commands
inWorkStation.

Shortcut key Command

Ctrl + Tab Shift between tabs

F1 Open help

F2 Rename
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Continued

Shortcut key Command

F3 Open Search

F5 Refresh

F11 Change normal mode and full screen mode

Ctrl + A Select all

Ctrl + B Edit bindings

Ctrl + D Deselect all

Ctrl + E Edit

Ctrl + Shift + E Action -->View --> Events

Ctrl + N New ...

Ctrl + O Open

Shift + O Open in new window

Ctrl + P Print ...

Ctrl + R Properties

Ctrl + Shift + R Shortcut Properties

Ctrl + S Save

Ctrl + Shift + S Save as ...

Ctrl + X Cut

Ctrl + Z Cancel

Ctrl + V Paste

Ctrl + Shift + V Paste as shortcut

Ctrl + W Save workspace layout

Del Delete

Ctrl + F2 Print Preview

Alt + F4 Exit

Shift + F4 Close Window

Ctrl + Shift + F4 Close all windows

Ctrl + 1 Alarms pane

Ctrl + 2 System Tree pane

Ctrl + 3 Events pane

Ctrl + 4 Watch pane

Alt + --> Forward (history)

Alt + <-- Back (history)
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3.6 Selecting a Default Workspace
You select the workspace that you want to use when you log on to WorkStation for the
first time.

For more information, see section 3.2 “Workspaces” on page 31.

To select a default workspace

1. In WorkStation, in the Select Default Workspace dialog box, click the workspace
you want to use as your default workspace.

The selected workspace is your default workspace the next time you log on to
WorkStation.

3.7 Window Menu
You can navigate between the available open windows in the Work area. The windows
you can select using the Window menu are represented by tabs in the Work area.

The objects in the Window menu reflects the open Windows in the Window pane.

Figure – You can use the Windows menu to navigate between open windows in the
Work area.
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4.1 Customization
In WorkStation you can customize your workspace to some extent. You can, for
example, decide where workspace components, such as, Alarms are displayed.

You can configure the workspace layout, for example, to display different workspace
items on different monitors or to change the size of a pane to improve readability. When
you save the modified workspace layout, it is saved on the local computer. If you log on
to WorkStation on another computer you cannot access the customized layout. The
modified workspace layout is displayed the next time you log on to WorkStation.

You can switch the following bars on or off:

• Address bar

• Menu bar

• Toolbar

• Status bar

• Search bar

• History bar

For each window, pane, or work area in the workspace the user can modify the
following:

• Auto hide on/off

• Closed on/off

• Floating on/off

• Position

You can reset a modified workspace layout on the local computer. In this case, you
return to the default workspace layout that applies for your user account.
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4.2 Increase the Work Area in WorkStation
You can increase the Work area in WorkStation by using Full screen mode and hiding
toolbars and panes.

4.2.1 Hide Toolbars and Panes

You can increase the work area in WorkStation by hiding some or all of the toolbars and
panes. Most functions can still be reached using the right-click method. All toolbars and
panes that are hidden can be displayed again at any time.

In this example, the System Tree pane, Address bar, Basic toolbar, and Main menu are
hidden.

Figure – Default workspace (top left) and a workspace with the System Tree pane, Address bar, Basic toolbar,
and Main menu hidden (bottom right).

4.2.2 Full Screen Mode

To further increase the Work area you can use Full screen mode. This function
maximizes the window in focus to fill the whole screen. This is a good function to use,
for example, when you work in large graphics with lots of information.
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Figure – Full screen mode

4.3 Using Full Screen Mode
You use full screen mode to maximize the Work area so that you get a better view.

For more information, see section 4.2 “Increase the Work Area in WorkStation” on page
38.

To use full screen mode

1. In WorkStation, on the Main Menu, click View, and then click Full screen.

4.4 Returning from Full Screen Mode
You return to normal mode from full screen mode when you want to access toolbars
and panes.

For more information, see section 4.2 “Increase the Work Area in WorkStation” on page
38.

To return from full screen mode

1. Press F11 on the keyboard.
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4.5 Hiding Menus and Toolbars
You hide the main menus and toolbars if you do not use them or think they take up to
much space.

For more information, see section 4.2 “Increase the Work Area in WorkStation” on page
38.

To hide menus and toolbars

1. In WorkStation, click View, point to Toolbars, and then click the menus and
toolbars you want to hide.

4.6 Hiding Panes
You hide panes if you do not use them or think they take up too much space.

For more information, see section 3.2 “Workspaces” on page 31.

To hide panes

1. In WorkStation, click View and then click the panes you want to hide.

4.7 Resetting the Workspace Layout
You reset the workspace layout to return to the default workspace layout for your user
account.

For more information, see section 4.1 “Customization” on page 37.

To reset the workspace layout

1. In WorkStation, on the View menu, click Reset workspace layout.

The workspace layout is reset to the default workspace for your user account.

4.8 Resetting All User Settings
You reset all user settings to clear all modifications you have made to WorkStation on
the local computer and return to the default settings that apply for your user account.

For more information, see section 4.1 “Customization” on page 37.

To reset all user settings

1. In WorkStation, on the Tools menu, click Options.

2. Click Reset all user settings.

3. Click OK.

4.9 Showing a Hidden Main Menu
You show a hidden main menu when you want it to be visible.

For more information, see section 4.1 “Customization” on page 37.
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To show a hidden Main menu

1. In WorkStation, right-click the toolbar and then select Main menu.



Filtering and Grouping

42 04-50007-01-en, December 2022

WorkStation

5 Filtering and Grouping
What's in This Chapter?
5.1 Basic Functions .................................................................................................... 42
5.2 Filter Objects Using Column Headings ................................................................. 43
5.3 Filtering Objects ................................................................................................... 44
5.4 Clearing the Filter ................................................................................................ 44
5.5 Columns ............................................................................................................... 44
5.6 Changing the Alarm State Sort Order ................................................................... 45
5.7 Group and Sort Objects ........................................................................................ 46
5.8 Grouping Objects ................................................................................................. 47
5.9 Sorting Objects ..................................................................................................... 48
5.10 Removing a Group ............................................................................................. 49
5.11 Quick Filter ........................................................................................................ 49
5.12 Show Abbreviated References ........................................................................... 51
5.13 Showing Abbreviated References ...................................................................... 51

5.1 Basic Functions
To get a better view of the objects in views and lists, you can use a number of functions
like filtering, grouping, and sorting.

5.1.1 Filter Objects Using Column Headings

You can filter objects on the properties available for each displayed column in panes
and views. This makes it easier to get an overview of all objects.

For more information, see section 5.2 “Filter Objects Using Column Headings” on page
43.

5.1.2 Columns

In WorkStation, panes and views present information in lists. You can customize the
contents of the lists by adding and removing columns.

For more information, see section 5.5 “Columns” on page 44.

5.1.3 Group and Sort Objects

You can group objects using the group function in a pane or View.

For more information, see section 5.7 “Group and Sort Objects” on page 46.

5.1.4 Quick Filter

Using the Quick filter you can filter objects on all properties in a pane or View. Filtering
can be done on whole words down to solitary letters.
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For more information, see section 5.11 “Quick Filter ” on page 49.First para

5.1.5 Alarm and Event Detail View

Use the Detail view to view all properties of a selected alarm or event.

For more information, see section 21.51 “Alarm and Event Detail View ” on page 265.

5.1.6 Show Abbreviated References

References in the List view are abbreviated to save space. An abbreviated reference
might only display the first part of the reference but sometimes the last part is the most
important one. You can have the system only show the last part of the reference in the
list.

For more information, see section 5.12 “Show Abbreviated References” on page 51.

5.2 Filter Objects Using Column Headings
You can filter objects on the properties available for each displayed column in the List
View. This makes it easier to get an overview of all objects.

You filter the objects using the filter function in the column heading. You select the
criteria in the filter drop-down list.

For example, you can filter on all objects that are set to '21' in the Value column in the
List View.

Figure – The filter function in the List View in WorkStation

You can filter objects in the following panes and views in WorkStation:

• List View

• Alarms pane

• Events pane

• Watch pane
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You cannot filter the timestamp column. By default, the filter settings are not saved
when you close the view or pane. You cannot save the filter settings in Favorites or in a
Content type.

5.3 Filtering Objects
You filter objects in the List View in WorkStation when you want to reduce the number
of displayed objects.

For more information, see section 5.2 “Filter Objects Using Column Headings” on page
43.

To filter objects

1. In WorkStation, click the arrow in the column heading.

2. Select the properties you want to display.

5.4 Clearing the Filter
Clear the filter when you do not need it anymore.

For more information, see section 5.2 “Filter Objects Using Column Headings” on page
43.

To clear the filter

1. In WorkStation, click the arrow in the column heading.

2. Click (Clear filter).

5.5 Columns
In WorkStation, panes and views present information in lists. You can customize the
contents of the lists by adding and removing columns.

Columns are available in the following views and panes:

• List View

• Alarms pane

• Alarm Views

• Events pane

• Event Views

• Watch pane

• Watch Views

• Trend Log List View
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Column changes to the List View are automatically saved when you leave the view. You
can save column changes to the Alarms pane, Alarm View, Events pane, or Event View
as a standard layout or as a favorite depending on your permissions. You have to
manually save column changes to the Watch pane and Watch Views before leaving the
pane or view. Column changes to the Trend Log List View cannot be saved.

You use the column headings to sort information. For more information, see section 5.7
“Group and Sort Objects” on page 46.

The contents of the columns reflect the properties of the presented object in the pane or
view. Using Quick filter, you can narrow the number of objects displayed in the list. For
more information, see section 5.11 “Quick Filter ” on page 49.

Figure – The Add/Remove Columns dialog box in WorkStation

5.6 Changing the Alarm State Sort Order
You change the sort order of the alarm states to display alarms in the Alarms pane or an
Alarm View in the order you choose.

IMPORTANT:
• For the changes to be saved, you must have permissions to change the alarm

state sort order.
• If you have permission to change the alarm state sort order, the change affects

all users and all Alarm Views in the system.

For more information, see section 5.7 “Group and Sort Objects” on page 46.
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To change the alarm state sort order

1. In WorkStation, right-click in the Alarms pane or in an Alarm View.

2. Point to Alarm View settings and then click Alarm state sort order.

3. In the Alarm State Sort Order dialog box, select the state you want to reposition.

4. Click the up or down arrow to change the sort order.

5. Repeat the operation to reposition other states.

6. Click OK.

If you have permission to change the alarm state sort order, the changes are saved for
all users and all alarm views in the system. If you do not have permission to change the
alarm state sort order, the change is temporary.

5.7 Group and Sort Objects
To get a better view of the objects in views and lists, you can use a number of functions
like filtering, grouping, and sorting.

You can group objects to display them in a specific way, for example, by their priority or
name. You can also add sub groups by adding new columns to a group.

You can change from descending to ascending sort order by using the small arrow in
the column heading. You can also sort alarms on, for example, state or priority by
adding columns that contain the information you want to sort by. You can sort on
several columns by pressing SHIFT and then sorting a new column. The sorting is done
in the order in which you added a new sorting.

Example:

You sort by alarm state and then priority. First of all the alarms are sorted by their state.
If several alarms have the same state, they are sorted by priority.

Group and sort order changes to the List View are saved when you close or leave the
list. You have to manually save other changes to panes and Views.
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Figure – Objects in the List View grouped by Name and Value and sorted in ascending order

You can group and sort objects in the following panes and views in WorkStation:

• List View

• Alarms pane

• Alarm Views

• Events pane

• Event Views

• Watch pane

• Watch Views

• Trend Log List View

5.8 Grouping Objects
You group objects using the Group function to get a better overview of the objects, for
example, in a folder or a list.
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For more information, see section 5.7 “Group and Sort Objects” on page 46.

To group objects

1. In WorkStation, in the pane or View, right-click the column heading row and then
click Group box.

2. Drag the column heading you want to group on to the group area.

You add more groups by dragging the column headings to the group area.

5.9 Sorting Objects
You sort objects to change the sort order the objects are presented in.

For more information, see section 5.7 “Group and Sort Objects” on page 46.

To sort objects

1. In WorkStation, in the pane or View, click the column heading.
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5.10 Removing a Group
You remove a group and hide the group area when you do not need to use it anymore.

For more information, see section 5.7 “Group and Sort Objects” on page 46.

To remove a group

1. In WorkStation, drag the group label from the group area to the column heading
row.

2. In the pane or view, right-click the column heading row and then clear Group box.

5.11 Quick Filter
You use Quick filter to filter out the objects by their names from the list. You can either
type the name in the Quick filter box or drag an item from a column in the Alarms pane,
the Events pane, an Alarm view, or an Event view and drop it in the Quick filter box.

For example, if you want to find all objects that are named “temperature”, just type
“temp” in the Quick filter box and only objects named temperature are displayed in the
list.

Figure – Filtering on characters in all visible columns

The Quick filter filters on everything that is visible in the columns of the view. For
example, if you filter on “20” you do not get any hits. But if you add the column Value,
you get hits on the temperature, which is 20, and the setpoint which is 20.

The Quick filter for the Event View filters on records that have already been retrieved
from the server.
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Figure – Quick filter filters on all visible columns in the view

Quick filter is used in the following components in WorkStation:

• List View

• Alarms pane

• Alarm Views

• Events pane

• Event Views

• Alarm or Event details views

• Watch pane

• Watch Views

• Add/Remove columns dialog box

• Create object wizard
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Figure – The Quick filter is used in many components, such as the List View (upper left), the Watch pane
(bottom left), and the Add/Remove dialog box (upper right).

5.12 Show Abbreviated References
References in the List view are abbreviated to save space. An abbreviated reference
might only display the first part of the reference but sometimes the last part is the most
important one. You can have the system only show the last part of the reference in the
list.

For example, if the full reference is ../../IO Resources/Onboard IO/DO 01 and you select
to show abbreviated references, the list shows DO 01.

5.13 Showing Abbreviated References
You show abbreviated references to see the last part of the reference.

For more information, see section 5.12 “Show Abbreviated References” on page 51.

To show abbreviated references

1. In WorkStation, in the List View, click the Show abbreviated references button

.
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6.1 Modify Values
You can change and force values using a graphic or the Properties pane. Using the
Watch pane, you can dynamically monitor a value.

6.1.1 Forced Values

When you force a value, all input from the system is overridden. For example, a
schedule is set to start a fan at 09:00 but you want it to start at 08:00. In this case, you
can force the fan to start at 08:00.

For more information, see section 6.7 “Forced Values” on page 54.

6.1.2 Add and Change Units and Prefix

You can add or change units and prefixes on values using WebStation.

For more information, see the Adding or Changing a Unit and Prefix for a Value in
WebStation topic on WebHelp.

6.2 Adding an Object to the Watch Pane or a Watch View
You add an object to the Watch pane or a Watch View to dynamically monitor its
property changes.

For more information, see section 21.11 “Watch Pane and Watch View” on page 206.

To add an object to the Watch pane or a Watch View

1. In WorkStation, in the System Tree pane, select the object you want to monitor.

2. Drag the object to the Watch pane or a Watch View.
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6.3 Saving a List of Values in the Watch Pane or a Watch View
You save lists of values in the Watch pane or a Watch View so that you can organize
you monitored values into manageable collections.

For more information, see section 21.11 “Watch Pane and Watch View” on page 206.

To save a list of values in the Watch pane or a Watch View

1. In WorkStation, in the Watch pane or a Watch View, on the toolbar, click the Save

current settings button .

2. Enter a Name and a location for the list.

3. Click Save.

6.4 Monitoring a Non-default Property
You add a value to the Watch pane and select the property to monitor when you do not
want to monitor the default property.

For more information, see section 21.11 “Watch Pane and Watch View” on page 206.

To monitor a non-default property

1. In WorkStation, in the System Tree pane, select the value.

2. On the Actions menu, point to View, point to Watch pane, and then click Select
property.

3. In the Select property dialog box, select the property you want to monitor.

4. Click OK.

6.5 Removing an Object from the Watch Pane or a Watch View
You remove an object from the Watch pane or a Watch View when you no longer want
to monitor its property changes.

For more information, see section 21.11 “Watch Pane and Watch View” on page 206.

To remove an object from the Watch pane or a Watch View

1. In WorkStation, in the Watch pane or a Watch View, select the object you want to
remove.

2. Click Remove from Watch Window .

The object is removed from the Watch pane or Watch View but not deleted from
EcoStruxure Building Operation database.

6.6 Changing a Value in a Graphic
You change a value in a graphic when you want a different value.
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For more information, see section 19.1 “How Graphics Work” on page 185.

To change a value in a graphic

1. In WorkStation or WebStation, click the graphic with the value you want to change.

2. Click the value you want to change.

3. In the Edit properties dialog box, enter the new value.

4. Click OK.

6.7 Forced Values
When you force a value, all input from the system is overridden. For example, a
schedule is set to start a fan at 09:00 but you want it to start at 08:00. In this case, you
can force the fan to start at 08:00.

You can manually release a forced value at any time or you can automate the release,
using a Timed Force utility object to specify the duration or end time of the force. For
more information, see the Timed Force Objects topic on WebHelp.

When you release a forced value, the value returns to its normal status.

In WorkStation, you can view the unforced value, which is the real value from the
system, at any time. For more information, see section 6.11 “Viewing an Unforced
Value ” on page 56.

Timeout on forced values

You can set a timeout on forced values so that the forced value is automatically
unforced after a fixed time. The time can be a duration, for example two hours. The
forced value can also be unforced at a specific calendar date and time.

For more information, see section 6.10 “Setting a Timeout on a Forced Value” on page
55.

For more information, see the Setting a Timeout on a Forced Value topic on WebHelp.

Indication in WorkStation

A forced value is indicated by orange color in the properties dialog boxes. In in the
Watch pane, a forced value is indicated by a pointing hand .

In the List View and Search View, a forced value is indicated by the text [Forced] in the
'Value' column.

In WorkStation, you can view the unforced value, which is the real value from the
system, at any time. For more information, see section 6.11 “Viewing an Unforced
Value ” on page 56.

Indication in WebStation

A forced value is indicated by orange color and a pointing hand in the List view.
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Indication in Function Block Graphics Viewer

A forced value is indicated by orange color in Function Block Graphics Viewer. For
more information, see the Forced Value Indication in Function Block Graphics Viewer
topic on WebHelp.

Search for forced values

You can search for forced values using the search function in WorkStation.

For more information, see section 6.12 “Searching for Forced Values” on page 56.

You can search for forced values in WebStation using Diagnostics.

For more information, see the Searching for Forced Values in WebStation topic on
WebHelp.

6.8 Forcing a Value
You force a value when you want to override a value, such as a value from a device.

For more information, see section 6.7 “Forced Values” on page 54.

To force a value

1. In WorkStation, in the System Tree pane, select the value you want to force.

2. On the File menu, click Properties.
3. Change the value.

4. Click Force.

5. Click OK.

6.9 Releasing a Forced Value
You release a forced value to return to its normal status.

For more information, see section 6.7 “Forced Values” on page 54.

To release a forced value

1. In WorkStation, in the System Tree pane, select the forced value you want to
release.

2. On the File menu, click Properties.

3. Click Unforce.

4. Click OK.

6.10 Setting a Timeout on a Forced Value
You set a timeout on a forced value when you want the value to be unforced
automatically at a fixed time.

For more information, see section 6.7 “Forced Values” on page 54.
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To set a timeout on a forced value

1. In Workstation, click the value you want to set a timeout on.

2. In the value row, click Force.

3. Click the Set timeout button.

4. Chose if you want a duration of the forced value or if you want the value to be
unforced on specific date and time.

5. Click OK.

6. Click Save.

6.11 Viewing an Unforced Value
You view an unforced value of a forced value when you want to see the real value.

For more information, see section 6.7 “Forced Values” on page 54.

To view an unforced value

1. In WorkStation, in the System Tree pane, select the forced value.

2. On the File menu, click Properties.

3. Click Configure .

4. Click the Operations tab.

5. In the Unforced value box, view the unforced value.

6.12 Searching for Forced Values
You search for forced values to determine if the system runs normally and to reset
forced values. Manually overridden I/O points are not included in the search result.

For more information, see section 6.7 “Forced Values” on page 54.

To search for forced values

1. In WorkStation, on the Toolbar, click the Search button .

2. In the Search view, in the text box, type your search.

NOTE: To search for all forced values, type '*'.

3. In the In folder box, enter the folder where you want to start the search.

4. Select Include subservers to include automation subservers in the search.

NOTE: Only subservers running EcoStruxure Building Operation BMS
version 1.5 or higher are included in the search.

5. Select Stop if more than 1000 results to limit the search to 1,000 results.
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6. Select Forced values only to search for forced values that were forced from
within the EcoStruxure BMS.

7. Select In device to include values forced from outside the EcoStruxure BMS in the
search. For example, values forced on the device.

8. In the Select Types dialog box, in the Include types box, select object types to
include in your search.

9. Click the Add type button .

10. Click OK.

11. In the Select Conditions box, enter the search conditions that have to be met
before a search result is displayed.

12. Click the Add condition button and select the condition you want to use for
the search.

13. Click OK.

14. Click the Search button .

The forced values in the EcoStruxure BMS are displayed.
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7.1 WorkStation Help
WorkStation Help provides you with information on how to handle and understand the
EcoStruxure BMS.

There are two different Help systems in WorkStation:

• WebHelp

• System Reference Guide

WebHelp

WebHelp is a context sensitive online help. WebHelp is always up-to-date so that you
get the latest version of Help. To be able to use WebHelp, you have to be connected to
the Internet.

System Reference Guide

System Reference Guide is a PDF-file that is installed with WorkStation. System
Reference Guide is not context sensitive or up-to-date with the latest Help information.

7.1.1 Help Settings

You can decide which Help you want to use as the default, using the Help menu in
WorkStation. You can select the following settings:

• Automatic

• Building Operation help

• Building Operation guide

Automatic

Click to make WorkStation check if you are connected to the Internet. If you are
connected, WebHelp opens. If you are not connected, the System Reference Guide
opens.

Building Operation help

Click to always open WebHelp. If you are not connected to the Internet, you get an error
message.
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Building Operation guide

Click to always open the System Reference Guide, regardless of whether you are
connected to the Internet or not.

7.1.2 Context Sensitive Help

Context sensitive help means that when you click on a help button or press F1 for a
specific dialog box or view, you are directed to the specific topic that explains that dialog
box or view. Only WebHelp is context sensitive.

7.2 Opening Help
You use help if you encounter difficulties in EcoStruxure Building Operation software.

For more information, see section 7.1 “WorkStation Help” on page 58.

To open help

1. In WorkStation, on the Help menu, click Building Operation help (online
version).

7.3 Getting Help on a Specific Topic
You click Help to get help on a specific topic.

For more information, see section 7.1 “WorkStation Help” on page 58.

To get help on a specific topic

1. Click the Help button in the dialog box.



Alarms

60 04-50007-01-en, December 2022

WorkStation

8 Alarms
What's in This Chapter?
8.1 How Alarms Work ................................................................................................. 60
8.2 Alarm and Event Details ....................................................................................... 62
8.3 Alarm Acknowledgements ................................................................................... 63
8.4 Acknowledging an Alarm ...................................................................................... 63
8.5 Alarm Assignments .............................................................................................. 63
8.6 Assigning an Alarm .............................................................................................. 65
8.7 Self-Assigning an Alarm ....................................................................................... 65
8.8 Accepting an Alarm Assignment .......................................................................... 65
8.9 Releasing an Alarm Assignment .......................................................................... 66
8.10 Rejecting an Alarm Assignment ......................................................................... 66
8.11 Alarm Attachments ............................................................................................. 66
8.12 Opening an Alarm Attachment .......................................................................... 66
8.13 Temporary User Filters ....................................................................................... 67
8.14 Editing a User Filter ............................................................................................ 67
8.15 Favorites ............................................................................................................ 68
8.16 Adding a Favorites ............................................................................................. 69
8.17 Applying a Favorite ............................................................................................. 69
8.18 Renaming a Favorite .......................................................................................... 70
8.19 Deleting a Favorite ............................................................................................. 70
8.20 Fitting the Column Width to the Contents ........................................................... 71
8.21 Viewing the Events of an Alarm .......................................................................... 71

8.1 How Alarms Work
You are notified by alarms when some important event occurs. For example, if the
temperature is too low or too high in a building, if a window is open, or if something is
broken, such as a fan. The system administrator sets up the alarms and decides to
whom the alarm is sent.

When an alarm is triggered, the alarm is displayed in a list together with information
about the alarm and its current status. In the list, you can manage the alarms, for
example, acknowledge, accept, and comment alarms. In addition, you can sort, hide,
and disable alarms in the list. You can also open a detail view to get information on all
properties of an alarm.

8.1.1 Alarm Acknowledgements

When you acknowledge an alarm, you let other users know that you have seen the
alarm. Acknowledging an alarm does not necessarily mean that you are responsible for
solving the cause of the alarm.
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For more information, see section 8.3 “Alarm Acknowledgements ” on page 63.

8.1.2 Alarm Assignments

A triggered alarm can be manually or automatically assigned to a specific user or user
group that seems to be most suited to correct the problem.

For more information, see section 8.5 “Alarm Assignments” on page 63.

8.1.3 Alarm Attachments

You can add attachments to alarm objects, except System Information alarms. An
attachment is a link pointing to an object in the system. When an alarm that has an
attachment is triggered, a paperclip icon is displayed in the Alarms pane and Alarm
Views. It is also possible to configure the attachment to display when the alarm is going
from Normal to Alarm state.

For more information, see section 8.11 “Alarm Attachments” on page 66.

8.1.4 User Actions

User actions are used to ease the understanding of what triggered the alarms and what
to do to solve the cause of the alarm. User action can be mandatory or optional
depending on how the system is set up.

For more information, see section 9.1 “User Actions” on page 72.

8.1.5 Hide and Disable

You can hide or disable alarms to decrease the number of alarms that are presented in
the Alarms pane or Alarm View. This is particularly useful when you have many active
alarms at the same time.

For more information, see section 10.1 “Hide and Disable” on page 76.

8.1.6 Alarm State-change Logging

Every time an alarm changes its state, such as from alarm state to reset state, an event
is written in the event log and shown in the Events pane in WorkStation. You can
disable state-change logging if you are only interested in the current alarm status. For
example, you want to present the current alarm status in a graphic and do not care
about the event history.

For more information, see section 11.1 “Alarm State-Change Logging ” on page 80.

8.1.7 Alarm and Event Details

To quickly get all the details of a specific alarm or event in WorkStation, or an alarm in
WebStation, you can use a Detail view. The Detail view always displays all properties
that can be added and displayed in the Alarms pane, Events pane, Alarm View or Event
View.

For more information, see section 8.2 “Alarm and Event Details” on page 62.
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8.1.8 Temporary User Filters

You change the Alarms pane or Alarm View filter conditions to narrow what is displayed
in the Alarms pane or Alarm View.

For more information, see section 8.13 “Temporary User Filters” on page 67.

8.1.9 Favorites

When you make layout or filter changes to the Alarms pane or an Alarm View, you can
save the changes as a favorite. The purpose of the favorite is to quickly and temporarily
change the Standard layout and narrow what is displayed in the Alarms pane or Alarm
View by applying the favorite filter conditions.

For more information, see section 8.15 “Favorites” on page 68.

8.2 Alarm and Event Details
To quickly get all the details of a specific alarm or event in WorkStation, or an alarm in
WebStation, you can use a Detail view. The Detail view always displays all properties
that can be added and displayed in the Alarms pane, Events pane, Alarm View or Event
View.

8.2.1 Alarm and Event Details in WorkStation

In WorkStation, you use the Detail view to display all the properties and their values for
the selected alarm or event.

Use the Quick filter to limit the number of properties listed in the view.

Figure – The Alarm Detail view (to the right) in WorkStation

8.2.2 Alarm and Event Details in WebStation

In WebStation, you use the Detail view to display all the properties and their values for
the selected alarm or event.
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Figure – The Details dialog box in WebStation

8.3 Alarm Acknowledgements
When you acknowledge an alarm, you let other users know that you have seen the
alarm. Acknowledging an alarm does not necessarily mean that you are responsible for
solving the cause of the alarm.

When you acknowledge an alarm the color of the alarm in the Alarms pane changes. In
WebStation the alarm symbol also changes.

An acknowledged alarm does not disappear from the Alarms pane list.

You can acknowledge one alarm or many alarms at the same time.

8.4 Acknowledging an Alarm
You acknowledge an alarm to let other users know that you have seen the alarm.

For more information, see section 8.3 “Alarm Acknowledgements ” on page 63.

To acknowledge an alarm

1. In WorkStation, in the Alarms pane, right-click the alarm and then click
Acknowledge.

8.5 Alarm Assignments
A triggered alarm can be manually or automatically assigned to a specific user or user
group that seems to be most suited to correct the problem.
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An assigned alarm indicates for other users that someone is working with the problem
that caused the alarm. The name of the user that is assigned to the alarm together with
the assignment status is displayed in the Alarms pane in WorkStation or WebStation,
and in the Events pane in WorkStation.

If an alarm is assigned to you, you can either accept the assignment request or reject it.
Rejecting the assignment request means setting the assignment alarm back to
unassigned. If you accept the assignment but realize that you are not the right person to
correct the problem, you can release the assignment or assign the alarm to another
user. If nobody has assigned an alarm, you can do a self-assign. When self-assigning,
the status of the assignment is changed from unassigned to accepted with your name.

You can assign an alarm to a user independent of the current assignment state.

Figure – Assignment schedule triggered by an alarm

Table – Assign Statuses

Status Description

Unassigned Nobody is assigned to the alarm.

Assigned An assignment request is sent to a user or
user group.

Accepted The assigned user or user-group has
accepted the assignment request.
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8.5.1 Manual Assignments

You or your supervisor can manually send an assignment request to the user or user
group that seems most suitable to correct the problem that triggered the alarm. When
manually sending an assignment request, you can define the time the user has to
respond to the request. If the user does not respond to the assignment within the time
limit, the request is automatically rejected and the assign status changes back to
unassigned.

8.5.2 Automatic Assignments

A triggered alarm can be automatically assigned to a specific user or user group that is
most suited to correct the problem. An assigned alarm indicates to other users that
someone is working with the problem that caused the alarm. The name of the user that
is assigned to the alarm and the assignment status are displayed in the Alarms pane,
Events pane, Alarm Views and Event Views.

For more information, see the Automatic Assignments topic on WebHelp.

8.6 Assigning an Alarm
You assign an alarm to another user and define the time the user has to respond before
the alarm is automatically rejected.

For more information, see section 8.3 “Alarm Acknowledgements ” on page 63.

To assign an alarm

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Assign.

2. In the Assign dialog box, browse to the user or group you want to assign the
alarm to.

3. Select Amount of time until automatically rejected and then type the amount of
time you want the alarm to be rejected after.

4. Click OK.

8.7 Self-Assigning an Alarm
You self-assign an alarm if you feel that you are the person most suited to correct the
cause of the alarm.

For more information, see section 8.5 “Alarm Assignments” on page 63.

To self-assign an alarm

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Self-
assign.

8.8 Accepting an Alarm Assignment
You accept an alarm that is assigned to you if you feel that you are the person most
suited to take care of the alarm.
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For more information, see section 8.5 “Alarm Assignments” on page 63.

To accept an alarm assignment

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Accept.

8.9 Releasing an Alarm Assignment
You release an alarm that you have assigned to yourself so someone else can assign
or self-assign it.

For more information, see section 8.5 “Alarm Assignments” on page 63.

To release an alarm assignment

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Release.

8.10 Rejecting an Alarm Assignment
You reject an alarm if you feel that you are not the person most suited to correct the
cause of the alarm.

For more information, see section 8.5 “Alarm Assignments” on page 63.

To reject an alarm assignment

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Reject.

8.11 Alarm Attachments
You can add attachments to alarm objects, except System Information alarms. An
attachment is a link pointing to an object in the system. When an alarm that has an
attachment is triggered, a paperclip icon is displayed in the Alarms pane and Alarm
Views. It is also possible to configure the attachment to display when the alarm is going
from Normal to Alarm state.

An attachment can be: a voice message, a report, a trend chart, a schedule, a Microsoft
Word file, a PDF file, a video recording, or a pop-up window that contains information
regarding the alarm.

You can add the same attachment or set of attachments to multiple alarms in a single
operation. You can also delete the attachments that belong to multiple alarms in a
single operation. If you add an attachment that already has been attached to an alarm,
the later attachment is added as a duplicate.

You can open attachments provided that the program or editor associated with the
attachment is locally installed on your computer. For example, if the attachment is a
PDF file, you can open the file if Adobe Reader or a similar program is installed on your
computer.

8.12 Opening an Alarm Attachment
You open an alarm attachment to get more detailed information about what triggered
the alarm.
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Continued on next page

For more information, see section 8.11 “Alarm Attachments” on page 66.

To open an alarm attachment

1. In WorkStation, in the Alarms pane, right-click the alarm, point to Attachment,
and then click the attachment you want to open.

8.13 Temporary User Filters
You change the filter conditions to narrow what is displayed in the Alarms pane, Events
pane, Alarm View, or Event View.

When you do not need to reuse the changes made to the filter conditions, you
temporarily change the user filter. In this case, the changes are no longer available
when you close the pane or View or log off.

If you want to save the changes made to the filter conditions, you can save the user
filter as a favorite before closing the pane or View and before logging off. For more
information, see section 8.15 “Favorites” on page 68.

Sorting and using fields in WebStation

You can add or remove information fields in the Alarm View and Event View in
WebStation. The fields in WebStation display alarm and event information. For
example, if you want to see the last comment of the alarms and who acknowledged the
alarms you can add the field Last comments and Acknowledge by.

You can sort alarms and events in the Alarm View and Event View in WebStation. The
sorting can be done ascending or descending. You don’t have to add the field that you
sort on. For example, you can sort the alarms by priority without adding the priority field.

The sorting and adding of fields can be saved as a Favorite in WebStation. For more
information, see section 8.15 “Favorites” on page 68.

8.14 Editing a User Filter
You edit the user filter to temporarily display a different set of alarms in the Alarms pane
or an Alarm View for the logged on session.

For more information, see section 8.1 “How Alarms Work” on page 60.

To edit a user filter

1. In the Alarms pane or Alarm View toolbar, click the Edit user filter icon .

2. In the Select Conditions dialog box, click the Add button to add filter
conditions.

3. In the Add/Remove Conditions dialog box, select the filter conditions you want to
add to the user filter.

4. Click OK.
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5. In the Select Conditions dialog box, select the conditions for the added filters.

6. Click OK.

The alarms that meet the filter conditions are displayed in the Alarms pane or Alarm
View until you log out of WorkStation.

8.15 Favorites
When you make layout or filter changes to certain panes and views, you can save the
changes as a favorite. The purpose of the favorite is to quickly and temporarily change
the Standard layout and narrow what is displayed in the pane or view by applying the
favorite filter conditions.

Layout and filters in WorkStation

Layout and filter changes can be saved as favorites for the following views and panes in
WorkStation:

• Alarms pane

• Alarm Views

• Events pane

• Event Views

• List Views

• Search

Layout changes can be saved as favorites for folder or container objects displayed in
the List View.

Filters in WebStation

Filter changes can be saved as favorites for the following views and panes in
WebStation:

• Alarms pane

• Alarm Views

• Events pane

• Event Views

If you create a favorite in WorkStation that contains both layout and filter edits, only the
filter edits are available in WebStation. Filters for List view and Search are not
supported by WebStation and cannot be used in WebStation.

IMPORTANT: You have to be logged on to the domain controller of the domain
where you want to make the filter or layout changes to be able to access the
Favorites feature.

A favorite is saved for the logged on user account and is available from any computer in
the EcoStruxure BMS.



Alarms

6904-50007-01-en, December 2022

WorkStation

When you apply a favorite, the layout and content of the pane or View changes
according to the favorite layout and filter conditions. A favorite cannot display
information the logged on user account does not have permissions to see. When you
apply a favorite, you do not alter the pane or View for anyone else who is currently
logged on using the same user account.

You can rename an existing favorite or edit the layout and filter conditions of an applied
favorite and save it under the existing name or a new name. You can also delete a
favorite. When you delete a favorite, you do not alter the pane or View for anyone else
who is currently logged on using the same user account.

Favorites in Alarm Views and Event Views support relative paths for the Source
property. You can reuse Alarm Views and Event Views containing favorites and have
the Source paths in the favorites dynamically change when you paste a copy, make a
duplicate, import, or move the Alarm View or Event View. For example, in a relative
path: '../../*' where '../' represents a folder or other container object and '*' represents
anything below the folder or container object.

You can return to the Standard layout and filter at any time. When you log off and log
back on, the pane or View returns to the Standard layout and filter.

8.16 Adding a Favorites
You add a favorite to save a layout and filter change that you have made to an Alarms
pane, Events pane, Alarm View, Event View, List View, or Search.

IMPORTANT: You have to be logged on to the domain controller of the domain
where you want to make the filter or layout changes to be able to access the
Favorites feature.

For more information, see section 8.15 “Favorites” on page 68.

To add a favorites

1. On the pane or View toolbar, click the Favorites button .

2. Click Add to favorites.

3. In the Save Favorite dialog box, in the Name box, type a name for the favorite.

4. Click OK.

The current layout and user filter are saved as a favorite and are displayed on the
Favorites menu.

8.17 Applying a Favorite
You apply a favorite to the Alarms pane, Events pane, Alarm View, Event View, List
View, or Search to temporarily change the layout and narrow the content determined by
the Standard filter conditions.
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IMPORTANT: You have to be logged on to the domain controller of the domain
where you want to make the filter or layout changes to be able to access the
Favorites feature.

For more information, see section 8.15 “Favorites” on page 68.

To apply a favorite

1. On the pane or View toolbar, click the Favorites button .

2. Click the name of the favorite whose layout and filter conditions you want to apply
to the pane or View.

The layout and filter conditions of the applied favorite are displayed in the pane or view.

8.18 Renaming a Favorite
You rename a favorite to make it easier to find the predefined a layout and filter
conditions for the Alarms pane, Events pane, Alarm View, Event View, List View, or
Search.

For more information, see section 8.15 “Favorites” on page 68.

To rename a favorite

1. On the pane or View toolbar, click the Favorites button .

2. Click Manage favorites.

3. In the Manage Favorites dialog box, right-click the favorite whose name you want
to edit.

4. Click Rename.

5. In the Edit Favorite dialog box, in the Name box, type a new name for the favorite.

6. Click OK.

7. Click OK again.

The favorite appears under its new name on the Favorites menu.

8.19 Deleting a Favorite
You delete a favorite that it is no longer needed.

For more information, see section 8.15 “Favorites” on page 68.

To delete a favorite

1. On the pane or View toolbar, click the Favorites button .

2. Click Manage favorites.
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3. In the Manage Favorites dialog box, select the favorite that you want to delete.

4. Click the Delete button .

5. Click OK.

The favorite is removed from the Favorites menu but does not alter the current pane or
view layout and filter conditions for a user who has applied the favorite.

8.20 Fitting the Column Width to the Contents
You fit the column width to the content to see all, or as much as possible, of the content
displayed in each of the columns in the Alarms pane, Alarm View, Events pane, Event
View, Multi Trend Log List, List View, or Search.

For more information, see the Alarm View and Event View Standard Filter and Layout
topic on WebHelp.

To fit the column width to the contents

1. In the pane or View, right-click anywhere in the column heading row and then click
Auto fit to contents.

The width of all the columns in the pane or View is adjusted so that all or as much as
possible of the column content is displayed.

8.21 Viewing the Events of an Alarm
You view the events of an alarm when you want to check the historical data of the
alarm.

To view the events of an alarm

1. In WorkStation, in the Alarms pane, right-click anywhere.

2. Point to View.

3. Click View history.
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9.1 User Actions
User actions are used to ease the understanding of what triggered the alarms and what
to do to solve the cause of the alarm. User action can be mandatory or optional
depending on how the system is set up.

9.1.1 Alarm Comments

You can add a comment to an alarm that can be helpful the next time the same alarm is
triggered.

For more information, see section 9.2 “Alarm Comments” on page 73.

9.1.2 Cause Notes

A cause note is a predefined note that contains information on what triggered the alarm.
This information can be helpful the next time the same alarm is triggered.

For more information, see section 9.5 “Cause Notes” on page 73.

9.1.3 Action Notes

An action note is a predefined note that contains information on what you have done to
solve the problem that triggered the alarm.

For more information, see section 9.8 “Action Notes” on page 74.

9.1.4 Checklists

Checklists are predefined lists with steps you take to correct the cause of the alarm.
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For more information, see section 9.11 “Checklists” on page 75.

9.2 Alarm Comments
You can add a comment to an alarm that can be helpful the next time the same alarm is
triggered.

Other people can read your comment in WorkStation or WebStation. You can add a
comment to an alarm that is assigned to yourself or to someone else.

Your comment is marked with your user name and the time you made the comment.

In some cases, adding a comment to an alarm is optional. In other cases, you are
required to add a comment when you acknowledge the alarm.

You add a comment using WorkStation or WebStation. You can view a comment added
to an alarm in WorkStation and WebStation.

9.3 Adding a Comment to an Alarm
You add a comment to an alarm to help others understand the problem that caused the
alarm or how the alarm was solved.

For more information, see section 9.2 “Alarm Comments” on page 73.

To add a comment to an alarm

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Add
comment.

2. In the Add Comment dialog box, type the comment.

3. Click OK.

9.4 Viewing an Alarm Comment
You can view a comment for an alarm.

For more information, see section 9.2 “Alarm Comments” on page 73.

To view an alarm comment

1. In Workstation, in the System Tree pane, select the alarm.

2. On the Actions menu, click View Comments.

9.5 Cause Notes
A cause note is a predefined note that contains information on what triggered the alarm.
This information can be helpful the next time the same alarm is triggered.

In some cases, adding a cause note is optional. In other cases, you are required to add
a cause note when you acknowledge the alarm.

You add a cause note using WorkStation or WebStation. You can view a cause note
added to an alarm in WorkStation or Webstation.
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9.6 Adding a Cause Note to an Alarm
You add a cause note to an alarm to let others know what caused the alarm.

For more information, see section 9.5 “Cause Notes” on page 73.

To add a cause note to an alarm

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Add
cause note.

2. In the Cause Notes dialog box, select the cause note.

3. Click OK.

The cause note is added to the alarm.

9.7 Viewing a Cause Note
You view a cause note to see what caused the alarm.

For more information, see section 9.5 “Cause Notes” on page 73.

To view a cause note

1. In Workstation, in the the System Tree pane, select the alarm.

2. On the Actions menu, click View Cause Notes.

9.8 Action Notes
An action note is a predefined note that contains information on what you have done to
solve the problem that triggered the alarm.

You can add an action note to an alarm. In some cases, adding an action note to an
alarm is optional. In other cases, you are required to enter an action note when you
acknowledge the alarm.

You add an action note using WorkStation or WebStation. You can view an action note
added to an alarm in WorkStation or WebStation.

9.9 Adding an Action Note to an Alarm
You add an action note to an alarm to let others know what you have done to correct the
problem that caused the alarm.

For more information, see section 9.8 “Action Notes” on page 74.

To add an action note to an alarm

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Add
action note.

2. In the Action Notes dialog box, select the action note.

3. Click OK.
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The action note is added to the alarm.

9.10 Viewing an Action Note
You view an action note to see what actions solved the problem that triggered the
alarm.

For more information, see section 9.8 “Action Notes” on page 74.

To view an action note

1. In WorkStation, in the System Tree pane, select the alarm.

2. On the Actions menu, click View Action Notes.

9.11 Checklists
Checklists are predefined lists with steps you take to correct the cause of the alarm.

In some cases, adding a check mark to a checklist in an alarm is optional. In other
cases, you are forced to add a check mark when you acknowledge the alarm.

You add a check mark to a checklist using WorkStation or WebStation. You can view
the check marks added to a checklist in WorkStation and WebStation.

9.12 Adding a Check Mark to a Checklist
You add a check mark to a checklist to show which steps you have completed to solve
the cause of the alarm.

For more information, see section 9.11 “Checklists” on page 75.

To add a check mark to a checklist

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Checklist.

2. Select the steps you have completed.

3. Click OK.

The steps in the checklist are added to the alarm.

9.13 Viewing a Checklist
You can view the steps in a checklist.

For more information, see section 9.11 “Checklists” on page 75.

To view a checklist

1. In WorkStation, in the System Tree pane, right-click the alarm object.

2. On the Actions menu, click View Checklists.
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10.1 Hide and Disable
You can hide or disable alarms to decrease the number of alarms that are presented in
the Alarms pane or Alarm View. This is particularly useful when you have many active
alarms at the same time.

Hidden and disabled alarms can be displayed and enabled again at any time.

10.1.1 Hide and Show Alarms

In the Alarms pane or Alarm View, you can hide alarms to decrease the number of
alarms and sort out alarms from the list.

For more information, see section 10.2 “Hide and Show Alarms” on page 76.

10.1.2 Disable and Enable Alarms

In the Alarms pane or Alarm View, you can disable an alarm. For example, you can
disable an alarm if you need to do maintenance that you know will trigger the alarm.

For more information, see section 10.6 “Disable and Enable Alarms” on page 77.

10.1.3 Rechecking Alarms

In the Alarms pane or Alarm View, you recheck alarms to refresh the information.

For more information, see section 10.10 “Rechecking Alarms” on page 79.

10.2 Hide and Show Alarms
In the Alarms pane or Alarm View, you can hide alarms to decrease the number of
alarms and sort out alarms from the list.
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A hidden alarm is still active and changes its state as shown alarms. The only difference
is that a hidden alarm that goes back to normal state is still visible in the Alarms pane, if
hidden alarms are shown.

10.3 Hiding an Alarm
You hide an alarm in the Alarms pane or Alarm View to decrease the number of alarms
shown in the Alarms list. All alarms, regardless of their status, can be hidden.

For more information, see section 10.2 “Hide and Show Alarms” on page 76.

To hide an alarm

1. In WorkStation, in the Alarms pane or Alarm View, right-click the alarm and then
click Hide alarm.

The alarm is now hidden in the Alarms pane or Alarm View.

10.4 Showing a Hidden Alarm
You show a hidden alarm when you want to view or edit an alarm set to Hidden.

For more information, see section 10.2 “Hide and Show Alarms” on page 76.

To show a hidden alarm

1. In WorkStation, in the Alarms pane or Alarm View, on the Alarm toolbar, click the

Show hidden alarms button .

All hidden alarms are displayed in the Alarms pane or Alarm View.

10.5 Show Hidden Alarms
You show hidden alarms when you want them to be displayed in the Alarms pane or
Alarm View.

For more information, see section 10.2 “Hide and Show Alarms” on page 76.

To show a hidden alarm

1. In WorkStation, in the Alarms pane or Alarm View, on the Alarm toolbar, click the

Show hidden alarms button .

2. In the Alarms pane, right-click the alarm and then click Show alarm.

The alarm is displayed in the Alarms pane or Alarm View when it is in an alarm state.

10.6 Disable and Enable Alarms
In the Alarms pane or Alarm View, you can disable an alarm. For example, you can
disable an alarm if you need to do maintenance that you know will trigger the alarm.

Disabled alarms automatically disappear from the Alarms pane or Alarm View.

You can view disabled alarms to get information about the cause for disabling the alarm
and the name of the user account that disabled the alarm.
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NOTE:
• To disable an alarm that is in normal state, it is recommended that you use a

connected shunt variable.

You enable disabled alarms so they once again change state according to the variables
the alarms monitor.

If you enable an alarm that has been disabled by a user (Disable cause = User), the
alarm goes to Normal state for re-evaluation. If you enable an alarm that has been
disabled by the System or a shunt variable, the alarm stays disabled.

10.7 Disabling an Alarm
You disable an alarm so it does not change state according to the variables the alarm
monitors.

For more information, see section 10.6 “Disable and Enable Alarms” on page 77.

To disable an alarm

1. In WorkStation, in the Alarms pane or Alarm View, right-click the alarm and then
click Disable alarm.

The alarm is disabled.

10.8 Enabling an Alarm
You enable alarms so they change state according to the variables the alarm monitors.

For more information, see section 10.6 “Disable and Enable Alarms” on page 77.

To enable an alarm

1. In WorkStation, in the Alarms pane or Alarm View, click the Show disabled

alarms button .

2. In the Alarms pane or Alarm View, right-click the alarm and then click Enable
alarm.

If you enable an alarm that has been disabled by a user (Disable cause = User), the
alarm goes to Normal state for re-evaluation. If you enable an alarm that has been
disabled by the System or a shunt variable, the alarm stays disabled.

10.9 Showing Disabled Alarms
You show disabled alarms when you want to view a list of disabled alarms, the cause
for disabling an alarm, the name of the user account that disabled the alarm, or edit an
alarm set to Disabled.

For more information, see section 10.6 “Disable and Enable Alarms” on page 77.
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To show disabled alarms

1. In WorkStation, on the Alarms pane toolbar, click the Show disabled alarms

button .

The disabled alarms are displayed in a list with two additional columns: Disabled cause
and Disabled by.

10.10 Rechecking Alarms
You recheck alarms to refresh the information in the Alarms pane.

For more information, see section 8.1 “How Alarms Work” on page 60.

To recheck alarms

1. In WorkStation, in the Alarms pane, right-click the alarm and then click Recheck.

NOTE: Alarms that are disabled have to be re-enabled before you click
Recheck.
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11.1 Alarm State-Change Logging
Every time an alarm changes its state, such as from alarm state to reset state, an event
is written in the event log and shown in the Events pane in WorkStation. You can
disable state-change logging if you are only interested in the current alarm status. For
example, you want to present the current alarm status in a graphic and do not care
about the event history.

11.1.1 Count

In the Alarm view, the value in the Count column counts +1 each time an alarm changes
to alarm state. When the alarm state changes to normal, the count is reset to zero.

For more information, see section 11.4 “Count” on page 80.

11.2 Enabling State-Change Logging of an Alarm
You enable the state-change logging of an alarm.

For more information, see section 11.1 “Alarm State-Change Logging ” on page 80.

To enable state-change logging of an alarm

1. In the Alarms pane or Alarm View, right-click the alarm you want to log and then
click Enable state-change logging.

11.3 Disabling State-Change Logging of an Alarm
You disable the state-change logging of an alarm to prevent the Events pane from filling
up with events caused by a faulty alarm that frequently toggles between alarm states.

For more information, see section 11.1 “Alarm State-Change Logging ” on page 80.

To disable state-change logging of an alarm

1. In the Alarms pane or Alarm View, select the alarm you want to disable the
logging for and click Disable state-change logging.

11.4 Count
In the Alarm view, the value in the Count column counts +1 each time an alarm changes
to alarm state. When the alarm state changes to normal, the count is reset to zero.
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This information is useful if an alarm at a certain value tends to frequently toggle
between alarm and reset, which unnecessarily disturbs the assigned user. The count
could then be a proof to adding a deadband to the alarm that dismiss this uncertain
value.
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12.1 How Events Work
All system events, as well as information and circumstances, are recorded in the Event
log. These event records can be viewed in the Events pane or in an Event View.

Events can tell you when someone logged on or off the EcoStruxure BMS, when a
setpoint was changed, if a notification was written to a file, if an email notification was
sent or not and when an object was created. For example, Events can tell you when a
trend log or an alarm was created, and by whom. The event log also records when
automation servers were online or offline and when the software was upgraded. The
event log is useful for tracking down all information in your system.

To limit the events displayed in the WorkStation Events pane, you can use the time
interval filter or a number of other filters. An indicator tells you the number of displayed
events.

You can create and use more than one Event View. Each Event View and the Events
pane can be customized with an event filter to only show the information you are
interested in.

You can view all events that have been generated from one object in the system.

In WorkStation, you can also view all events for a branch. A branch can be, for
example, a folder or a network including all contents.

When you view Events in this branch, the events are based on the path of the branch.
This means that there is no complete list of historical events for objects that have been
moved into the branch. Historical events are also lost if the container has been moved
or renamed. Events for objects that has been removed or deleted from the container are
displayed.

In the Events view, you can also open a detailed view to inspect all properties for a
selected event.

For scheduled events, changes are encoded:

• Monday: WS00001

• Tuesday: WS00002

• Wednesday: WS00003
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• Thursday: WS00004

• Friday: WS00005

• Saturday: WS00006

• Sunday: WS00007

12.1.1 Events Pane and Event View Customization

You can style certain events to bring out those that are of more interest than other
events listed in the Events pane and Event Views. To style a specific event, you first
have to create a condition that is associated with the events you want to style. An event
can be styled with a unique background color, font, and font color.

For more information, see the Events Pane and Event View Customization topic on
WebHelp.

12.1.2 Event Filter Conditions

Event filter conditions are used to set up the conditions for the events you want to be
displayed in the Events pane or an Event View.

For more information, see the Event Filter Conditions topic on WebHelp.

12.1.3 Favorites

When you make layout or filter changes to certain panes and views, you can save the
changes as a favorite. The purpose of the favorite is to quickly and temporarily change
the Standard layout and narrow what is displayed in the pane or view by applying the
favorite filter conditions.

For more information, see section 8.15 “Favorites” on page 68.

12.1.4 Archive Overview

Archiving is the process of preserving historical data, which is comprised of selected
events and extended trend logs. For example, some facilities are required to maintain
archives to comply with government regulations. Another example is in secure facilities
where they must maintain records of who logged in or who changed setpoints. Archiving
is not a backup function because archive data cannot be imported back into the system.

For more information, see the Archiving Overview topic on WebHelp.

12.2 Opening the Alarms and Events Detail View
You open the Alarms and Events detail view to view the details of an alarm or an event.

To open the alarms and events detail view

1. In the Alarms view or Events view, right-click the alarm or event you want to view
the details for.

2. Click Detail View.
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12.3 Opening an Object-specific Event View
You can view all the events that are related to a specific object or a specific branch.

NOTE: The object-specific standard filter can only narrow what is being shown in
the Event View.

For more information, see the Events Pane and Event View Customization topic on
WebHelp.

To open an object-specific event view

1. In the System Tree pane, select the object that you want to view the events for.

2. On the Actions menu, point to View and then click Events or Events in this
branch.

12.4 Editing a User Filter
You edit the user filter to temporarily display a different set of events in the Events pane
or an Event View for the logged on session.

For more information, see section 12.1 “How Events Work ” on page 82.

To edit a user filter

1. In the Events pane or Event View toolbar, click the Edit user filter icon .

2. In the Select Conditions dialog box, click the Add button to add filter
conditions.

3. In the Add/Remove Conditions dialog box, select the filter conditions you want to
add to the user filter.

4. Click OK.

5. In the Select Conditions dialog box, select the conditions for the added filters.

6. Click OK.

The events that meet the filter conditions are displayed in the Events pane or Event
View until you log out of WorkStation.

12.5 Applying an Event Time Filter
You use the event time filter to limit the number of events displayed in the Events pane
or to narrow a search based on a particular time interval.

IMPORTANT:
• The time filter is a temporary filter for the logged on user. To save a time filter,

you have to add it as a Favorite. For more information, see section 8.15
“Favorites” on page 68.
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• If you have auto hidden the Events pane or Event View, you have to temporarily
pin the pane or View before applying the event time filter. For more information,
see section 21.14 “Pane Menu” on page 209.

For more information, see section 12.1 “How Events Work ” on page 82.

To apply an event time filter

1. In WorkStation, open the Events pane.

2. Click the period selection button .

3. Select the period you want to filter on:

• To display the events for the past 24 hours, click the Day button .

• To display the events for the past week, click the Week button .

• To display the events for the past month, click the Month button .

• To display the events for the past year, click the Year button .

4. To modify the selected start time or date, select the Start box, enter a start time,
and click a different start date in the calendar.

5. To modify the selected end time or date, select the End box, enter an end time,
and click a different end date in the calendar.

6. Click Apply.

The Events pane displays the events generated within the selected date and time
interval.
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13.1 How Trend Charts Work
Trend charts are a way to graphically present trend logs. A trend chart can contain one
or more trend logs that are represented in the trend chart by lines or bars.

You can also add and remove trend logs from a trend chart. This makes it easy to
compare different trend logs, for example the energy consumption compared to the
average temperature.

Figure – Trend chart in WorkStation

13.1.1 Trend Chart Navigation in WorkStation

The trend chart contains a lot of tools for easy navigation in the chart. You can scroll or
use the predefined settings to focus on the time span you want to see.

For more information, see section 13.5 “Trend Chart Navigation in WorkStation” on
page 89.

13.1.2 Trend Chart Navigation in WebStation

The trend chart contains a lot of tools for easy navigation in the chart. You can scroll or
use the predefined settings to focus on the time span you want to see.
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For more information, see the Trend Chart Navigation in WebStation topic on WebHelp.

13.1.3 Trend Chart Series in WorkStation

You can display the trend logs as trend log series in a trend chart in a number of ways.
For example, you can change the color and weight of the trend log line, or display
markers at the time where the trend log value was sampled.

For more information, see section 13.12 “Trend Chart Series in WorkStation” on page
90.

13.1.4 Trend Chart Series in WebStation

You can display the trend logs as trend log series in a trend chart in a number of ways.
For example, you can change the color and weight of the trend log line, or display
markers at the time where the trend log value was sampled.

For more information, see the Trend Chart Series in WebStation topic on WebHelp.

13.1.5 Trend Chart Axes in WebStation

A trend chart displays the records of a trend log or an extended trend log as a series.

For more information, see section 13.25 “ Trend Charts” on page 95.

13.2 Opening a Trend Chart
You open a trend chart to see a graphical presentation of a trend log.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To open a trend chart

1. In WorkStation or WebStation, in the System tree pane, click the trend chart you
want to open.

The trend chart is now opened.

13.3 Creating a Trend Chart
You create a trend chart to get a graphic presentation of a trend log.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To create a trend chart

1. In WorkStation, in the System Tree pane, select the trend log or the variable you
want to create the trend chart from.

2. In the Actions menu, point to View, point to Trend charts, and then click New
Trend chart.

3. Click the Save button .

4. Browse to where you want to save the trend chart.
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5. Click Save.

13.4 Printing a Trend Chart
You print a trend chart to get a snapshot of what is displayed in the trend chart.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To print a trend chart

1. In WorkStation, in the System Tree pane, open the trend chart you want to print.

2. On the main toolbar, click the Print button .

3. In the Print out dialog box, select a printer and then click Print.

The part of the trend chart that is displayed on the screen is printed.

13.5 Trend Chart Navigation in WorkStation
The trend chart contains a lot of tools for easy navigation in the chart. You can scroll or
use the predefined settings to focus on the time span you want to see.

13.6 Zooming In a Trend Chart
You zoom in to enlarge the scale of the trend chart to make the reading easier.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To zoom in a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart.

2. On the Trend Chart toolbar, click the Zoom in button .

13.7 Zooming In an Area of a Trend Chart
You zoom in to enlarge a specific area of the trend chart to make the reading easier.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To zoom in an area of a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart you want to show.

2. On the Trend Chart toolbar, click the Zoom in button .

3. In the trend chart, select the area you want to enlarge.

4. Click the Zoom out button to zoom out to 100%.

13.8 Zooming Out of a Trend Chart
You zoom out to decrease the scale of the trend chart to make the reading easier.
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For more information, see section 13.1 “How Trend Charts Work” on page 87.

To zoom out of a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart.

2. On the Trend Chart toolbar, click the Zoom out button .

13.9 Scrolling a Trend Chart Vertically
You scroll the trend chart up and down to make reading a series easier.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To scroll a trend chart vertically

1. In WorkStation, in the System Tree pane, select the trend chart.

2. On the Trend Chart toolbar, click the Scroll trend chart vertical button .

3. Drag the trend chart upwards or downwards.

13.10 Scrolling the X-Axis in Small Steps
To navigate in the trend chart in small steps, you scroll the x-axis in steps equal to one
tenth of the displayed x-axis in the trend chart.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To scroll the x-axis in small steps

1. On the Trend Chart, click the Backward button to scroll the x-axis left, and

the Forward button to scroll the x-axis right.

13.11 Scrolling the X-Axis in Big Steps
You scroll the x-axis of a trend chart in big steps equal to the entire displayed x-axis in
the trend chart.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To scroll the x-axis in big steps

1. On the Trend Chart, click the Fast backward button to scroll the x-axis left,

and the Fast forward button to scroll the x-axis right.

13.12 Trend Chart Series in WorkStation
You can display the trend logs as trend log series in a trend chart in a number of ways.
For example, you can change the color and weight of the trend log line, or display
markers at the time where the trend log value was sampled.
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These settings can be saved so that the trend chart is displayed in the same way
anytime you open it.

13.13 Displaying Specific Time Spans of a Trend Chart
You change the time spans of the trend chart to display one hour or one year.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To display specific time spans of a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart you want to show.

2. On the Trend Chart toolbar, click the time span you want to display:

• Click the Show one hour button .

• Click the Show one day button .

• Click the Show one week button .

• Click the Show one month button .

• Click the Show one year button .

13.14 Viewing Events in a Trend Chart
You view trend chart events to track events or status of the trend chart.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To view events in a trend chart

1. In Workstation, select the trend chart you are working with.

2. On the trend chart toolbar, click the Show events button .

Repeat this procedure to hide the events.

13.15 Refreshing a Trend Chart
You manually refresh the trend chart to see the latest records. The trend chart does not
automatically update if live update is disabled or if the trend chart presents a field
controller trend log.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To refresh a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart you want to
refresh.

2. On the main toolbar, click the Refresh button .
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The trend chart is now refreshed and up-to-date.

13.16 Updating a Trend Chart with Live Values
You use live update if you want the trend chart to automatically get updated values from
the trend log in the system.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To update a trend chart with live values

1. In WorkStation, in the System Tree pane, click the trend chart.

2. On the Trend Chart navigation bar, select Live update.

The trend chart is automatically updated with values from the system.

13.17 Hiding a Series in a Trend Chart
When you want to concentrate on a specific trend log record series, you hide the other
trend log record series in the chart.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To hide a series in a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart.

2. On the Trend Chart, click the Series tab.

3. In the Series area, click on the series you want to hide.

13.18 Comparing Trend Chart Values Between Series
You use the Show the nearest information on every series when you want to compare
trend chart series at a specific time.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To compare trend chart values between series

1. In WorkStation, in the System Tree pane, select the trend chart you want to show.

2. On the Trend Chart toolbar, click the Show nearest information on every series

button .

3. Point to any series in the trend chart.

The values for every series at this specific time are now shown. Repeat the procedure
to deactivate the function.

13.19 Changing the Line Weight of a Trend Chart Series
You change the line weight of a trend chart series to make it easier to differentiate the
series.

For more information, see section 13.1 “How Trend Charts Work” on page 87.
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To change the line weight of a trend chart series

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. In the Trend Chart Settings properties, click the Series tab.

4. In the Data series box, select the series you want to change the line weight on.

5. In the Weight box, type a weight.

6. Click OK.

The line weight of the series is now changed.

13.20 Changing the Display Order of a Trend Chart Series
You change the display order of the series in a trend chart, for example, if one series is
obscured by another series.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To change the display order of a trend chart series

1. On the Trend Chart, click the Series tab.

2. In the Series area, right-click a series and select Bring to front.

The selected series is now placed in front of the other series.

13.21 Changing the Color of a Trend Chart Series
You change the color of a trend chart series to make reading easier.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To change the color of a trend chart series

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. In the Trend Charts Setting dialog box, click the Series tab.

4. In the Data series box, select the series you want to change color on.

5. In the Color box, enter a color.

6. Click OK.

7. In the Trend chart settings dialog box, click OK.

The color of the series is now changed.
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13.22 Showing Markers in a Trend Log Series
You show trend log series with markers for each record to make reading easier.

NOTE:
• This feature is only applicable to lines and discrete lines.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To show markers in a trend log series

1. In WorkStation, in the System Tree pane, select the trend chart.

2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. Click the Series tab.

4. In the Data series box, select the series you want to show with markers.

5. Select Show markers.

6. Click OK.

The series is now presented with markers.

13.23 Changing the Presentation Type of a Trend Chart Series
You change the presentation type of a trend chart series to adapt the appearance to
your needs.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To change the presentation type of a trend chart series

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.
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2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. In the Trend Chart Settings dialog box, click the Series tab.

4. In the Data series box, select the series you want to display in another
presentation type.

5. In the Series presentation box, select a presentation type.

6. Click OK.

The presentation type for the data series is now edited.

13.24 Saving the Trend Chart Settings
You save the trend chart settings if you want the trend chart to be displayed the same
way the next time you open it.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To save the trend chart settings

1. In WorkStation, in the System Tree pane, open the trend chart.

2. Change the settings to fit your preferences.

3. Click the Save button .

13.25 Trend Charts
A trend chart displays the records of a trend log or an extended trend log as a series.

A trend chart series that presents a trend log is automatically updated with the latest
records, if Live update in WorkStation or Automatic scroll in WebStation is activated.
A trend chart series that presents records from a field controller trend log needs to be
refreshed manually.

There is no upper limitation of how many trend logs a trend chart can present. However,
the performance decreases as the number of displayed trend logs increase. The
records of the trend log can be processed by a calculation method before they are
presented in the trend chart. The calculation function supports negative consumption
values, which can be used to handle cases where you need to subtract consumption
for, for example, energy produced on site.
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Figure – Trend chart, schematic

When a trend chart presents records live from an extended trend log, the latest records
of the connected trend log are frequently transferred to the extended trend log. This
decreases the delay that can occur when the extended trend log has to wait for the
transfer threshold to be reached before new records from the trend log are transferred.
With this method, the trend chart presents the latest records.
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Figure – An extended trend log, that presents in an opened live trend chart, frequently transfers the
latest records from the trend log to the extended trend log.
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If two extended trend logs are connected between the trend log and the trend chart, the
transfer that occurs when a trend chart presents records live only transfers the records
from the nearest extended trend log. The transfer threshold rate between the trend log
and the first connected trend log remains unaffected.
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Figure – Latest trend log record that does not present the same short latency in a live trend chart
when two extended trend logs are connected in a series between the trend log and trend
chart.



Trend Charts

100 04-50007-01-en, December 2022

WorkStation

When waiting for a new record, the trend chart draws a dotted line from the last
recorded value and forward. When a new value is recorded, the dotted line between the
last and the new record is replaced by a solid series of lines.

Figure – If no value is recorded, the trend chart draws a dotted line.
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Dynamic Trend Chart Title

Trend charts support relative property references for the trend chart title. You can reuse
the trend chart and have the trend chart title dynamically changed depending on where
you paste a copy, make a duplicate, import, or move the trend chart. The Chart title
property of the trend chart is the first part of the trend chart title and the Description
property of the trend chart is the last part of the trend chart title. For example, in a
relative property reference: '../../NAME' where '../' represents a folder or container
object.

If the Chart title property is empty or contains an unresolved reference, the trend chart
object name is the first part of the trend chart title.

The trend chart title is visible in trend chart printouts.

13.25.1 Trend Chart Series

In a trend chart, a series can be presented as a line, discrete line, digital, or bars. In a
trend chart, series can be presented in different colors and with different line weights.

In WorkStation, in a multi trend log list, series are presented as text and can be
exported to .XML or .CSV.

For more information, see the Trend Series topic on WebHelp.

13.25.2 Trend Chart Axes in WorkStation

The x-axis of the trend chart represents time. The time span of the axis can be set with
a fixed start and end time or with an end time relative to the present time. The axis can
be quick-scaled to show the last hour, last day, last month, or last year.

For more information, see section 13.30 “Trend Chart Axes” on page 105.

13.25.3 Trend Chart Axes in WebStation

The x-axis of the trend chart represents time. The time span of the axis can be set with
a fixed start and end time or with an end time relative to the present time. The axis can
be quick-scaled to show the last hour, last day, last month, or last year.

For more information, see the Trend Chart Axes in WebStation topic on WebHelp.

13.25.4 Real-Time Plotting

The real-time plot is a variable displayed directly in the trend chart. The real-time plot is
an instant reflection of the variable, so the history of the real-time plot is lost when the
trend chart is closed. However, the history is not lost for I/O points that have implicit logs
where approximately 500 records of history are displayed.

For more information, see the Real-Time Plotting topic on WebHelp.

13.25.5 Time Zone Modes in a Trend Chart

In a trend chart, you can present the records of a trend log in different time zones: local
time or a predefined time zone.
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For more information, see the Time Zone Modes in a Trend Chart topic on WebHelp.

13.25.6 Calculation Methods

Use a calculation method to process the records of the trend log before presenting them
in a trend log list or a trend chart. The original records in the trend log are not affected
by the calculation method. The calculation method is applied to the trend log records
grouped by a specific time interval.

For more information, see section 14.15 “Calculation Methods” on page 119.

13.25.7 Period Timestamps in Trend Charts and Trend Log Lists

When a calculated value for a period is presented, the middle of the period is used as
the timestamp.

Example:

The calculated value for the period 8:00-9:00 is stamped 8:30. If there is a value at 9:01,
the next period is 9:00-10:00, which is stamped as 9:30. The full period may not have
passed yet, but the value can be presented even if parts of the period are in the future.

13.25.8 Temporary Trend Charts

To display a trend log without creating a new trend log list or trend chart, the trend log
can be displayed in a temporary list or chart.

For more information, see the Temporary Trend Charts topic on WebHelp.

13.25.9 Multi Trend Log Lists

You can view a trend chart in a multi trend log list to be able to export it and print it. The
trend chart series settings and calculation are retained in the multi trend log list.

For more information, see the Multi Trend Log Lists topic on WebHelp.

13.25.10 Floating Point Values NaN, INF, and –INF

In the EcoStruxure Building Operation software, the floating point values “Not a
Number”, positive infinity, or negative infinity may be displayed in the Basic property
tab, in a trend log list, or a trend chart.

For more information, see the Floating Point Values NaN, INF, and –INF topic on
WebHelp.

13.26 Configuring a Trend Chart
You configure the properties of a trend chart to meet the unique needs of your site.

For more information, see section 13.25 “ Trend Charts” on page 95.

To configure a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.
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Continued on next page

2. On the File menu, click Properties.

3. In the properties dialog box, click the Basic tab.

4. Edit the basic properties:

Property Description

Time mode Select the time mode of the x-axis.

Start time Enter the absolute start time when Time
mode is set to Absolute. This time is the
leftmost point of the x-axis.

Time span Type the relative time span of the x-axis.

Time zone Select the time zone of the trend log list.
The mode is the perspective in which the
trend log is displayed.

Show nearest information for all series Select True to show information on every
series along a diagonal line.

Show grid lines for X-axis Select True to show grid lines for the x-
axis.

Chart title Enter the property reference or relative
property reference to the folder or other
container whose name you want to include
in the trend chart title.

Auto scale left y-axis Select True to activate auto scale and have
the left y-axis adapt itself to the displayed
series.

Left y-axis minimum Enter the minimum value of the left y-axis.

Left y-axis maximum Enter the maximum value of the left y-axis.

Auto scale right y-axis Select True to activate auto scale and have
the right y-axis adapt itself to the displayed
series.

Right y-axis minimum Enter the minimum value of the right y-axis.

Right y-axis maximum Enter the maximum value of the right y-
axis.

Show grid lines for left Y-axis Select True to show gridlines for the left y-
axis originating from the y-axis scale.

Show grid lines for right Y-axis Select True to show gridlines for the right
y-axis originating from the y-axis scale.

Add
Click to add a series to the trend chart. For
more information, see the New Object
Wizard – Naming the Object Page topic on
WebHelp.

Edit
Click to edit a selected series. For more
information, see the Trend Chart Series
Properties topic on WebHelp.
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Continued

Property Description

Remove
Click to remove a selected series.

5. Click the Series tab.

6. Edit the series properties.

7. Click OK.

13.27 Viewing a Trend Log in a Temporary Trend Chart
You open a trend log as a temporary trend chart to view the recorded values
graphically. When you close the temporary trend chart, the chart is not saved.

For more information, see the Temporary Trend Charts topic on WebHelp.

To view a trend log in a temporary trend chart

1. In WorkStation, in the System Tree pane, select the folder or EcoStruxure BMS
server where the trend log is located.

2. Select the trend log you want to open as a temporary trend chart.

3. On the Actions menu, point to the View submenu and then click In Trend Chart.

The temporary trend chart is displayed in the work area under a generic name.

13.28 Removing a Trend Chart Series
You remove unused series from the trend chart.

For more information, see section 13.1 “How Trend Charts Work” on page 87.

To remove a trend chart series

1. In WorkStation, in the System Tree pane, select the trend chart from which you
want to remove a series.

2. On the Trend Chart, click the Series tab.

3. In the Series area, right-click a series and select Remove series.

The selected series is now removed from the trend chart.

13.29 Creating a Real-Time Plot Trend Chart
You create a real-time plot trend chart to display a variable in real time.

For more information, see the Real-Time Plotting topic on WebHelp.
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To create a real-time plot trend chart

1. In WorkStation, in the System Tree pane, select the variable you want to display
in a real-time plot trend chart.

2. On the Actions menu, point to View and then click New Trend chart.

3. Click the Save button .

4. Browse to where you want to save the real-time plot trend chart.

5. Click Save.

By saving the real-time plot trend chart, a trend chart object is created in the System
Tree pane.

13.30 Trend Chart Axes
The x-axis of the trend chart represents time. The time span of the axis can be set with
a fixed start and end time or with an end time relative to the present time. The axis can
be quick-scaled to show the last hour, last day, last month, or last year.

Figure – Absolute time span and relative time span, schematic

The y-axis refers to the measurement unit that the variable represents. The scale of the
y-axis can be set manually or by auto scale. You can configure the trend chart to
present series on one y-axis or two y-axes, one to the left and one to the right. Use two
y-axes to present series with different ranges in the same trend chart.
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Figure – One y-axis and two y-axes, schematic

To make reading easier, grid lines can be shown in the trend chart. Grid lines can be
shown in both the x- and y-direction, independent of each other.

Figure – Grid lines, schematic

13.31 Scrolling the Trend Chart X-Axis to the Current Time
You scroll the x-axis rightmost point for fast navigation to the current time. This is useful
when live update is disabled.

For more information, see section 13.30 “Trend Chart Axes” on page 105.
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To scoll the trend chart x-axis to current time

1. In WorkStation, in the System Tree pane, select the trend chart you want to show.

2. On the Trend Chart navigation bar, click the Current time button .

The trend chart displays the trend chart with the client’s current time as the rightmost x-
axis point.

13.32 Editing the Trend Chart Settings
You configure the scale of the trend chart axes, the presentation of series, and the
calculation method to make it easier to interpret the series, representing the trend log
records, in the trend chart.

For more information, see section 13.30 “Trend Chart Axes” on page 105.

To edit the trend chart settings

1. In WorkStation, in the System Tree pane, select the trend chart.

2. On the Trend Chart toolbar, click Open trend chart settings button .

3. In the Trend Chart Settings dialog box, edit the trend chart settings.

4. Click OK.

13.33 Configuring the X-Axis with a Relative Time Span
You set the trend chart time span of the x-axis relative to the series current end point
time to automatically adapt the trend chart to display the current time and the latest
records within the specific time span.

For more information, see section 13.30 “Trend Chart Axes” on page 105.

To configure the x-axis with a relative time span

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. In the trend chart view, on the toolbar, click Open trend chart settings button

.

3. In the Trend chart settings dialog box, in the Time mode box, select Relative (to
current time).

4. In the Time span box, type the length of the x-axis to display before the current
time.

5. Click OK.

The x-axis is now configured with a relative time span.
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13.34 Configuring the X-Axis with an Absolute Time Span
You configure the time span of a trend chart x-axis to display the records that are
recorded within a specific period of time.

For more information, see section 13.30 “Trend Chart Axes” on page 105.

To configure the x-axis with an absolute time span

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. In the trend chart view, on the toolbar, click the Open trend chart settings button

.

3. In the Trend chart settings dialog box, the Time mode box, select Absolute
(start and end time).

4. In the Start time boxes, type the x-axis leftmost date and time.

5. In the End time boxes, type the x-axis rightmost date and time.

6. Click OK.

The x-axis is now configured with an absolute time span.

13.35 Configuring the Trend Chart Time Zone
You display the time of the records in local time, server time, or in the time of a
predefined time zone. By changing the time zone settings you make it easier to interpret
the time stamp.

For more information, see the Time Zone Modes in a Trend Chart topic on WebHelp.

To configure the trend chart time zone mode

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. In the trend chart view, on the toolbar, click the Open trend chart settings button

.

3. In the Trend Chart Settings dialog box, in the Time zone box, select a time zone
to display the trend chart time stamps in:

• Select Local time to display the time stamps in real time from the perspective
of the client.

• Select a predfined time zone to display the time stamps in real time from the
perspective of the selected time zone.

4. Click OK.

The x-axis is now set according to the selected time zone.



Trend Charts

10904-50007-01-en, December 2022

WorkStation

Continued on next page

13.36 Showing Trend Chart Grid Lines
You show the trend chart grid lines on the x-axis and the y-axis to make the chart easier
to read.

For more information, see the Trend Chart Settings Dialog Box – Axes Tab topic on
WebHelp.

To show trend chart grid lines

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. Below the Time zone box, select Show grid lines to show grid lines originating
from the x-axis scale.

4. Select Show left grid lines or Show right grid lines to show grid lines originating
from the y-axis scale.

5. Click OK.

Grid lines are now shown in the trend chart. Repeat the procedure to hide the grid lines.

13.37 Manually Configuring the Y-Axis Scale
You manually configure the trend chart y-axis to have a fixed scale. The trend chart has
two y-axes, one to the left and one to the right. You can use this procedure to scale both
axes.

For more information, see section 13.30 “Trend Chart Axes” on page 105.

To manually configure the y-axis scale

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.
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2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. In the Trend chart settings dialog box, clear Auto scale left y-axis and Auto
scale right y-axis.

4. In the Left y-axis minimum and Right y-axis minimum boxes, type the minimum
value of the y-axis.

5. In the Left y-axis maximum and Right y-axis maximum boxes, type the
maximum value of the y-axis.

6. Click OK.

The y-axis is now set with a fixed scale.

13.38 Automatically Configuring the Y-Axis Scale
You configure the trend chart to automatically scale the y-axis. The trend chart has two
y-axes, one to the left and one to the right. You can use this procedure to scale both
axes.

For more information, see section 13.30 “Trend Chart Axes” on page 105.

To automatically configure the y-axis scale

1. In WorkStation, in the System Tree pane, select the trend chart you want to
configure.

2. On the Trend Chart toolbar, click the Open trend chart settings button .

3. In the Trend Chart Settings dialog box, select Auto Scale left y-axis and Auto
Scale right y-axis.

4. Click OK.

The y-axis scale is now set automatically and updated with the presented series.

13.39 Activating Trend Chart Live Update
You activate the live update of a trend chart to automatically update the trend chart with
the latest records.

For more information, see section 13.25 “ Trend Charts” on page 95.

To activate trend chart live update

1. In WorkStation, in the System Tree pane, select the trend chart on which you
want to activate live update.

2. In the Trend Chart View, in the navigation bar, select Live update.



Trend Charts

11104-50007-01-en, December 2022

WorkStation

13.40 Creating a Trend Chart that Monitors a Variable in Real-
Time

You create a trend chart that monitories a variable in real-time, for example, to access
and check the current status of the variable.

For more information, see the Real-Time Plotting topic on WebHelp.

To create a trend chart that monitors a variable in real-time

1. In WorkStation, in the System Tree pane, select the folder or EcoStruxure BMS
server where you want to create the trend chart.

2. On the File menu, point to New and then click Trend.

3. In the Create Object wizard, in the object type list, select Trend Chart.

4. In the Name box, type a name for the trend chart.

5. In the Description box, type a description.

6. Click Next.

7. In the Configure Trend Chart page, in the Time mode box, select Absolute to
manually specify the x-axis start and end point.

8. In the Start time box, type the absolute start time (the leftmost point of the x axis).

9. In the End time box, type the absolute end time (the rightmost point of the x axis).

10. In the Auto scale left y-axis box, select True so the y-axis adapts itself to
displayed series.

11. Click the Add button.

12. In the Create Object wizard, in the object type list, select Real Time Trend
Series.

13. In the Name box, type a name for the series.

14. In the Description box, type a description.

15. Click Next.

16. In the Configure Real-time Trend Series page, in the Display variable box,
enter the variable you want to display in the trend chart.

17. In the Weight box, select the weight of the series.

18. In the Show markers box, select True to display a marker for each recorded.

19. Click Create.

20. In the Configure real-time trend series dialog box, click Create.
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The real-time trend series trend chart is created in the selected folder.

13.41 Attaching a Calculation Method to a Trend Chart Series
You attach a calculation method to a trend chart series to process the recorded values
and present the result.

For more information, see section 14.15 “Calculation Methods” on page 119.

To attach a calculation method to a trend chart series

1. In WorkStation, in the System Tree pane, select the trend chart you want to attach
a calculation method to.

2. On the Trend Chart toolbar, click Open trend chart settings button .

3. In the Trend Chart Settings dialog box, click the Calculations tab.

4. In the Data series box, select the series you want to add a calculation method to.

5. In the Calculation method box, select a calculation method.

6. Select Delta over period if the calculation method is a delta calculation with
periods.

7. In the Period box, select the time span for which the calculation method is to be
executed.

NOTE:
• If Custom is selected in the Period box, enter a custom time span for which

the calculation method is to be executed in the Custom period box and the
time when you want the custom period to start in the Custom period
alignment boxes.

• To calculate the required number of records for a trend log, multiply the
number of records in one day with the number of days you want the trend
log to record. For example, the interval of the trend log is set to 1 hour, then
this gives 24 recorded values per day. The trend log should record at least
one month of recorded values equal to 31 days. For example, the number
of records = 24 x 31 = 744.

8. In the Custom period box, enter a custom time span for which the calculation
method is to be executed.

9. In the Custom period alignment boxes, enter the time when you want the custom
period to start.

10. Click OK.

A calculation method is now attached to the series.
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13.42 Adding a Trend Log Series to a Trend Chart
You add a trend log series to a trend chart to compare trend data from different logs or
variables.

For more information, see the Trend Series topic on WebHelp.

To add a trend log series to a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart you want to add a
trend log series to.

2. In the System Tree pane, select the trend log you want to add.

3. Drag the trend log from the System Tree pane to the trend chart diagram.

4. Click Save.

13.43 Adding a Real-Time Trend Series to a Trend Chart
You add a real-time trend series to a trend chart to compare trend data from different
logs or variables.

For more information, see the Trend Series topic on WebHelp.

To add a real-time trend series to a trend chart

1. In WorkStation, in the System Tree pane, select the trend chart you want to add a
trend series to.

2. On the File menu, click Properties.

3. In the Trend Chart Properties dialog box, under Series Configuration Settings,

click the Add button .

4. In the Create Object wizard, in the object type list, select Real Time Trend
Series.

5. In the Name box, type a name for the series.

6. In the Description box, type a description for the series.

7. Click Next.

8. In the Configure Real-time Trend Series page, in the Display variable box,
enter the path to the variable you want to display in the trend chart.

9. In the Weight box, enter the line weight of the series.

10. In the Show markers box, select True to display a marker for each recorded
value.

11. Click Create.

12. Click OK.
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14.1 Trend Log Lists in WorkStation
A trend log list displays all values in the trend log in a list.

You can create a trend log list directly from a trend log and refresh the values.

You can manually add records to a trend log list for any type of trend log.

14.1.1 Trend Log List Display

A trend log list can be displayed in a number of ways.

For more information, see section 14.6 “Trend Log List Display ” on page 116.

14.1.2 Export of Trend Log Lists and Records

Trend log lists and records can be exported in two different formats:

• CSV

• XML

For more information, see section 14.12 “Export of Trend Log Lists and Records ” on
page 118.
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Figure – Trend log list

14.2 Opening a Trend Log List
You open the trend log list for viewing.

For more information, see section 15.1 “How Trend Logs Work” on page 127.

To open a trend log list

1. In WorkStation or WebStation, in the System tree pane, select the trend log list
you want to open.

The trend log list is now open.

14.3 Creating a Trend Log List
You create a trend log list to get a list of the records in the trend log.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To create a trend log list

1. In WorkStation, in the System Tree pane, select the trend log or the variable you
want to create the trend log list from.

2. On the Actions menu, point to View, point to Trend log lists, and then click New
Trend log list.

3. Click the Save button .

4. Browse to where you want to save the trend log list.

5. Click Save.
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14.4 Refreshing a Trend Log List
You have to manually refresh the trend log list to display recently recorded values.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To refresh a trend log list

1. In WorkStation, in the System Tree pane, select the trend log list.

2. On the main toolbar, click the Refresh button .

3. Manually scroll in the list to see the latest records.

The trend log list is now refreshed.

14.5 Copying a Trend Log Record
You copy rows in the trend log list to the clipboard if you want to paste them into other
programs, such as Microsoft Excel.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To copy a trend log record

1. In WorkStation, in the System Tree pane, select the trend log list you want to
open.

2. In the Trend Log List, select the row you want to copy.

3. On the Edit menu, click Copy.

The text is now copied to the clipboard.

14.6 Trend Log List Display
A trend log list can be displayed in a number of ways.

You can present the values in the trend log as decimals or as bitstrings. You can hide or
display events in a trend log list to make the reading easier. Events that have a value or
comment cannot be hidden and are always displayed.

The settings can be saved so that the trend log list is displayed in the same way the
next time you open it.

14.7 Displaying or Hiding Events in a Trend Log List
You hide or display events in a trend log list to make the reading easier. Events that
have a value or comment cannot be hidden and are always displayed. For example, as
a Record was added, or as a Record was commented.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.



Trend Log Lists

11704-50007-01-en, December 2022

WorkStation

To display or hide events in a trend log list

1. In WorkStation, in the System Tree pane, select the trend log list you want to
display.

2. On the Trend Log List toolbar, click the Events button .

Events are now displayed in the trend log list. Repeat the procedure to hide the events.

14.8 Displaying Trend Log List Values as Decimals
You present trend log list values as decimals.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To display trend log list values as decimals

1. In WorkStation, in the System Tree pane, select the trend log list.

2. On the Trend Log List toolbar, click the Show decimal values button .

The values in the trend log list are now shown as decimals.

14.9 Displaying Trend Log List Values as Bitstrings
You present trend log list values as bitstrings.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To display trend log list values as bitstrings

1. In WorkStation, in the System Tree, select the trend log list values you want to
display as bitstrings

2. On the Trend Log List toolbar, click the Show values as bitstrings button .

The values in the trend log list are now shown as bitstrings.

14.10 Saving a Trend Log List Setting
You save the trend log list setting if you want the trend log list to be displayed in the
same way the next time you open it.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To save a trend log list setting

1. In WorkStation, in the System Tree pane, open the trend log list.

2. Change the settings to fit your preferences.

3. On the Trend Log List toolbar, click the Save button .
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Continued on next page

14.11 Viewing a Trend Log in a Temporary Trend Log List
You open a trend log in a temporary trend log list to view the recorded values in a list.
When you close the temporary trend log list, the list is not saved.

For more information, see the Temporary Trend Log Lists topic on WebHelp.

To view a trend log in a temporary trend log list

1. In WorkStation, in the System Tree pane, select the folder or EcoStruxure BMS
server where the trend log is located.

2. Select the trend log you want to open as a temporary trend log list.

3. On the Actions menu, point to View and then click In Trend Log List.

(In FM: TaskClosing) The trend log list is displayed in the work area under a generic
name.

14.12 Export of Trend Log Lists and Records
Trend log lists and records can be exported in two different formats:

• CSV

• XML

CSV

CSV (Comma separated values) is a standard file format for digital storage of data
structured in a table of lists form. The CSV format can be used by Excel and in
databases such as SQL.

XML

XML (Extensible Markup Language) is a standard file format for structured data and can
be use with a lot of different tools.

14.13 Exporting a Trend Log List to XML format
You export a trend log list to XML format if you want to open it in an XML editor for
viewing and processing.

IMPORTANT: When you are exporting log data and then importing it to another
EcoStruxure BMS, change the time zone to UTC before the export to make sure
the imported time stamps show the correct time

For more information, see section 14.12 “Export of Trend Log Lists and Records ” on
page 118.

To export a trend log list to XML format

1. In WorkStation, in the System Tree pane, select the trend log list you want to
export.
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2. On the Trend Log List toolbar, click the Export to .XML button .

3. Browse to the folder where you want to save the file.

4. In the File name box, type a name.

5. Click Save.

The trend log list is now exported to XML format.

14.14 Exporting a Trend Log List to CSV Format
You export a trend log list to CSV format if you want to open it for viewing and
processing, for example, in Microsoft Excel.

For more information, see section 14.12 “Export of Trend Log Lists and Records ” on
page 118.

To export a trend log list to CSV format

1. In WorkStation, in the System Tree pane, select the trend log list you want to
export.

2. On the Trend Log List toolbar, click the Export to .CSV button .

3. Browse to the folder where you want to save the file.

4. In the File name box, type a name.

5. Click Save.

The trend log list is now exported to CSV format.

14.15 Calculation Methods
Use a calculation method to process the records of the trend log before presenting them
in a trend log list or a trend chart. The original records in the trend log are not affected
by the calculation method. The calculation method is applied to the trend log records
grouped by a specific time interval.

The following calculation methods are available:

• None

• Maximum

• Minimum

• Average

• Sum

• Delta

• Delta over period

• Meter consumption
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All calculation methods might not be available in all features of EcoStruxure Building
Operation.

NOTE:
• Adapt the period so it contains the required amount of records to generate a

correct calculation.
• If a calculation method is connected to an interval trend log with delta, make

sure that the period and delta are adapted for the calculation.

14.15.1 None

No calculation is performed. The actual values are presented.

14.15.2 Maximum

The maximum value of each period is presented.

Figure – Maximum calculation method, schematic

IMPORTANT: If the log point is offline or no value is produced during the interval,
no value is displayed.

14.15.3 Minimum

The minimum value of each period is presented.
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Figure – Minimum calculation method, schematic

IMPORTANT: If the log point is offline or no value is produced during the interval,
no value is displayed.

14.15.4 Average

The average of the values in each period is calculated and presented.

Figure – Average calculation method, schematic
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IMPORTANT: If the log point is offline or no value is produced during the interval,
no value is displayed.

14.15.5 Sum

The sum of the values in each period is calculated and presented.

Figure – Sum calculation method, schematic

14.15.6 Delta

The change to the previous value is calculated and presented.
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Figure – Delta calculation method, schematic

14.15.7 Delta over Period

The change over a period is calculated and presented. The value at the period limit is
often interpolated, based upon the last value in the old period and the first value in the
new period.

Figure – Delta over period calculation method, schematic



Trend Log Lists

124 04-50007-01-en, December 2022

WorkStation

14.15.8 Meter Consumption

Meter consumption is a delta over period calculation with meter functionality. For more
information, see section 15.7 “Meter Function” on page 137.

14.15.9 Period Timestamps in Trend Charts and Trend Log Lists

When a calculated value for a period is presented, the middle of the period is used as
the timestamp.

Example:

The calculated value for the period 8:00-9:00 is stamped 8:30. If there is a value at 9:01,
the next period is 9:00-10:00, which is stamped as 9:30. The full period may not have
passed yet, but the value can be presented even if parts of the period are in the future.

14.16 Attaching a Calculation Method to a Trend Log List
You attach a calculation method to a trend log list to process the recorded values and
present the result.

For more information, see section 14.15 “Calculation Methods” on page 119.

To attach a calculation method to a trend log list

1. In WorkStation, in the System Tree pane, select the trend log list you want to
attach a calculation method to.

2. On the Trend Log List toolbar, click the Open trend log list settings button .

3. In the Trend Log List properties, in the Calculation method box, select a
calculation.

4. In the Delta over period box, select True if the calculation method is a delta
calculation with periods.

5. In the Period box, select the time span for which the calculation method is to be
executed.

NOTE:
• If Custom is selected in the Period box, enter a custom time span for which

the calculation method is to be executed in the Custom period box and the
time when you want the custom period to start in the Custom period
alignment boxes.

• To calculate the required number of records for a trend log, multiply the
number of records in one day with the number of days you want the trend
log to record. For example, the interval of the trend log is set to 1 hour, then
this gives 24 recorded values per day. The trend log should record at least
one month of recorded values equal to 31 days. For example, the number
of records = 24 x 31 = 744.
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6. In the Custom period box, enter a custom time span for which the calculation
method is to be executed.

7. In the Custom period alignment boxes, enter the time when you want the custom
period to start.

8. Click OK.

A calculation method is now attached to the trend log list.

14.17 Editing or Commenting a Trend Log Record
You edit or comment a trend log record through the trend log list, for example, to correct
a corrupt value or comment a specific record.

NOTE:
• When editing an extended trend log record, the changes do not affect

corresponding record in the connected trend log.

For more information, see the Trend Log Lists topic on WebHelp.

To edit a trend log record

1. In WorkStation, in the System Tree pane, select the trend log list you want to edit.

2. Select the record you want to edit, and then click the Edit/comment trend log

record button .

3. In the Edit/comment trend log record dialog box, in the Value box, type the new
value.

4. In the Comment box, type a comment.

5. Click Save.

6. On the main toolbar, click the Refresh button .

The record is now edited, when the list is refreshed the new record with comment is
displayed. All edits are stored and you can display a records history.
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14.18 Manually Adding a Trend Log Record to a Trend Log List
You manually add trend log records if a log record has been missed and you want to
complete the list or to add old values to compare the log record history to.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

To manually add a trend log record to a trend log list

1. In WorkStation, in the System Tree pane, select the folder or EcoStruxure BMS
server where the trend log list is located.

2. Select the trend log list to which you want add a record.

3. On the trend log list toolbar, click Add trend log record .

4. In the Add trend log record dialog box, in the Time stamp box, enter the date
and time of the new value.

5. In the Value box, enter the value.

6. In the Comment box, type a comment.

7. Click Add record.

8. Click Close.

The record is now added to the trend log list.
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15.1 How Trend Logs Work
You use trend logs to record values, such as a sensor. A trend log can also log
consumptions, such as energy consumption or water consumption.

You can view a trend log as a trend log list or as a trend chart.
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Figure – A trend list (upper left) and a trend chart (bottom right) in WorkStation

You can copy trend data between EcoStruxure Building Operation databases by
exporting trend log data from a trend log list to an .XML file and then importing the trend
log data from the .XML file to a trend log.

The .XML file contains a time stamp, value, and comment for each record. The file also
contains the locale setting that you can edit in the .XML file.

Figure – Trend log list exported to an .XML file

For more information, see section 15.15 “Importing Log Data to a Trend Log” on page
148.

15.1.1 Trend Charts

Trend charts are a way to graphically present trend logs. A trend chart can contain one
or more trend logs that are represented in the trend chart by lines or bars.
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For more information, see section 13.1 “How Trend Charts Work” on page 87.

15.1.2 Trend Log Lists in WorkStation

A trend log list displays all values in the trend log in a list.

For more information, see section 14.1 “Trend Log Lists in WorkStation” on page 114.

15.1.3 Trend Log Lists in WebStation

A trend log list displays all values in the trend log in a list.

For more information, see the Trend Log Lists in WebStation topic on WebHelp.

15.1.4 Trend Logs in WebStation

A trend log is a collection of time-stamp values. In WebStation, you can create a trend
log from a value or from a property in an object.

For more information, see the How Trend Logs Work in WebStation topic on WebHelp.

15.2 Trend Logs
A trend log is a collection of time-stamp values. In WebStation, you can create a trend
log from a value.

15.2.1 Interval Trend Logs

The interval trend log collects data at a specific time interval. Each logged value is
stored as a record in the trend log. Use this trend log when the logging interval is less
than 1 hour.

For more information, see section 15.3 “Interval Trend Logs ” on page 130.

15.2.2 Extended Trend Logs

You use an extended trend log to transfer records from a trend log. An extended trend
log can be connected to a trend log or connected in a series to another extended trend
log. Only one extended trend log can be connected to a trend log.

For more information, see section 15.10 “Extended Trend Logs” on page 140.

15.2.3 Log Record Storage

All trend logs use circular storing. How many records a trend log can store before
overwriting old ones depends on the trend log configuration.

For more information, see section 15.12 “Log Record Storage” on page 146.

15.2.4 Meter Function

The meter function adds meter properties to any trend log type to seamlessly handle
consumption calculations independent of meter rollover or meter exchange.

For more information, see section 15.7 “Meter Function” on page 137.
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15.3 Interval Trend Logs
The interval trend log collects data at a specific time interval. Each logged value is
stored as a record in the trend log. Use this trend log when the logging interval is less
than 1 hour.

You create interval trend logs using WorkStation or WebStation. In WorkStation, you
configure the properties of the interval trend log to meet the specific needs of your site.

For example, in the figure below, the interval trend log records a variable every minute.
The records are printed in a trend chart. The interval trend log does not record the
values between the intervals.
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Figure – Interval trend log schematic.
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The interval of the interval trend log is aligned with the activation time of the trend. For
example, if the activation time is 09:01:00 and the interval is 15 minutes, the trend will
log at 09:16:00, 09:31:00, 09:46:00, and so on.

15.3.1 Interval Time Zone

By default, the interval log uses UTC to determine when to take the next log sample.
When the interval is longer than 1 hour and you want to continue to log that interval after
a Daylight Savings Time change, use Server Local Time. For example, the log interval
is every 24th hour at midnight and you want to continue to log at midnight even after a
DST change, so you use Server Local Time. During the DST change in the Spring, the
log sample will register after 23 hours. After the DST change in the Autumn, the log
sample will register after 25 hours.

15.3.2 Interval Trend Log Delta

An interval trend log with delta can reduce the storage of similar records, and may not
fill up the storage capacity as quickly as an interval trend log with no delta.

An interval trend log with delta checks the monitored value at each interval and records
the new value if it differs from the previously recorded value by more than the delta.
Delta is the difference between the current variable value and the last log value. To log
a variable according to the time interval, use a delta of zero.

For example, in the figure below, the interval trend log records a variable every minute
but only if the variable exceeds or falls below the delta of 3. The records are printed in a
trend chart. Notice that the interval trend log with delta does not record the values
between the intervals, or on intervals where the variable is within the delta.

NOTE:
• To log a variable only according to the time interval, set Delta to zero.
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Figure – Interval trend log with delta schematic.
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If an interval trend log has a delta and a calculation method that uses periods, make
sure the period contains the required amount of records to generate a correct
calculation. If the value does not differ from the previously logged value by more than
the delta within the period, then none or too few values are recorded for the calculation.

NOTE:
• Adapt the period so it contains the required amount of records to generate a

correct calculation.
• If a calculation method is connected to an interval trend log with delta, make

sure that the period and delta are adapted for the calculation.

Interval trend log meter functionality

An interval trend log can be created with initial meter settings. The interval trend log
supports the meter change command and meter consumption calculation. You can view
the last meter change information on the interval trend log object. For more information,
see section 15.7 “Meter Function” on page 137.

15.4 Creating an Interval Trend Log
You create an interval trend log to record a value of a variable at specified and regularly
occurring increments of time.

For more information, see section 15.3 “Interval Trend Logs ” on page 130.

To create an interval trend log

1. In WorkStation, in the System Tree pane, select the folder or EcoStruxure BMS
server where you want to create the trend log.

2. On the File menu, point to New and then click Trend.

3. In the Create Object wizard, in the object type list, select Interval Trend Log.

4. In the Name box, type a name for the trend log.

5. In the Description box, type a description for the trend log.

6. Click Next.

7. In the Configure Interval Trend Log page, in the Logged variable box, enter the
variable that you want to log.

8. Click the Set unit button .

9. In the Unit Selection dialog box, select a unit for the trend log values.
10. In the Prefix box, select the prefix of the unit.

11. Click Select.

12. In the Delta box, enter the minimum value change that triggers a new record.
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13. In the Activation variable box, enter a variable to start recording values when the
acitvation variable is true

14. In the Activation time box, enter the exact time for the recording to begin.

15. In the Interval time zone box, select Server Local Time to avoid problems with
DST for logging intervals more frequent than 1 hour.

16. In the Interval box, type the log frequency.

17. In the Log size box, type the log size to be stored before old values are
overwritten.

18. In the Available trend storage box, check that the available number of records is
not exceeded.

19. In the Clear when enabled box, select True to clear the trend log every time the
trend log is enabled.

20. Click Next.

21. In the Initial Meter Settings page, in the Set initial meter box, select True to
enable the meter function.

22. In the Start time box, enter the time when the meter was installed.

23. In the Start value box, enter the value of the new meter when it was installed.

24. In the Min value box, enter the first value of the new meter after roll-over.

25. In the Max value box, enter the last value of the new meter before roll-over.

26. Click Next.
27. In the Connect Objects to the Trend Log page, in the Extended Trend Log box,

click the Browse button to create an extended trend log and connect it to the trend
log.

28. In the Trend Log List box, click the Browse button to create a trend log list and
connect it to the trend log.

29. In the Trend Chart box, click the Browse button to either create a new trend chart
or connect the interval trend log to an existing trend chart.

30. Click Create.

15.5 Configuring an Interval Trend Log
You configure the properties of an interval trend log to meet the unique needs of your
site.

For more information, see section 15.3 “Interval Trend Logs ” on page 130.

To configure an interval trend log

1. In WorkStation, in the System Tree pane, click the interval trend log you want to
configure.
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2. On the File menu, click Properties.

3. In the properties dialog box, click the Basic tab.

4. Edit the basic properties:

Property Description

Status Displays the status of the trend log.

Enabled Displays True if the trend log is enabled.

Logged variable Enter the variable you want to log.

Delta Select the minimum value change that
triggers a new record.
For more information, see the Interval
Trend Log Delta topic on WebHelp.

Activation variable Enter the variable that makes the trend log
start recording values when the variable is
True.
For more information, see the Trend Log
Activation topic on WebHelp.

Activation time Specify the time when the trend log is to
start recording values.
For more information, see the Trend Log
Activation topic on WebHelp.

Interval Type how often to log the variable. The
interval defines the time between two log
records.

Log size Select the number of records to store
before old records are overwritten,
including internal records generated by the
trend log.
For more information, see section 15.12
“Log Record Storage” on page 146.

Clear when enabled Select True to clear the trend log when it is
enabled.

5. Click the Meter Info tab.

6. Edit the meter properties:

Property Description

Is meter log Select True if the trend log meter function
is active.
For more information, see section 15.7
“Meter Function” on page 137.

Meter change time Enter the time when the meter was
changed.

Meter change user Enter the name of the user account that
changed the meter.

End time Enter the time when the old meter was
replaced.
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Continued

Property Description

End value Enter the value the old meter had when it
was replaced.

Start time Enter the time when the new meter was
installed.

Start value Enter the value of the new meter when it
was installed.

Meter constant Enter the constant of the new meter. If the
meter counts in kilo (103), the constant is
1000.

Min value Enter the first value of the new meter after
roll-over.

Max value Enter the last value of the new meter
before roll-over.

7. Click OK.

15.6 Editing the Interval of an Interval Trend Log
You edit the interval property of a trend log to increase or decrease the frequency of
records.

For more information, see section 15.3 “Interval Trend Logs ” on page 130.

To edit the interval of an interval trend log

1. In WorkStation, in the System Tree pane, click the interval trend log whose
interval you want to edit.

2. In the Interval box, type the new value.

3. Click the Save button .

15.7 Meter Function
The meter function adds meter properties to any trend log type to seamlessly handle
consumption calculations independent of meter rollover or meter exchange.

You create and configure the meter function in trend logs using WorkStation.

For example, in the figure below, the meter function in the trend log records a meter the
1st of every month. In the middle of February, the meter rolls over to 00000. A chart with
meter consumption calculation prints the consumption every month.
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Figure – Meter trend log

The calculation function supports negative meter consumption values, which can be
used to handle cases where you need to subtract consumption, for example, when
energy is produced on site.



Trend Logs

13904-50007-01-en, December 2022

WorkStation
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When physically replacing an old meter with a new one, you have to configure the meter
function of the trend log by adding the configuration and values of both the old and the
new meter. These configurations and values are the foundation when handling a meter
rollover or calculating consumption though meter replacement. For more information,
see section 15.8 “Managing Meter Replacement ” on page 139.

Figure – Manage replacement of meter dialog box where you enter the values of both
the old and the new meter

NOTE:
• In order for a meter rollover to be managed correctly in the meter trend log and

to ensure logging starts at the correct energy reading value, you enter previous
meter and new meter information in the Manage replacement of meter dialog
box. For more information, see section 15.8 “Managing Meter Replacement ” on
page 139.

15.8 Managing Meter Replacement
You have to manage the meter configuration and values each time a meter is replaced.

For more information, see section 15.7 “Meter Function” on page 137.

To manage meter replacement

1. In WorkStation, in the System Tree pane, select the trend log whose meter
configuration you want to manage.

2. On the File menu, click Properties.

3. In the End time box, enter the end time of the old meter.

4. In the End value box, type the value of the old meter when it was replaced.

5. In the Start time box, enter the start time of the new meter.

6. In the Start value box, type the current value of the new meter.
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7. In the Meter constant box, type the constant value of the new meter.

IMPORTANT:
• Type the constant of the new meter if unit conversion is not used in the

trend log, for example, the old trend log counted in grams and the new one
counts in kilos (103) type 1000.

• If unit conversion is used in the trend log - do not change the meter
constant.

8. In the Min value box, type the first value of the new meter when it rolls over.

9. In the Max value box, type the last value of the new meter before it rolls over.

10. Click OK.

15.9 Displaying Meter Change History
You view, through a trend log list, all meter change events that are registered by the
meter trend log.

NOTE:
• The meter change history is only applicable for the meter trend log.

For more information, see section 15.7 “Meter Function” on page 137.

To display meter change history

1. In WorkStation, in the System Tree pane, select the trend log list that is connected
to a meter trend log.

2. On the Trend Log List toolbar, click the Show list of meter change events

button .

3. Click Close.

It is important that all meter changes are registered in the Manage replacement of
meter dialog box.

15.10 Extended Trend Logs
You use an extended trend log to store records from a trend log. An extended trend log
can be connected to a trend log or connected in a series to another extended trend log.
Only one extended trend log can be connected to a trend log or another extended trend
log.

You create and configure extended trend logs from WorkStation.

IMPORTANT:
• The extended trend log cannot log a variable.
• The extended trend log gets the initial value of the connected trend log.
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• Do not connect more than one extended trend log to a trend log or another
extended trend log. If a trend log is connected to two or more extended trend
logs, critical conflicts can occur.

• The extended trend log must have the same unit as the monitored trend log to
correctly display values.

Figure – Do not connect more than one extended trend log to a trend log or extended trend log.

The extended trend log is often saved on an Enterprise Server or an Enterprise Central
with more storage capacity than the automation server where the ordinary trend log is
saved. This extra storage capacity enables the Enterprise Server or Enterprise Central
to store more records before it overwrites old ones. The extended trend log can be
viewed in a trend log list or a trend chart.

You can configure the extended trend log to transfer data several ways: Smart log,
percentage, time interval, or force transfer.
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Table – Extended Trend Log Transfer Criteria

Function Explanation

Smart log Automatically updates the transfer rate with
respect to the frequency of records, network
speed, and the capacity of the EcoStruxure
BMS server that runs the trend log and the
extended trend log.

Threshold Transfers records every time a specific
percentage threshold of records on the trend
log is reached.

Maximum transfer interval Transfers records at a specific time interval
even though the threshold or Smart log
condition is not reached.

Transfer trigger variable Transfers records when triggered by a
variable that changes state from false to true,
for example, a digital schedule. The transfer
takes place regardless of the transfer
threshold. This function can be used to ensure
that the extended trend log contains all
records, for example, to generate a complete
report at the end of every month.

Force transfer Executed by the user to manually force a
transfer even though transfer threshold is not
reached.

When you create extend trend logs for BACnet or Xenta trend logs, be sure to create
the extended trend log on the same EcoStruxure BMS server that hosts the BACnet or
Xenta device and its trend log. This ensures that they remain synchronized in the event
the server needs to be restored.

For more information, see the Extended Logging for External BACnet Trend Logs
Workflow topic on WebHelp.

For more information, see the Trend Logs for Xenta LonWorks Devices topic on
WebHelp.
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Figure – Extended trend log that transfers records from a trend log each time the trend log exceeds a
record volume of 20% or every hour.
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When you edit a record in the extended trend log, the changes do not affect the
connected trend log. If you edit a record in the trend log, the changes are transferred to
the extended trend log next time a transfer occurs. You can edit both the trend log and
the corresponding record in the extended trend log, but the edit is written twice in the
extended trend log record under certain circumstances:

• the record in the extended trend log is manually updated

• the corresponding edit is transferred from the trend log to the extended trend log

The trend log list or trend chart displays the last written value of an edited record.

Example 1: You edit a record in a trend log that is connected to an extended trend log.
The extended trend log is updated with the edited record. After the transfer, you update
the corresponding record in the extended trend log. The trend log list and trend chart
connected to the extended trend log display the last value of the record, which in this
case is the extended trend log edit.

Example 2: You edit a record in a trend log that is connected to an extended trend log.
Before the extended trend log is updated with the edited record, you edit the
corresponding record in the extended trend log. After a while the trend log transfers its
edited record to the extended trend log. The trend log list and trend chart connected to
the extended trend log display the edited trend log record value and not the edited
extended trend log record value. In this case, the trend log list and trend chart display
the last value that was written to the extended trend log, not the last edited value.

You can view all edits, automatically transferred or manually added, in the record
history.

15.10.1 Archive Overview

Archiving is the process of preserving historical data, which is comprised of selected
events and extended trend logs. For example, some facilities are required to maintain
archives to comply with government regulations. Another example is in secure facilities
where they must maintain records of who logged in or who changed setpoints. Archiving
is not a backup function because archive data cannot be imported back into the system.

For more information, see the Archiving Overview topic on WebHelp.

15.10.2 Extended Trend Log Meter Support

You can view the meter properties of the connected trend log, if the meter function is
enabled on the connected trend log. For more information, see section 15.7 “Meter
Function” on page 137.

15.11 Configuring an Extended Trend Log
You configure the properties of an extended trend log to meet the unique needs of your
site.

For more information, see section 15.10 “Extended Trend Logs” on page 140.
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To configure an extended trend log

1. In WorkStation, in the System Tree pane, select the extended trend log you want
to configure.

2. On the File menu, click Properties.

3. In the properties dialog box, click the Basic tab.

4. Edit the basic properties:

Component Description

Monitored trend log Enter the path to the trend log you want to
transfer records from.

Unit The unit of an extended trend log created
from the trend log wizard at the same time
as the connected trend log inherits the unit
of measurement from the connected trend
log.
The unit of an extended trend log that is
manually connected to a trend log needs to
be manually configured to use the same
unit of measurement as the connected
trend log.

Smart log Select True to optimize the transfer of the
monitored trend log to the extended trend
log.

Threshold Select the percentage threshold at which
the trend log transfers its records to the
extended trend log.

Maximum transfer interval Select the maximum length of time that can
pass between transfers from the monitored
trend log to the extended trend log.

Transfer trigger variable Enter a trigger variable to force a transfer
of all records from the trend log to the
extended trend log, for example, to
generate a complete report.
For more information, see section 15.10
“Extended Trend Logs” on page 140.

Log size Select the number of records to store
before old records are overwritten,
including internal records generated by the
trend log.
For more information, see section 15.12
“Log Record Storage” on page 146.

Include in reports Select True to include the extended trend
log data in reports.

5. Click the Meter Info tab.
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6. View the meter properties:

Property Description

Is meter log Displays True if the trend log meter
function is active.
For more information, see section 15.7
“Meter Function” on page 137.

Meter change time Displays the time when the meter was
changed.

Meter change user Displays the name of the user account that
changed the meter.

End time Displays the time when the old meter was
replaced.

End value Displays the value the old meter had when
it was replaced.

Start time Displays the time when the new meter was
installed.

Start value Displays the value of the new meter when it
was installed.

Meter constant Displays the constant of the new meter. If
the meter counts in kilo (103), the constant
is 1000.

Min value Displays the first value of the new meter
after roll-over.

Max value Displays the last value of the new meter
before roll-over.

NOTE: Meter properties are only available if the meter properties of the
connected trend log are active.

7. Click OK.

15.12 Log Record Storage
All trend logs use circular storing. How many records a trend log can store before
overwriting old ones depends on the trend log configuration.

For example, a trend log is configured to store 10 records. The logging starts and the
first record x1 is stored. After 10 records the trend log is full. The next record x11
overwrites the oldest record which in our case is x1. The next logging x12 overwrites the
oldest record x2, and so on.

Additional internal records can be generated by the log itself. These records may not be
visible. Internal records are a part of the log usage.

If you try to configure a trend log to store a larger number of log records than the
EcoStruxure BMS server can manage, the trend log is not created.
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Figure – Circular storing, schematic

15.13 Editing the Log Size for a Trend Log
You increase or decrease the number of records to be stored in the trend log before
records are overwritten.

For more information, see section 15.12 “Log Record Storage” on page 146.

To edit the log size for a trend log

1. In WorkStation, in the System Tree pane, click the trend log whose log size you
want to edit.

2. In the Extended Trend Log properties, in the Log size box, enter the new value.

3. Click the Save button .

15.14 Manually Adding a Trend Log Record to a Trend Log
You manually add trend log records if a log record has been missed and you want to
complete the log or to add old values to compare the log record history to.

For more information, see section 15.2 “Trend Logs” on page 129.

To manually add a trend log record to a trend log

1. In WorkStation, in the System Tree pane, select the folder or EcoStruxure BMS
server where the trend log is located.

2. Select the trend log to which you want add a record.

3. On the Actions menu, point to Modification and then click Add trend log record.
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4. In the Add trend log record dialog box, in the Time stamp box, enter the date
and time of the new value.

5. In the Value box, enter the value.

6. In the Comment box, type a comment.

7. Click Add record.

8. Click Close.

The record is now added to the trend log.

15.15 Importing Log Data to a Trend Log
You import trend log data to move trend log data between systems.

For more information, see section 15.1 “How Trend Logs Work” on page 127.

To import log data to a trend log

1. In WorkStation, in the System Tree pane, select the trend log to which you want to
import log records.

2. On the Actions menu, point to Modification and then click Import log data.

3. Select the .XML file you want to import.

4. Click Open.

The imported log data is displayed in the trend log list view of the trend log.
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16.1 How Schedules Work
Schedules are used to schedule the operation of part of the building management
system, such as a fan, a door, or a setpoint. Using a schedule, a fan can be set to
operate between 08:00 and 17:00 every workday.

Schedules can be overridden by different types of exceptions. For example, if you want
to shut the fan down the last Friday in every month due to maintenance, you can use a
calculated exception. The exception is added to the schedule and turns off the fan the
last Friday in every month.

If you want to shut down the fan during the summer vacation, you can use a Calendar
exception. In this case, you use an already created calendar that defines the summer
vacation. This calendar is added to the schedule as an exception and the fan will be
shut down during all days of the summer vacation defined by the calendar.
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16.1.1 Schedule Editor in WorkStation

Figure – Schedule editor calendar exceptions
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The Basic view of the Schedule Editor serves as a workspace to plan and design a
schedule. You use this editor to create, manage, and display weekly scheduled events
and exception events.

For more information, see section 16.2 “Basic View of the Schedule Editor” on page
152.

16.1.2 Schedule Editor in WebStation

The Schedule Editor serves as a workspace to plan and design a schedule. You use
this editor to create, manage, and display weekly scheduled events and exception
events.

For more information, see the Schedule Editor in WebStation topic on WebHelp.

16.1.3 Schedule Colors in WorkStation

A schedule has a color code so you can identify weekly events and exception events at
a glance. This color code can assist you when you are modifying your schedule or trying
to troubleshoot any problems.

For more information, see section 16.3 “Schedule Colors in WorkStation” on page 153.

16.1.4 Schedule Colors in WebStation

A schedule has a color code so you can identify weekly events and exception events at
a glance. This color code can assist you when you are modifying your schedule or trying
to troubleshoot any problems.

For more information, see the Schedule Colors in WebStation topic on WebHelp.

16.1.5 Schedule Navigation in WorkStation

You can navigate in a schedule day-by-day, month-by-month, or year-by-year.

For more information, see section 16.5 “Schedule Navigation in WorkStation” on page
156.

16.1.6 Schedule Navigation in WebStation

You can navigate in a schedule day-by-day, month-by-month, or year-by-year.

For more information, see the Schedule Workspace Toolbar topic on WebHelp.

16.1.7 Schedule Events

Scheduled events are used to control different types of devices, for example lights, fans
or doors.

For more information, see section 16.9 “Schedule Events” on page 158.
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16.1.8 Calendars in WorkStation

A calendar is a list of dates. The calendar provides the schedule with the dates when
the exception events shall occur. To save time, you can reference a single calendar
rather than entering several exception events in a schedule.

For more information, see section 18.1 “Calendars in WorkStation” on page 177.

16.1.9 Calendars in WebStation

A calendar is a list of dates. The calendar provides the schedule with the dates when
the exception events shall occur. To save time, you can reference a single calendar
rather than entering several exception events in a schedule.

For more information, see the Calendars in WebStation topic on WebHelp.

16.1.10 Schedules Types

You can create three types of schedules: Digital, Multistate, or Analog. You create a
digital schedule if the schedule needs to control a device with two output states, such as
On or Off. You create a multistate schedule if the schedule needs to control a device
that has output states based on multiple states, such as low, medium, or high. You
create an analog schedule if the schedule controls a device that gauges the output in
real numbers.

For more information, see section 16.16 “Schedule Types ” on page 162.

16.1.11 Xenta Schedules in WebStation

Xenta Time Schedules and Xenta Central Time Schedules can be edited in
WebStation. You can add, edit and delete weekly and exception events. You can assign
and unassign lead Xenta central schedules. The Xenta Time Schedules and Xenta
Central Time Schedules must be created using WorkStation.

For more information, see the Xenta Schedules in WebStation topic on WebHelp.

16.1.12 Multi Schedule Viewer in WebStation

You can create a Multi schedule viewer in WebStation to edit and view a number of
schedules at the same time.

For more information, see the Multi Schedule Viewer topic on WebHelp.

16.2 Basic View of the Schedule Editor
The Basic view of the Schedule Editor serves as a workspace to plan and design a
schedule. You use this editor to create, manage, and display weekly scheduled events
and exception events.

You can also display the client time zone and the server time zone in the Basic view.
This is convenient if your EcoStruxure BMS server is located in a time zone that is
different from the time zone where you are configuring the schedule. For more
information, see the Time Zones topic on WebHelp.
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The following figure displays the schedule of the lights within the building. The weekly
events are in green and the exception event in blue. The values of the events are also
displayed. Monday, November 12 is an exception event so it does not follow the same
scheduled events as the rest of the week. The lights are off all day. For the rest of the
week, the lights turn on at 07:00 and turn off at 18:00.

Figure – Basic view of the Schedule Editor

16.3 Schedule Colors in WorkStation
A schedule has a color code so you can identify weekly events and exception events at
a glance. This color code can assist you when you are modifying your schedule or trying
to troubleshoot any problems.

16.3.1 Basic Schedule View

In the Event grid, weekly events and exception events display in distinct colors to clearly
identify them. Similar events that are next to each other are highlighted in different
shades of the same color so you can easily see the start and stop time. For example, a
meeting scheduled from 8:00 to 12:00 is dark green while the weekday event from
12:00 to 17:00 is in light green. In the Calendar view, you can view the weekly events
and exception events across several months and the selected day in black.
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Figure – Basic Schedule Editor colors

Table – Basic Schedule Editor Colors

Color Description

Cream Event grid: default value

Green Event grid: weekly events

Blue Event grid: exception events

Light blue Calendar view: exception events

Black Calendar view: selected day

Priority Level Conflicts

The Event grid also highlights a conflict in dark blue if there are two exception events
that overlap on the same day and have different values, but are set at the same priority
level.
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Figure – Priority level conflict

For more information, see the Priorities topic on WebHelp.

16.3.2 Advanced Schedule View

In the Event gride, weekly and exception events are both green in the Advanced
Schedule. Events that are next to each other in the schedule are presented in different
intensities of green so you can easily see the start and stop time of these events. In the
Calendar view, you can view the exception events presented in light blue. The selected
event is presented in a darker blue.

Figure – Advanced Schedule Editor colors
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Table – Advanced Schedule Editor Colors

Color Description

White Event grid: default value

Green Event grid: weekly and exception events

Light blue Calendar view: exception events

Blue Calendar view: selected exception event

16.4 Viewing a Schedule
You view a schedule using Basic Schedule Editor.

For more information, see section 16.2 “Basic View of the Schedule Editor” on page
152.

To view a schedule

1. In WorkStation, click on the schedule.

The schedule is displayed in Basic Schedule Editor.

16.5 Schedule Navigation in WorkStation
You have some navigation tools to use when you navigate the Basic Schedule Editor,
the Advanced Schedule Editor, and the Calendar Editor. To navigate the editors, you
can use the tools described in the following table.

Table – Schedule and Calendar Editor Navigation Tools

Tool Description

Year
Enter the year you want to display in the
schedule calendar. For more information, see
section 16.1 “How Schedules Work” on page
149.
Navigation arrows to move ahead or
backward one month

Back One Month
Click to step a month back in the schedule
calendar. For more information, see section
16.1 “How Schedules Work” on page 149.

Forward One Month
Click to step a month forward in the schedule
calendar. For more information, see section
16.1 “How Schedules Work” on page 149.

Back a Week
Click to step a week back in the schedule
week view. Only avaialbe in the Basic
Schedule Editor. For more information, see
section 16.2 “Basic View of the Schedule
Editor” on page 152.
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Tool Description

Back a Day
Click to step a day back in the schedule week
view. Only avaialbe in the Basic Schedule
Editor. For more information, see section 16.2
“Basic View of the Schedule Editor” on page
152.

Forward a Day
Click to step a day forward in the schedule
week view. Only avaialbe in the Basic
Schedule Editor. For more information, see
section 16.2 “Basic View of the Schedule
Editor” on page 152.

Forward a Week
Click to step a week forward in the schedule
week view. Only avaialbe in the Basic
Schedule Editor. For more information, see
section 16.2 “Basic View of the Schedule
Editor” on page 152.

16.6 Scrolling a Day in a Schedule
You scroll a day in a schedule using the Forward a Day and Back a Day buttons.

For more information, see section 16.5 “Schedule Navigation in WorkStation” on page
156.

To scroll a day in a schedule

1. Click the View all schedule events button .

2. Click the Forward a Day button or click the Back a Day button .

16.7 Scrolling a Week in a Schedule
You scroll a week in a schedule using the Forward a Week and Back a Week buttons.

For more information, see section 16.5 “Schedule Navigation in WorkStation” on page
156.

To scroll a week in a schedule

1. Click the View all schedule events button .

2. Click the Forward a Week button or click the Back a Week button .

16.8 Editing the Grid Time Interval
You edit the grid time interval for the shedule view to define how precis you can be
when editing the time span of a schedule event using the drag and drop method.
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For more information, see the Advanced View of the Schedule Editor topic on WebHelp.

To change the grid time interval

1. In WorkStation, in the System Tree pane, select the schedule for which you want
to change the grid time interval.

2. Click the Advanced tab.

3. Right-click the Server Time bar, point to Snap To, and then select a time interval
for the grid.

16.9 Schedule Events
A schedule has two types of events: weekly events and exception events. Weekly
events occur every week at specified times. Exception events occur when the schedule
deviates from the weekly schedule, such as during holidays. Exception events override
the weekly events when there is an overlap.

For each schedule except Xenta schedules, you can set a default value. The default
value goes into effect after the exception events and weekly events are complete or
relinquish control. For example, the weekly event for a fan ends at 17:00. The fan ran at
a value of 3 (high) throughout the event. There are no scheduled events after the
weekly event. Because you have assigned 0 as the default value, the fan adjusts to the
default value and turns to 0 (off). The value remains at 0 until the next scheduled event.

Events occur in the following order of precedence:

• Exception events

• Weekly events

• Default value

Xenta schedules do not have any default values.

Example:

The weekly event for a fan is set to '08:00 - 17:00'. An exception event is set to '17:00 -
20:00' for a specific date. The exception event overrides the weekly event so that the
fan only runs from 17:00 to 20:00 on the specified date.

Xenta schedule events occur in the following order of precedence:

• Exception events

• Weekly events

16.9.1 Weekly Events in WorkStation

A weekly event occurs every week for an extended period of time on a regular basis.
You can schedule more than one weekly event for each day of the week.

For more information, see section 16.10 “Weekly Events in WorkStation” on page 159.
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16.9.2 Weekly Events in WebStation

A weekly event occurs every week for an extended period of time on a regular basis.
You can schedule more than one weekly event for each day of the week.

For more information, see the Weekly Events in WebStation topic on WebHelp.

16.9.3 Exception Events in WorkStation

An exception event occurs instead of the scheduled weekly events for a single date,
date range, calculated date, or calendar reference.

For more information, see section 17.1 “Exception Events in WorkStation” on page 167.

16.9.4 Exception Events in WebStation

An exception event occurs instead of the scheduled weekly events for a single date,
date range, calculated date, or calendar reference.

For more information, see the Exception Events in WebStation topic on WebHelp.

16.9.5 Priorities

Priority is a number that corresponds to a preassigned level of importance. When used
in schedules, priority numbers range from one to sixteen. One is the most important or
highest priority and sixteen is the lowest priority.

For more information, see the Priorities topic on WebHelp.

16.9.6 Time Zones

When you create a schedule, the time zone of the EcoStruxure BMS server that
contains the schedule determines the execution of the events. If the schedule is copied
to an EcoStruxure BMS server in a different time zone, the specified dates and times
relate to the new time zone.

For more information, see the Time Zones topic on WebHelp.

16.10 Weekly Events in WorkStation
A weekly event occurs every week for an extended period of time on a regular basis.
You can schedule more than one weekly event for each day of the week.
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Figure – Weekly events in an EcpStruxure Building Operation schedule

If there are any non-routine events, such as holidays, you can use exception events to
override the schedule. For more information, see section 17.1 “Exception Events in
WorkStation” on page 167.

16.11 Viewing a Schedule Event
You view schedule events to see the schedule for one or more events.

For more information, see section 16.9 “Schedule Events” on page 158.

To view a schedule events

1. In WorkStation, in the System Tree pane, select the schedule you want to view.

2. Click the Basic tab.

3. On the Schedule toolbar, click the View All Schedule Events button .

16.12 Editing the Time for a Weekly Event
You change the time for a weekly schedule event using the Basic Schedule Editor.

For more information, see section 16.10 “Weekly Events in WorkStation” on page 159.

To edit the time for a weekly event

1. In WorkStation, in the System Tree pane, click the schedule with the event you
want to change.

2. In Basic Schedule Editor, click the View weekly schedule events button .
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3. Click the schedule events you want to change the time for.

4. Click on the events node to extend or reduce the time for the schedule.

5. On the File menu, click Save.

16.13 Adding a Weekly Event
You add weekly events to a schedule to determine when the event is to regularly occur.
Weekly events always occur regularly unless overridden by an exception event.

For more information, see section 16.10 “Weekly Events in WorkStation” on page 159.

To add a weekly event

1. In WorkStation, in the System Tree pane, select the schedule you want to add the
weekly event to.

2. Click the Basic tab.

3. On the Basic Schedule Editor toolbar, click the View weekly schedule events

button .

4. In the grid, click the start time. Drag the cursor vertically to select the end time and
then horizontally to select all days for which the event should be valid.

5. On the File menu, click Save.

16.14 Editing a Weekly Event
You edit a weekly event to change the information about a weekly event on a single
day.

To edit a weekly event

1. In WorkStation, in the System Tree pane, select the schedule you want to edit.

2. In the Work area, click the Basic view.

3. In the Event grid, select the weekly event you want to edit.

4. On the Basic toolbar, click the Edit schedule event button .

5. In the Schedule event properties dialog box, edit the properties.

Component Description

Event type Click Weekly to select a weekly event type.

Days of week Select the days of the week that apply to
this schedule.

All Day Select to create an all day event.
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Component Description

Click to add a line to the Times and values
box.

Click to delete an entry from the Times
and values box.

6. Click Ok.

16.15 Deleting a Schedule Event
You delete a weekly or exception event from a schedule when the event is not in use.

For more information, see section 16.9 “Schedule Events” on page 158.

To delete a schedule event

1. In WorkStation, in the System Tree pane, select the schedule you want to delete
the schedule event from.

2. In the Work area, click the Basic view.

3. Select the weekly event or exception event you want to delete.

4. On the Basic toolbar, click the Delete button .

5. On the File menu, click Save.

16.16 Schedule Types
You can create three types of schedules: Digital, Multistate, or Analog. You create a
digital schedule if the schedule needs to control a device with two output states, such as
On or Off. You create a multistate schedule if the schedule needs to control a device
that has output states based on multiple states, such as low, medium, or high. You
create an analog schedule if the schedule controls a device that gauges the output in
real numbers.

You create schedules using WorkStation.

16.16.1 Analog Schedules

An analog schedule controls a device that gauges the output in real numbers. The real
numbers include positive or negative numbers, fractions, and decimal values.

For more information, see section 16.19 “Analog Schedules” on page 164.

16.16.2 Digital Schedules

A digital schedule controls a device that has an on output state and an off output state.

For more information, see section 16.17 “Digital Schedules” on page 163.
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16.16.3 Multistate Schedules

A multistate schedule controls a device that has output states based on integers or
positive whole numbers including zero.

For more information, see section 16.21 “Multistate Schedules” on page 165.

16.17 Digital Schedules
A digital schedule controls a device that has an on output state and an off output state.

For example, you can create a digital weekly schedule that is bound to a digital output,
such as a light switch. To turn on the lights Monday through Friday from 08:00 to 17:00,
you can set the value to On when the schedule is active and Off when the schedule is
inactive.

Figure – Digital Schedule

16.18 Editing the Status for a Weekly Event in a Digital
Schedule

You change the status in a digital schedule event using Basic Schedule Editor.

For more information, see section 16.10 “Weekly Events in WorkStation” on page 159.

To edit the status for a weekly event in a digital schedule

1. In WorkStation, click the schedule with the event you want to change.

2. In Basic Schedule Editor, click the View weekly schedule events button .

3. Click the schedule events you want to change.
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4. On the Basic Schedule Editor toolbar, change the status in the box.

5. Click Set.

6. On the File menu, click Save.

16.19 Analog Schedules
An analog schedule controls a device that gauges the output in real numbers. The real
numbers include positive or negative numbers, fractions, and decimal values.

For example, you can create an analog schedule to regulate a thermostat setpoint in an
office area. To control the temperature from 08:00 to 17:00, you can set the value to 22
°C (72 °F) when the schedule is active and 16 °C (62 °F) when the schedule is inactive.

Figure – Analog Schedule

16.20 Editing the Value for a Weekly Event in an Analog
Schedule

You change the value in an analog schedule event using Basic Schedule Editor.

For more information, see section 16.19 “Analog Schedules” on page 164.

To edit the value for a weekly event in an analog schedule

1. In WorkStation, click the schedule with the event you want to change.

2. In Basic Schedule Editor, click the View weekly schedule events button .

3. Click the schedule events.

4. On the Basic Schedule Editor toolbar, enter the new value in the box.
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5. Click Set.

6. On the File menu, click Save.

16.21 Multistate Schedules
A multistate schedule controls a device that has output states based on integers or
positive whole numbers including zero.

For example, you can create a multistate weekly schedule that is bound to a multistate
value to control an air handler unit in an office building. To regulate the air circulation
Monday through Friday from 08:00 to 17:00, you can set the value to 2 (occupied) when
the schedule is active and 1 (unoccupied) when the schedule is inactive.

Figure – Multistate Schedule

16.22 Editing the State for a Weekly Event in a Multistate
Schedule

You change the state in a multistate schedule event using Basic Schedule Editor.

For more information, see section 16.21 “Multistate Schedules” on page 165.

To edit the state for a weekly event in a multistate schedule

1. In WorkStation, click the schedule with the event you want to change.

2. In Basic Schedule Editor, click the View weekly schedule events button .

3. Click the schedule events you want to change.

4. On the Basic Schedule Editor toolbar, enter the new value in the box.
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5. Click Set.

6. On the File menu, click Save.

16.23 Saving a Schedule
You save a schedule when you want to keep your scheduled weekly events or
exception events.

To save a schedule

1. In WorkStation, in the System Tree pane, select the schedule you want to save.

2. In the Work area, click the Basic view.

3. On the toolbar, click the Save button .
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17.1 Exception Events in WorkStation
An exception event occurs instead of the scheduled weekly events for a single date,
date range, calculated date, or calendar reference.

For example, you create an exception event in March for an intense aerobics class in
the gym to open an air vent to 100 % from 06:30 to 17:00 every Wednesday in March.
This exception event takes precedence over the regularly scheduled weekly
Wednesday events.

When scheduling exception events, you can use four exception types to provide
flexibility and control in your schedule.

17.1.1 Date Exception Events

A single date exception event can occur on a single day, or you can use the options for
the event to occur on more than one day. The options such as Any year and Any day
provide flexibility. To schedule a single date event to take place every year on October
31, you select the following single date options:

• Year: Any year

• Month: October

• Day of month: 31

• Day of week: Any day

17.1.2 Date Range Exception Events

A date range exception event is an event that lasts over a period of time. In addition to a
specific day of month, you can select Odd, Even, or Any month, and Any day or Last
day, to provide the flexibility to a date range. For example, to schedule an exception
event to occur annually from the last day of March to the last day of April, select the
following options for the start and end dates:
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Start Date

• Start year: Any year

• Start month: March

• Day of month: Last day

• Day of week: Any day

End Date

• Year: Any year

• Month: April

• Day of month: Last day

• Day of week: Any day

17.1.3 Calculated Exception Events

A calculated date is an exception event that recurs. Other than a specific month and
week, you can select Any month and Any week or Last week, to provide flexibility to a
calculated date. For example, to schedule the Monday of the first week of every month
for an exception event, select the following options:

• Month: Any month

• Week of month: First week

• Day of week: Monday

17.1.4 Calendar Exception Events

A calendar reference allows you to apply an exception event for all dates specified in
the calendar. For example, to schedule exception events for all holidays on a calendar,
you select the calendar you want to reference and the schedule will follow the holidays
created in the calendar.

17.2 Adding a Date Exception Event
You add a single date exception event to make an exception for a specific day in the
schedule, such as 10 December, 2013.

For more information, see section 17.1 “Exception Events in WorkStation” on page 167.

To add a date exception event

1. In WorkStation, in the System Tree pane, select the schedule you want to add the
single date exception event to.

2. Click the Basic tab.

3. On the Basic Schedule Editor toolbar, click the New schedule event button

.
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4. Click Exception.

5. In Schedule Event Properties dialog box, in the Exception type box, click
Single date.

6. Select All Day if the exception event is to be on or off all day.

7. In the Start Time column, type a start time for the exception event.

8. In the End Time column, type an end time for the exception event.

9. In the Value column, select a value for the exception event.

10. In the Name box, type a name for the exception event.

11. In the Priority box, select a priority for the exception event to make it override
conflicting events with lower priorities.

12. In the Year box, select the year for the single date.

13. In the Month box, select the month for the single date.

14. In the Day of month, select a day of month for the single date.

15. In the Day of week box, select a weekday for the single date.

16. Click OK.

17. On the File menu, click Save.

17.3 Editing a Date Exception Event
You edit a date exception event to change the information about an exception event.

To edit a date exception event

1. In WorkStation, in the System Tree pane, select the schedule containing the date
exception event you want to edit.

2. Click the Basic tab.
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3. In the calendar view, select the date when the date exception event you want to
edit is valid.

4. In the event grid, select the date exception event you want to edit.

5. Click the Edit schedule event button .

6. In the Schedule Event Properties dialog box, edit the properties.

Component Description

Event type Click Exception to display the exception types.

Exception type Select Single date for the exception type to apply to the schedule.

Click to add a line to the Times and values box.

Click to delete an entry from the Times and values box.

All Day Select to create an all day event.

Name Type a name for the exception event.

Priority Select a priority number between 1 (highest priority) and 16 (lowest
priority).

Year Select a year. You can use Any year as a valid entry.

Month Select a month for the exception event or Odd month, Even
month, Any month.

Day of month Select a value for the day of the month. You can use Any Day, Last
day, Odd days or Even days as valid entries.
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Component Description

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

7. Click OK.

17.4 Adding a Date Range Exception Event
You create a date range exception to schedule a date range event that takes
precedence over a scheduled weekly event.

To add a date range exception event

1. In WorkStation, in the System Tree pane, select the schedule you want to add the
date range exception event to.

2. Click the Basic view.

3. On the Basic toolbar, click the New schedule event button .

4. In the Schedules Event Properties dialog box, under Event type, click
Exception.

5. Under Exception type, click Date range.

6. Select All Day to have the event last all day.

7. In the Value box, enter a value.

8. In the Name box, type a name for the exception.

9. In the Priority box, select a priority.

10. In the Year box, select a year for the start date and the end date.

11. In the Month box, select a month for the start date and end date.

12. In the Day of month box, select a day of the month for the start date and end date.

13. In the Day of week box, select a day of the week for the start date and end date.

14. Click OK.

17.5 Editing a Date Range Exception Event
You edit a date range exception event to change the information about an exception
event.
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To edit a date range exception event

1. In WorkStation, in the System Tree pane, select the schedule containing the date
range exception event you want to edit.

2. Click the Basic tab.

3. In the calendar view, select the date when the date range exception event you
want to edit is valid.

4. In the event grid, select the date range exception event you want to edit.

5. Click the Edit schedule event button .

6. In the Schedule Event Properties dialog box, edit the properties.

Property Description

Event type Click Exception to display the exception types.

Exception type Select Date range for the exception to apply to the schedule.

Click to add a line to the Times and values box.

Click to delete an entry from the Times and values box.

All Day Select to create an all day event.

Name Type a name for the event.

Priority Select a priority number between 1 (highest priority) and 16 (lowest
priority).

Year Select a year. You can use Any year as a valid entry.
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Property Description

Month Select a month for the exception event or Odd month, Even month,
Any month.

Day of month Select a value for the day of the month. You can use Any Day, Last
day, Odd days or Even days as valid entries.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

7. Click OK.

17.6 Adding a Calculated Exception Event
You create a calculated exception to schedule a recurring event that takes precedence
over a scheduled weekly event.

To add a calculated exception event

1. In WorkStation, in the System Tree pane, select the schedule you want to add the
calculated exception event to.

2. Click the Basic tab.

3. On the Basic toolbar, click the New schedule event button .

4. In the Schedule Event Properties dialog box, under Event type, click Exception.

5. Under Exception type, click Calculated.

6. Select All Day to have the event last all day.

7. In the Name box, type a name for the exception.

8. In the Priority box, enter a priority.

9. In the Month box, select a month.

10. In the Week of month box, select a week of the month.

11. In the Day of week box, select a day of the week.

12. Click OK.

17.7 Editing a Calculated Exception Event
You edit a calculated exception event to change the information about an exception
event.

To edit a calculated exception event

1. In WorkStation, in the System Tree pane, select the schedule you want to edit.

2. In the Work area, click the Basic view.
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3. In the Event grid, select the calculated exception event you want to edit.

4. On the Basic toolbar, click the Edit schedule event button .

5. In the Schedule Event Properties dialog box, edit the properties.

Property Description

Event type Click Exception to display the exception types.

Exception type Select Calculated for an exception type to apply the schedule.

Click to add a line to the Times and values box.

Click to delete an entry from the Times and values box.

All Day Select to create an all day event.

Name Type a name for the event.

Priority Select a priority number between 1 (highest priority) and 16 (lowest
priority).

Year Select a year. You can use Any year as a valid entry.

Month Select a month for the exception event or Odd month, Even
month, Any month.

Week of month Select a week of the month for the exception event or First week,
Second week, Third week, Fourth week, Last week, Any week.

• First week – the first through the seventh day of the month.
The second week is then considered day of month eight
through fourteen and so on. Since the dates do not necessarily
correspond to the first row of the calendar, they may include
dates from both the first and second row of the calendar.

• Fifth week – days 29 through 31 if they exist. It is always less
than seven days and is non-existent in February except in a
leap year.

• Last week – the last seven days of the month. It differs from
the Fifth week.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

6. Click OK.

17.8 Adding a Calendar Exception Event
You add a calendar to the schedule to make an exception event for all dates specified in
the calendar.

For more information, see section 18.1 “Calendars in WorkStation” on page 177.

To add a calendar exception event

1. In WorkStation, in the System Tree pane, select the schedule you want to add the
calendar to.
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2. Click the Basic tab.

3. On the Basic Schedule Editor toolbar, click the New schedule event button

.

4. In the Schedule Event Properties dialog box, click Exception.

5. Click Calendar.

6. Select All Day if the exception event is to be on or off all day.
7. In the Start Time column, type a start time for the exception event.
8. In the End Time column, type an end time for the exception event.

9. In the Value column, select a value for the exception event.

10. In the Name box, type a name for the exception event.

11. In the Priority box, select a priority for the exception event to make it override
conflicting events with lower priorities.

12. In the Calendar box, enter the calendar that you want to add.

13. Click OK.

14. On the File menu, click Save.

NOTE:
• You cannot specify different times and values for each of the different dates. All

dates specified in the calendar must have the same times and values assigned
to them.

17.9 Editing a Calendar Exception Event
You edit a calendar exception event to change the information about an exception
event.

To edit a calendar exception event

1. In WorkStation, in the System Tree pane, select the schedule containing the
calendar exception event you want to edit.

2. Click the Basic tab.
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3. In the calendar view, select the date when the calendar exception event you want
to edit is valid.

4. In the event grid, select the calendar exception event you want to edit. To edit the
dates for the calendar exception, you need to separately open the calendar object
itself. For more information, see section 18.5 “Editing a Date Calendar Event” on
page 180.

5. Click the Edit schedule event button .

6. In the Schedule Event Properties dialog box, edit the properties:

Property Description

Event type Click Exception to display the exception types.

Exception type Select Calendar to initiate a calendar reference.

All Day Select to create an all day event.

Click to add a line to the Times and values box.

Click to delete an entry from the Times and values box.

Name Type a name for the event.

Priority Select a priority number between 1 (highest priority) and 16 (lowest
priority).

Calendar Select a calendar to reference.

7. Click OK.

8. On the File menu, click Save.
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18.1 Calendars in WorkStation
A calendar is a list of dates. The calendar provides the schedule with the dates when
the exception events shall occur. To save time, you can reference a single calendar
rather than entering several exception events in a schedule.

Figure – Exception events in a calendar

Many schedules can make a reference to the calendar. You can define the group of
dates once rather than over and over again in multiple schedules, a potentially tedious
task if your building control system contains many schedules.
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18.1.1 Calendar Editor Overview

You use the Calendar Editor to create a calendar that contains a date list of exception
events. The exception events can be a single date, a date range, or a recurring date. By
using a calendar, you specify all the exception events only one time, rather than in each
schedule. The calendar is then referenced to each of the schedules and all exception
dates are automatically designated in the schedules.

For more information, see section 18.2 “Calendar Editor Overview” on page 178.

18.1.2 Calendar Events

The dates specified in a calendar are shown in the date list. You can specify dates in a
calendar by three different methods:

• Date: a specific date

• Date range: a fixed period with a set start and stop date

• Calculated date: a fixed period that repeats

For more information, see section 18.3 “Calendar Events” on page 179.

18.2 Calendar Editor Overview
The Calendar Editor is the editor you use to create a date list of exception events. The
date list can include a single date, a date range, or a recurring date. You use the
calendar when creating a schedule that uses a Calendar Reference Exception. You can
apply one calendar to many schedules.

The following figure displays the calendar with all of the exception events in blue. The
exception events are also in a list view.

Figure – Calendar Editor Overview
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18.3 Calendar Events
The dates specified in a calendar are shown in the date list. You can specify dates in a
calendar by three different methods:

• Date: a specific date

• Date range: a fixed period with a set start and stop date

• Calculated date: a fixed period that repeats

18.3.1 Date Calendar Events

A single date within a calendar is an entry that occurs once or every year on the same
date.

The following single date entry choices schedule an event on a single date, January 1,
2009:

• Year - 2009

• Month - January

• Day of month - 1

• Day of week - Any day

The following single date entry choices schedule an event on a single date every year,
January 1:

• Year - Any Year

• Month - January

• Day of month - 1

• Day of week - Any day

The following choices produce an error message:

• A day, month, and year combination that does not coincide
An example is Friday, March 5, 2009. This date actually falls on a Thursday.

• Any years past 2105

• An explicit day that is out of range
An example is September 31 or February 29 in a non-leap year.

18.3.2 Date Range Calendar Events

You can include a date range in the date list. A date range is a series of days to include
in a calendar. An example of a date range is January 1, 2009 to January 31, 2009,
which adds the entire month of January to the calendar as an event. You can use this
date range for a device, such as a thermostat, to behave differently for the whole month
of January.
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18.3.3 Calculated Calendar Events

You can include a calculated date on a date list. A calculated date has no set start and
stop date. For example, you use a calculated date to schedule the first week of the even
months on a Friday.

18.4 Adding a Date Calendar Event
You add a date to a calendar to specify an exception date for a specific day, such as 7
May, 2013.

For more information, see section 18.3 “Calendar Events” on page 179.

To add a date calendar event

1. In WorkStation, in the System Tree pane, select the calendar you want to add the
exception to.

2. Click the Calendar Editor tab.

3. On the Calendar Editor toolbar, click the Add Date button .

4. In the Edit Calendar Entry dialog box, in the Entry name box, type the name that
you want to display on the date list.

5. In the Year box, select the year for the date.

6. In the Month box, select the month for the date.

7. In the Day of month box, select the day for the date.

8. In the Day of week box, select the weekday for the date.

9. Click OK.

10. On the File menu, click Save.

18.5 Editing a Date Calendar Event
You edit a date calendar to change the information about a calendar event.

To edit a date calendar event

1. In WorkStation, in the System Tree pane, select the calendar you want to edit.

2. Click the Calendar Editor tab.

3. In the date list, right-click the date calendar event you want to edit and click
Properties.
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4. In the Edit Calendar Entry dialog box, edit the properties.

Component Description

Entry name Type an entry name for the calendar entry.

Year Select a year. You can use Any year as a valid entry.

Month Select a month for the exception event or Odd month, Even
month, Any month.

Day of month Select a value for the day of the month. You can use Any Day,
Last day, Odd days or Even days as valid entries.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

5. Click OK.

18.6 Adding a Date Range Calendar Event
You add a date range to a calendar to specify two or more consecutive days with a
specific start and end date, such as 19 March to 23 March, 2013.

For more information, see section 18.3 “Calendar Events” on page 179.

To add a date range calendar event

1. In WorkStation, in the System Tree pane, select the calendar you want to add the
exception to.

2. Click the Calendar Editor tab.

3. On the Calendar Editor toolbar, click the Add Date Range button .

4. In the Edit Calendar Entry dialog box, in the Entry name box, type the name that
you want to display on the date list.

5. In the Start year box, select the year for the start date.

6. In the Start month box, select the month for the start date.

7. In the Day of month box, select the day for the start date.

8. In the Day of week box, select the weekday for the start date.

9. In the Year box, select the year for the end date.

10. In the Month box, select the month for the end date.

11. In the Day of month box, select the day for the end date.

12. In the Day of week box, select the weekday for the end date.

13. Click OK.

14. On the File menu, click Save.
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18.7 Editing a Date Range Calendar Event
You edit a date range calendar to change the information about a calendar event.

To edit a date range calendar event

1. In WorkStation, in the System Tree pane, select the calendar you want to edit.

2. In Calendar Editor, select the date range calendar.

3. Right-click the date range calendar.

4. In the Edit Calendar Entry dialog box, edit the properties.

Component Description

Entry name Type an entry name for the calendar entry.

Start year Select a year. You can use Any year as a valid entry.

Start month Select a month for the exception event or Odd month, Even
month, Any month.

Day of month Select a value for the day of the month. You can use Any Day,
Last day, Odd days or Even days as valid entries.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

Year Select a year. You can use Any year as a valid entry.

Month Select a month for the exception event or Odd month, Even
month, Any month.

5. Click OK.

18.8 Adding a Calculated Date Calendar Event
You add a calculated date to specify a recurring event, such as Friday of the first week
of even months. Calculated dates are also used for events or holidays that do not
always fall on the same date each year.

For more information, see section 18.3 “Calendar Events” on page 179.

To add a calculated date calendar event

1. In WorkStation, in the System Tree pane, select the calendar that you want to add
the exception dates to.

2. Click the Calendar Editor tab.

3. On the Calendar Editor toolbar, click the Add Calculated button .

4. In the Edit Calendar Entry dialog box, in the Entry name box, type the name that
you want to display on the date list.
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5. In the Month box, select a month for the calculated date.

6. In the Week of month box, select the week of month for the calculated date.

7. In the Day of week box, select a weekday for the calculated date.

8. Click OK.

9. On the File menu, click Save.

18.9 Editing a Calculated Date Calendar Event
You edit a calculated date calendar to change the information about a calendar event.

To edit a calculated date calendar event

1. In WorkStation, in the System Tree pane, select the calendar you want to edit.

2. In Calendar Editor, select the calculated date calendar.

3. Right-click the calculated date calendar.

4. In the Edit Calendar Entry dialog box, edit the properties.

Component Description

Entry name Type an entry name for the calendar entry.

Month Select a month for the exception event or Odd month, Even
month, Any month.

Week of month Select a week of the month for the exception event or First
week, Second week, Third week, Fourth week, Last week,
Any week.

• First week – the first through the seventh day of the month.
Be aware that it does not necessarily correspond to the first
row of the calendar since it may include dates from both the
first and second row of the calendar.

• Fifth week – days 29 through 31 if they exist. It is always
less than seven days and is non-existent in February
except in a leap year.

• Last week – the last seven days of the month. It differs
from the Fifth week.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

5. Click OK.

18.10 Deleting a Date List Entry from a Calendar
You delete a date list entry from a calendar to remove the entry from a schedule.

To delete a date list entry from a calendar

1. In WorkStation, in the System Tree pane, select the calendar.
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2. In the work area, click the Calendar Editor view.

3. In the Date List, select an entry.

4. On the Calendar Editor toolbar, click the Delete button .

Repeat the procedure to delete additional date list entries.
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19.1 How Graphics Work
You use graphics to display building overviews, display values from sensors, or change
setpoints. A graphic can also contain links to trend charts, trend log lists, Internet sites,
or views in WorkStation and WebStation.

A graphic that contain links to documents, such as Microsoft Word or Adobe PDF, can
be opened in WorkStation and WebStation. The associated programs, in this case
Microsoft Word or Adobe Reader, has to be installed on the computer running
WorkStation or WebStation.

Figure – A Graphic with links and interactive components like gauges in WorkStation

19.2 Changing a Value in a Graphic
You change a value in a graphic when you want a different value.

For more information, see section 19.1 “How Graphics Work” on page 185.
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To change a value in a graphic

1. In WorkStation or WebStation, click the graphic with the value you want to change.

2. Click the value you want to change.

3. In the Edit properties dialog box, enter the new value.

4. Click OK.

19.3 Scrolling in a Graphic
You scroll to move the graphic vertically or horizontally to see more of the graphic.

For more information, see section 19.1 “How Graphics Work” on page 185.

To scroll in a graphic

1. Click the Scroll button .

2. Use the hand to move around in the graphic.

19.4 Resetting Zoom in a Graphic
You restore the graphic to its original size using Reset Zoom after you increased or
decreased the size of the graphic.

For more information, see section 19.1 “How Graphics Work” on page 185.

To reset zoom in a graphic

1. Click the Reset Zoom button .

19.5 Zooming In an Area of a Graphic
You zoom in a graphic to view a part of the graphic in more detail.

For more information, see section 19.1 “How Graphics Work” on page 185.

To zoom in an area of a graphic

1. Click the Zoom In button .

2. Drag the magnifier over the area in the graphic you want to increase in size.

19.6 Zooming Out from a Graphic
You zoom out from a graphic to get a better overview of the graphic.

For more information, see section 19.1 “How Graphics Work” on page 185.

To zoom out from a graphic

1. Click the Zoom Out button .
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2. Click in the graphic until the graphic is the size you want.
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20 Documents
What's in This Chapter?
20.1 How Documents Work ..................................................................................... 188
20.2 Opening a Document ....................................................................................... 188

20.1 How Documents Work
You can open documents stored on an EcoStruxure BMS server using the default
program associated with the file type. For example, a txt-file opens Notepad and a ppt-
file opens PowerPoint.

You can edit the documents and then save them again using WorkStation. You cannot
edit and save documents using WebStation.

IMPORTANT: When you log off or are automatically logged off, any unsaved
changes in the document are not saved in the database. Make sure that you save
changes in open documents frequently.

20.2 Opening a Document
You open, edit, and save documents stored on an EcoStruxure BMS server using the
default editor associated with the file type. For example, the Notepad editor opens a text
file.

For more information, see section 20.1 “How Documents Work ” on page 188.

To open a document

1. In WorkStation, in the System Tree pane, click the document.

2. When the editor opens the document, you can view or modify the file.

3. When finished, save and close the document.
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21.81 Building Operation WorkStation Error ............................................................ 304

21.1 WorkStation Workspace
Use the Workspace in WorkStation to edit and display information on an EcoStruxure
BMS server.

IMPORTANT:
• WorkStation can be displayed in a number of ways. Not all components in this

document are visible in your WorkStation.

Figure – WorkStation Workspace
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Continued

Number Description

History bar
Use the History bar to go back and forward.
For more information, see section 21.7
“History Bar” on page 202.

Menu bar
Use the Menu bar to access the main menus
in WorkStation.
For more information, see section 21.5 “Menu
Bar” on page 200.

Toolbar
Use the buttons in Toolbar for easy access to
commands you use frequently.
For more information, see section 21.4
“WorkStation Toolbar” on page 198.

Address bar
Use the Address bar to browse the system.
For more information, see section 21.6
“Address Bar” on page 201.

Status bar
Use the Status bar to view the connectivity
status, logon information, and localization
information for the system. For more
information, see section 21.8 “Status Bar” on
page 203.

Search View
Use Search in WorkStation to find and view
objects in the database.
For more information, see the Search View
topic on WebHelp.

Work area
Use the Work area to display and work with
graphics, trend charts, trend log lists, reports
and schedules.
For more information, see section 19.1 “How
Graphics Work” on page 185.
For more information, see section 13.1 “How
Trend Charts Work” on page 87.
For more information, see section 14.1 “Trend
Log Lists in WorkStation” on page 114.
For more information, see the How Reports
Work topic on WebHelp.
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Number Description

Views and panes
Use views and panes to handle alarms and
events and to watch variables.
For more information, see section 21.39
“Alarms Pane and Alarm View ” on page 248.
For more information, see section 21.57
“Events Pane and Event View” on page 271.
For more information, see section 21.11
“Watch Pane and Watch View” on page 206.

System Tree pane
Use the System Tree pane to view, create,
delete, copy, rename and move objects.
For more information, see section 21.9
“System Tree Pane” on page 204.
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21.2 Building Operation WorkStation Window
Use the Building Operation WorkStation window to log on to WorkStation.

Figure – Building Operation WorkStation

Table – Building Operation WorkStation

Component Description

User name Type the user name of your EcoStruxure
Building Operation user account. For more
information, see the User Accounts and User
Account Groups topic on WebHelp.

Password Type the password of your EcoStruxure
Building Operation user account or of your
Windows user account.
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Component Description

Domain Type the name of the EcoStruxure Building
Operation domain that you want to log on to. If
you do not enter a domain, you are logged on
to the local domain. For more information, see
the Domains topic on WebHelp.

Server Select the Server hypertext transfer protocol
option for communication with the
EcoStruxure BMS server.
Enter an EcoStruxure BMS server name or an
IP address for the EcoStruxure BMS server
you want to log on to.

Log on as Click to log on to WorkStation with your
Windows user account. For more information,
see the User Accounts and User Account
Groups topic on WebHelp.

Remember me on this computer Select to save the entered information. The
information is automatically filled in the next
time you log on.

Log on Click to log on to WorkStation.

Click here to learn more about Building
Operation

Click to open the WebHelp home page. For
more information, see the WebHelp Overview
topic on WebHelp.
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21.3 Display Names and IP Addresses of Servers Drop-Down
List Box

You use the Display Names and IP Addresses of Servers drop-down list box to add,
edit and delete the display names of the server addresses. You also use it to export,
import and delete lists of the display names and IP addresses of servers.

Figure – Display Names and IP Addresses of Servers drop-down list box

Table – Display Names and IP Addresses of Servers Drop-Down List Box

Command Description

Edit
Click to edit the display name of the server
address. For more information, see section
1.9 “Editing the Display Name of the Server
Address” on page 22.

Delete
Click to delete display name and the IP
address of the server. For more information,
see section 1.10 “Deleting the Display Name
and the IP Address of a Server” on page 22.

Export
Click to export the list of the display names
and IP addresses of servers. For more
information, see section 1.11 “Exporting the
List of the Display Names and IP Addresses
of Servers” on page 22.

Import
Click to import a list of the display names and
IP addresses of servers. For more
information, see section 1.12 “Importing a List
of the Display Names and IP Addresses of
Servers” on page 23.

Remove all
Click to the display names and IP addresses
of servers. For more information, see section
1.13 “Clearing the List of the Display Names
and IP Addresses of Servers” on page 23.
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Command Description

Discover
Click to display servers from your network.
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21.4 WorkStation Toolbar
Use the buttons on the WorkStationtoolbar for easy access to commands you use
frequently.

Table – WorkStation Toolbar

Button Description

Workspace
Click to open the Workspace menu where you
can select a workspace. For more information,
see the List View topic on WebHelp.

Control Panel
Click to open the Control Panel where you get
access to some of the most used
administration functions, such as alarms,
domains, user accounts, backup and
archiving, and engineering. For more
information, see the Control Panel View topic
on WebHelp.

New
Click to open the New submenu where you
create new objects. For more information, see
section 21.17 “File Menu – New Submenu” on
page 214.

Open in New
Click to open the selected object in a new tab
in the work area.

Save
Click to save changes.

Cut
Click to cut the selected objects. The objects
are placed on the clipboard.

Copy
Click to copy the selected objects. The objects
are placed on the clipboard.

Paste
Click to paste a copied or cut object.

Delete
Click to open the Confirm delete dialog box
where you delete the selected object. For
more information, see the Confirm Delete
Dialog topic on WebHelp.

Cancel
Click to cancel the latest command.

Refresh
Click to refresh the selected object or
workspace.

Print
Click to print the selected object.
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Button Description

Help
Click to open the EcoStruxure BMS help.
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21.5 Menu Bar
Use the Menu bar to access the different file menus in WorkStation.

Figure – Menu bar

Table – Menu Bar

Component Decription

File Click to open the File menu, where you log off
from the system, import and export
information, print, and create new objects. For
more information, see section 21.16 “File
Menu ” on page 212.

Edit Click to open the Edit menu, where you edit
objects in the system. For more information,
see the Edit Menu topic on WebHelp.

View Click to open the View menu, where you
display or hide Workspace components. For
more information, see section 21.18 “View
Menu” on page 224.

Actions Click to open the Actions menu, where you
carry out commands for objects selected in
the System Tree pane or List View. For more
information, see the Actions Menu topic on
WebHelp.

Window Click to open the Window menu, where you
close or navigate between open windows. For
more information, see section 21.21 “Window
Menu” on page 228.

Tools Click to open the Tools menu, where you
open the Control Panel and the Options dialog
box. For more information, see the Tools
Menu topic on WebHelp.

Help Click to open the Help menu, where you
access the help and view information about
the WorkStation version number. For more
information, see section 21.22 “Help Menu” on
page 229.
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21.6 Address Bar
Use the Address bar to browse the system. The Address bar is located at the top of the
Workspace.

Figure – The Address bar

The Address bar is the equivalent of the Address bar in Windows and can be used for
browsing the system and for copying addresses that you want to paste in other areas of
the system, for example, in the Bindings View.

Figure – The Address bar

Table – The Adress bar filter

Button Description

Show/Hide non-presentation objects
Click to show non-presentation objects.
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21.7 History Bar
Use the History bar to go back and forward to views you have visited before.

Figure – The History bar

Table – The History bar

Button Description

Back
Click to go back to a view you have visited
before in the selected window.

Forward
Click to go forward to a view you have visited
before in the selected window.
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21.8 Status Bar
Use the Status bar to view information on the following items:

• connectivity status

• security certificates

• which EcoStruxure BMS server the user is logged on to

• the name of the logged on user account

• which domain the user is logged on to

• whether or not database mode is active

• the current language

• the measurement system

Figure – Status bar

Component Description

Indicates that the security certificate is valid.

Indicates that the security certificate cannot
be validated.

Connected to
Indicates that WorkStation is connected to the
EcoStruxure BMS server.

Trying to connect to
Indicates that WorkStation is disconnected
from the EcoStruxure BMS server and trying
to connect.

User account Displays the account you are currently using.

Domain Displays the domain you are logged on to.

Database mode
Indicates that database mode is active. For
more information, see the Database Mode
topic on WebHelp.

Current language Displays the current display language of the
system in the drop-down menu beside the
user account.

Measurement system Displays the selected measurement system
for the system in the drop-down beside the
user account.
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21.9 System Tree Pane
Use the System Tree Pane to view and manage the structure of the EcoStruxure
Building Operation database. In the System Tree pane you can view, create, delete,
copy, rename, and move objects.

Figure – System Tree pane

Table – System Tree Pane

Number Description

Show/Hide non-presentation objects
Toggle between showing and hiding non-
presentation objects, that is, objects required
when engineering the EcoStruxure BMS.

Collapse all
Click to collapse the System Tree so that only
the EcoStruxure BMS server of the
EcoStruxure BMS is visible.

Click to customize how the System Tree pane
is displayed. For more information, see
section 4.1 “Customization” on page 37.

Click to unpin the System Tree pane and
collapse it to the side.
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21.10 List View
Use the List View to view, manage, and mass edit objects in the EcoStruxure Building
Operation database.

Figure – List View

Table – List View

Number Description

Parent folder
Use Parent folder to move up in the hierarchy
to the folder containing the folder or object
currently displayed in the List View. For more
information, see the List View Toolbar topic on
WebHelp.

Create folder
Use Create folder to create a new folder. For
more information, see the Object Names topic
on WebHelp.

Quick filter
Enter a word to filter on. For more information,
see section 5.11 “Quick Filter ” on page 49..

Column row
Use the column row to view the contents of
the List View and to open the column heading
menu. For more information, see section
21.32 “Column Row Context Menu” on page
241.
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Number Description

Use the list to view the contents of the
selected folder or object in the List View.

Properties
Use Properties to view the properties of the
object you have selected in the List View. For
more information, see the Object Properties
topic on WebHelp.

Use the list information to view the total
number of objects iand the selected number
of objects in the List View.

21.11 Watch Pane and Watch View
You can drag objects to the Watch pane or a Watch View to monitor their live values
and other properties, for example, to monitor the impact of a change you are about to
make in your system. Property changes are immediately displayed in the Watch pane or
Watch View. You can add and remove property columns in the Watch pane or Watch
View.

Dragging an object to the Watch pane or Watch View, you get different results
depending on whether you right-click and drag or left-click and drag:

• Right-click and drag the object to the Watch pane or Watch View. When you
choose this method, you can select the properties you want to monitor.

• Left-click and drag an object to the Watch pane or Watch View. When you choose
this method, the default property of the object is displayed.

The list of objects in the Watch pane is not saved when you log out of WorkStation but
you can save the lists of objects to the system and reopen it from the System Tree. You
can save the list of objects on the Watch View toolbar. The saved Watch view is opened
in the List View. You can right-click any object in the Watch pane or a Watch View to
view and edit the properties of that object. The Properties dialog box displays the
properties you have chosen to monitor in the Watch pane or Watch View and also
contains a link to the full properties of the object.

You can right-click an object in the Watch pane or Watch View and view the trends
related to the object.

Figure – Watch Pane
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21.12 Watch Pane and Watch View Toolbar
Use the Watch pane and Watch View toolbar to manage the objects in the list.

Figure – Watch pane and Watch View toolbar

Table – Watch Pane Toolbar

Component Description

Remove from Watch Window
Click to remove a selected object from the
Watch pane.

Save current settings
Click to save the current list of objects.

Quick filter Enter a word or a character to filter on. For
more information, see section 5.11 “Quick
Filter ” on page 49.
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21.13 Add/Remove Columns Dialog Box (Watch)
Use the Add/Remove Columns dialog box to add or remove columns from the Watch
pane or a Watch View.

Figure – Add/Remove Columns dialog box
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21.14 Pane Menu
Use the Pane menu to dock, float, or hide a pane. You find the Pane menu in the upper
right corner of the pane.

Figure – The Pane menu

Button Description

Down arrow
Click to float, dock, hide or autohide the pane.

Pin
Click to autohide the pane.

Close
Click to close the pane.
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21.15 Add/Remove Columns Dialog Box (Search)
Use the Add/Remove Columns dialog box to add or remove columns to the Search
View.

NOTE: The columns that are displayed in the list are the columns that are relevant
for the specific search result.

Figure – Add/Remove Columns dialog box default columns

Table – Add/Remove Columns Dialog Box Default Columns

Component Description

Description Select to display what the object or property is
used for.

Foreign address Select to display the address to a non-
EcoStruxure Building Management product,
for example a BACnet device.

Modified Select to display the date and time when the
object was last modified.

Name Select to display the name of the object or
property.

Note 1 Select to display a text that appears in a
graphic or search result.

Note 2 Select to display a text that appears in a
graphic or search result.

Path Select to display the path of the object.

Property binding Select to display the in-bound binding of the
object property.
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Component Description

Property retain level Select to display the retain level of the object
property.

Type Select to display the object type that defines
the properties of the object

Validation Select to display the value of the validation
property of the object.

Value transfer delta Select to display the transfer rate based on a
delta value.

Value transfer interval Select to display the configured transfer
interval for the value.

Value transfer rate Select to display how often a value transfer
takes place.
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21.16 File Menu
Use the File menu to log off from the system, import and export information, print, and
create new objects.

Figure – File menu

Table – File Menu

Command Description

New Click to open the New submenu where you
create new objects. For more information, see
section 21.17 “File Menu – New Submenu” on
page 214.

Open Click to open an object.

Open in new tab Click to open the selected object in a new tab
in the work area.

Show in folder Click to display the object in its location in the
System Tree folder structure.

Save Click to save changes.

Log Off Click to log off WorkStation. Your session
ends and you are sent to the Welcome
Window where you can log in again with the
same or another user account. For more
information, see section 21.2 “Building
Operation WorkStation Window” on page 194.

Change Password Click to open the Change Password dialog
box where you change your password. For
more information, see the Change Password
Dialog Box topic on WebHelp.
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Command Description

Import Click to open the Open dialog box where you
select a previously exported solution that you
want to import. After you select a file, the
Import dialog box displays.
The Import dialog box provides a summary of
information about the imported file and a
preview of the names and file structure of the
objects to be imported. For more information,
see the Import Dialog Box topic on WebHelp.

Export Click to open the Save As dialog box where
you export a solution to a file location on the
WorkStation file system.
The Export preview dialog box displays when
there are objects in the solution that the
EcoStruxure Building Operation software
cannot export from the EcoStruxure BMS
server. Use this dialog box to view multiple
objects that the system can and cannot export
from the EcoStruxure BMS server. For more
information, see the Export Preview Dialog
Box topic on WebHelp.

Print Preview Click to preview a printout before printing.

Print Click to print the selected object.

Print Setup Click to adjust the print settings.

Properties Click to open the Properties dialog box where
you inspect or change properties for the
selected object. For more information, see the
General Information Properties – Basic Tab
topic on WebHelp.

Shortcut Properties Displays the Properties dialog box for the
currently selected shortcut.

Exit Click to quit WorkStation.
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21.17 File Menu – New Submenu
Use the New submenu to create new objects.

Figure – File menu - New submenu

Command Description

Alarm Click to open the Create Object wizard
where you create an alarm. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
An alarm monitors a variable and alerts you if
the monitored variable matches the
configured alarm conditions. For more
information, see the Alarms Overview topic on
WebHelp.

Assignment Click to open the Create Object wizard
where you create an assignment. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A triggered alarm can be automatically
assigned to a specific user or user group that
seems to be most suited to correct the
problem. For more information, see the
Automatic Assignments topic on WebHelp.

Application Click to open the Create Object wizard
where you create an application folder for a
hosted BACnet device. For more information,
see the Create Object Dialog – Naming the
Object Page topic on WebHelp.
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Command Description

b3 device Click to open the Create Object wizard
where you create a b3 device on the MSTP
network. For more information, see the Create
Object Dialog – Naming the Object Page topic
on WebHelp.
b3 BACnet devices are a family of intelligent,
programmable, stand-alone devices that
provide Direct Digital Control of air handlers
and systems as well as individual terminal
units. For more information, see the b3
BACnet Device Controllers topic on WebHelp.

BACnet device Click to open the Create Object wizard
where you create a BACnet device that is
hosted by the local EcoStruxure BMS server.
For more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.

BACnet loop Click to open the Create Object wizard
where you create a BACnet loop that
represents a feedback control loop. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
You use a BACnet loop to create a feedback
system without manually creating or editing
Script code. For more information, see the
BACnet Objects and Properties topic on
WebHelp.

BACnet network Click to open the Create Object wizard
where you create a BACnet network that is
not directly connected to the EcoStruxure
BMS server. For more information, see the
Create Object Dialog – Naming the Object
Page topic on WebHelp.
You use a BACnet network when you want to
host a device that is on a network that is not
directly connected to the EcoStruxure BMS
server. For more information, see the BACnet
Networks topic on WebHelp.

BACnet notification Click to open the Create Object wizard
where you create a BACnet notification that
can be referenced by BACnet alarms and
objects configured for intrinsic alarming. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
For more information, see the BACnet Alarms
topic on WebHelp.

BACnet program Click to open the Create Object wizard
where you create a BACnet program and
upload the properties of a BACnet program
from a BACnet device into the EcoStruxure
Building Operation database. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
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Command Description

BACnet trend log Click to open the Create Object wizard
where you create a BACnet trend log that
monitors and records the trends of a
monitored property. For more information, see
the Create Object Dialog – Naming the Object
Page topic on WebHelp.
A BACnet trend log is a property monitor for a
specific object. When certain conditions are
reached, a log is produced with the property
value and a date/time stamp. For more
information, see the BACnet Objects and
Properties topic on WebHelp.

BBMD Click to open the Create Object wizard
where you create a BBMD when you want
BACnet broadcast messages to be
communicated throughout an IP network. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
You create BBMDs on Ethernet-based
devices when you want BACnet broadcast
messages to be communicated throughout an
IP network.

BBMD BDT entry Click to open the Create Object wizard
where you create a BDT Entry for a BBMD.
For more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
You create a BDT entry for to configure a
master table for a BBMD.

Change of Value Log Set Click to create a Change of Value Log Set
subfolder. For more information, see the Log
Sets topic on WebHelp.

Device Click to open the Create Object wizard
where you create a device. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.

Document Click to open the Create Object wizard
where you create a document. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A document is a container in which you can
upload a file for use by the EcoStruxure
Building Operation software. You can upload
all types of files including reports, forms,
images, and video clips. For more information,
see the Documents Overview topic on
WebHelp.
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Extended trend log Click to open the Create Object wizard
where you create an extended trend log. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
An extended trend log is used to upload and
store log records from a trend log in a device
where space is limited. For more information,
see section 15.10 “Extended Trend Logs” on
page 140.

Folder Click to open the Create Object wizard
where you create a folder. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.

Function Block Click to open the Create Object wizard
where you create a Function Block program.
For more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
For more information, see the Function Block
Editor Overview topic on WebHelp.

Global Values Click to create a new Sigma global values
device. For more information, see the Global
Values topic on WebHelp.

Graphic Click to open the Create Object wizard
where you create a graphic. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
The created graphic is empty and has to be
edited. For more information, see the
Graphics Editor topic on WebHelp.

Graphics folder Click to create a Sigma graphics subfolder.

Hyperlink Click to open the Create Object wizard
where you create a hyperlink. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
Hyperlinks are used to acces web pages on
the Internet. For more information, see the
Hyperlinks topic on WebHelp.
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Command Description

Interface Click to open the Create Object wizard
where you create an interface. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
The created interface can be a BACnet
interface, LonWorks interface, MicroNet
network, or Modbus interface/network.
For more information, see the BACnet
Interface topic on WebHelp.
For more information, see the LonWorks
Overview topic on WebHelp.
For more information, see the MicroNet
Network Protocols topic on WebHelp.
For more information, see the Modbus
Overview topic on WebHelp.
For more information, see the Web Services
Overview topic on WebHelp.

Interval Log Set Click to create an Interval Log Set subfolder.
For more information, see the Log Sets topic
on WebHelp.

IP network Click to open the Create Object wizard
where you create an IP network. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.

LonWorks Network Opens the Create Object wizard, where you
create a LonWorks network. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.

MicroNet Click to open the Create Object wizard, where
you create any one of three MicroNet network
types. For more information, see the Create
Object Dialog – Naming the Object Page topic
on WebHelp.
MicroNet is a moderate-to-large scale
Building Management System. For more
information, see the MicroNet Network
Protocols topic on WebHelp.

MicroNet ARCNET Network Click to open the Create Object wizard, where
you create a MicroNet ARCNET network. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
An ARCNET network contains ARCNET
variant MicroNet devices. For more
information, see the ARCNET Networks topic
on WebHelp.
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MicroNet NCP Network Click to open the Create Object wizard, where
you create a MicroNet NCP network. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
An NCP network is the Satchwell Native
Communications Protocol proprietary
network, containing NCP variant MicroNet
devices. For more information, see the NCP
Networks topic on WebHelp.

MicroNet SNP Network Click to open the Create Object wizard, where
you create a MicroNet SNP network. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
An SNP network is the Satchwell SatchNet
Pro proprietary network, containing SNP
variant MicroNet devices. For more
information, see the SNP Networks topic on
WebHelp.

Modbus Device Click to open the Create Object wizard
where you create an external slave device on
a serial Modbus (master) network, or a new
serial device on a Modbus TCP gateway. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
A Modbus device is any device that conforms
to the Modbus standard (for example, a meter
or a programmable logic controller). For more
information, see the Modbus Devices topic on
WebHelp.

Modbus Points Click to open the Create Object wizard
where you create a Modbus point within an
external device. For more information, see the
Create Object Dialog – Naming the Object
Page topic on WebHelp.
A Modbus point is an analog, digital or
multistate input (or output) at a Modbus
device. For more information, see the Point
and Value Types topic on WebHelp.

Modbus TCP Device Click to open the Create Object wizard
where you create a Modbus TCP device. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
A Modbus TCP device is any Modbus device
on a Modbus TCP network. For more
information, see the Modbus Devices topic on
WebHelp.
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Modbus Register Group Click to open the Create Object wizard
where you create a Modbus register group
within a Modbus device. For more information,
see the Create Object Dialog – Naming the
Object Page topic on WebHelp.
A Modbus register group is a container where
Modbus registers can be polled as a group by
a Modbus polling device. For more
information, see the Modbus Register Groups
topic on WebHelp.

Modbus Value Click to open the Create Object wizard
where you create a Modbus value in a
Modbus interface. For more information, see
the Create Object Dialog – Naming the Object
Page topic on WebHelp.
A Modbus value is an analog, digital or
multistate input (or output) at a Modbus
interface. For more information, see the Point
and Value Types topic on WebHelp.

MSTP network Click to open the Create Object wizard
where you create an MS/TP Network for
BACnet devices or b3 devices. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
The EcoStruxure Building Operation software
supports BACnet IP networks and MS/TP
networks. For more information, see the
BACnet Networks topic on WebHelp.

Network Variable Click to open the Create Object wizard
where you create a network variable. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.

Notification Click to open the Create Object wizard
where you create a notification. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
User notifications are used for notifying users
or user groups that a certain alarm event has
occurred in the system. Notifications are
delivered to the users as emails or written to
files outside the EcoStruxure Building
Operation software. For more information, see
the Notifications topic on WebHelp.

Panel Click to open the Create Object wizard
where you create a panel. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A panel can consist of one or several panes
and one work area with viewable objects, for
example graphics, trend charts, reports, or
another panel. For more information, see the
Panel Components topic on WebHelp.
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Point Click to open the Create Object wizard
where you create a BACnet input or output
point. For more information, see the Create
Object Dialog – Naming the Object Page topic
on WebHelp.
You can create BACnet points in an
EcoStruxure BMS server and in a hosted
BACnet device. For more information, see the
BACnet Objects and Properties topic on
WebHelp.

Program Click to open the Create Object wizard
where you create a program. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
For more information, see the Function Block
Editor Overview topic on WebHelp.
For more information, see the Script Editor
Program Creation topic on WebHelp.

Report Click to open the Create Object wizard
where you create a report. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
Click to create a report. For more information,
see the WebReports Overview topic on
WebHelp.

Schedule Click to open the Create Object wizard
where you create a schedule. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
Schedules are used to determine when
essential events occur in a building
automation system. For more information, see
the Schedules Overview topic on WebHelp.

Search Click to open the Create Object wizard
where you create a search. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
Search is used for searching for objects and
properties of objects in the EcoStruxure
Building Operation database. For more
information, see the Search Overview topic on
WebHelp.

Segment Click to open the Create Object wizard
where you create a Sigma segment. For more
information, see the Sigma Representation
topic on WebHelp.

Server Click to open the Create Object wizard
where you create an EcoStruxure BMS
server. For more information, see the Create
Object Dialog – Naming the Object Page topic
on WebHelp.
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Shortcut Click to open the Create Object wizard
where you create a shortcut. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A shortcut is a link to an EcoStruxure BMS
server, folder, or other object and is simply a
pointer to an object which acts as if it is that
object. For more information, see the Shortcut
Creation topic on WebHelp.

User Account Click to open the Create Object wizard
where you create a user account. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A user account uniquely identifies a user to
the system. For more information, see the
User Accounts and User Account Groups
topic on WebHelp.

Domain Click to open the Create Object wizard
where you create a domain. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A domain contains of user accounts, user
account groups, software permissions,
workspaces and one or several EcoStruxure
BMS servers. For more information, see the
Domains topic on WebHelp.

Text report Opens the Create Object wizard, where you
create a text report. For more information, see
the Creating a Text Report topic on WebHelp.

Trend Click to open the Create Object wizard
where you create trend logs, trend log lists, or
trend charts. For more information, see the
Create Object Dialog – Naming the Object
Page topic on WebHelp.
The function of a trend log is to log the
variable that it is connected to and store the
records. For more information, see the Trends
Overview topic on WebHelp.

Trend log Click to open the Create Object wizard
where you create a trend log. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
The function of a trend log is to log the
variable that it is connected to and store the
records. For more information, see the Trends
Overview topic on WebHelp.
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User account group Click to open the Create Object wizard
where you create a user account group. For
more information, see the Create Object
Dialog – Naming the Object Page topic on
WebHelp.
A user account group can contain both user
accounts and other user account groups. For
more information, see the User Accounts and
User Account Groups topic on WebHelp.

Utility Click to open the Create Object wizard
where you create a utility. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
The utilities Signal Gererator, Simple Math
Operator, and Timed Force are used during
system maintenance and testing. For more
information, see the Utilities topic on
WebHelp.

Value Click to open the Create Object wizard
where you create a value. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.

View Click to open the Create Object wizard
where you create an Event View, Alarm View,
or Watch View. For more information, see the
Create Object Dialog – Naming the Object
Page topic on WebHelp.
Views are used to display information in a
easy way. For more information, see the
Alarms Overview topic on WebHelp.

Workspace Click to open the Create Object wizard
where you create a workspace. For more
information, see the Create Object Dialog –
Naming the Object Page topic on WebHelp.
A workspace is a configured layout and
selection of components that display in
WorkStation. For more information, see the
Workspace Components and Customization
topic on WebHelp.
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Use the View menu to display or hide Workspace components.

Figure – The View menu

Command Description

Forward Click to go forward to a view you have visited
before in the selected window.

Back Click to go back to a view you have visited
before in the selected window.

Workspaces Use the Workspaces submenu to switch to
another workspace. For more information, see
section 21.19 “View Menu – Workspaces
Submenu” on page 226.

Save workspace layout Click to save workspace layout changes you
have made to the workspace on the local
computer. For more information, see the
Workspace Components and Customization
topic on WebHelp.

Reset workspace layout Click to reset workspace layout to the default
workspace layout on the local computer. For
more information, see the Workspace
Components and Customization topic on
WebHelp.

Set the current workspace as default Click to set the current workspace layout as
the default workspace on the local computer.
For more information, see the Workspace
Components and Customization topic on
WebHelp.

Toolbars Use the Toolbars submenu to hide or display
the menus in WorkStation. For more
information, see section 21.20 “View Menu –
Toolbars Submenu” on page 227.

Watch Select to display the Watch pane where you
monitor variables. For more information, see
section 21.11 “Watch Pane and Watch View”
on page 206.
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System Tree Select to display the System Tree where you
can see and work with all objects in your
system. For more information, see section
21.9 “System Tree Pane” on page 204.

Events Select to display the Events pane where you
inspect events. For more information, see the
Events Pane and Event View Customization
topic on WebHelp.

Alarms Select to display the Alarms pane where you
handle alarms. For more information, see the
Alarms Pane and Alarm View Customization
topic on WebHelp.

Full screen Select to display the selected window in the
work area in full screen mode. For more
information, see section 4.3 “Using Full
Screen Mode” on page 39.
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21.19 View Menu – Workspaces Submenu
Use the Workspaces submenu to switch to another workspace.

Figure – Workspaces submenu

Table – Workspaces Submenu

Command Description

Administration Click to switch to the default Administration
workspace. For more information, see the
Workspace Components and Customization
topic on WebHelp.

Engineering Click to switch to the default Engineering
workspace. For more information, see the
Workspace Components and Customization
topic on WebHelp.

Engineering with Custom Types Click to switch to the default Engineering with
Custom Types workspace. For more
information, see the Workspace Components
and Customization topic on WebHelp.
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21.20 View Menu – Toolbars Submenu
Use the Toolbars submenu to hide or display the Main menu and the various bars in
the Workspace.

Figure – Toolbars submenu

Command Description

Main menu Select to display the Main menu where you
get access to the File, Edit, View, Actions,
Window, Tools, and Help menus. For more
information, see section 21.5 “Menu Bar” on
page 200.

Basic toolbar Select to display the Basic toolbar where you
access the toolbar buttons. For more
information, see section 21.4 “WorkStation
Toolbar” on page 198.

Search bar Select to display the Search bar to perform a
simple search on objects and properties in the
system. For more information, see the Search
Toolbar topic on WebHelp.

History bar Select to display the History bar to go back
and forward to views you have visited before.
For more information, see section 21.7
“History Bar” on page 202.

Address bar Select to display the Address bar to browse
the system. For more information, see section
21.6 “Address Bar” on page 201.

Status bar Select to display the Status bar to display the
user account, domain, and EcoStruxure BMS
server. For more information, see section 21.8
“Status Bar” on page 203.
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21.21 Window Menu
Use the Window menu to navigate between open windows.

Figure – The Window menu

Command Description

Close window Click to close the selected window.

Close all windows Click to close all window.

Active windows List all active windows.
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21.22 Help Menu
Use the Help menu to access Help, register your system, and to display information
about the WorkStation version number.

Figure – The Help Menu

Command Description

Help Click to open the EcoStruxure BMS help.

Building Operation help (online version) Click to open WebHelp. You must be
connected to Internet to access WebHelp. For
more information, see section 7.1
“WorkStation Help” on page 58.

Building Operation guide (PDF version) Click to access System Reference Guide, a
PDF file that is supplied with WorkStation. For
more information, see section 7.1
“WorkStation Help” on page 58.

Help Settings Click to open the Help Settings submenu. For
more information, see section 21.23 “Help
Menu – Help Settings Submenu” on page
230.

Registration Click to register your system. For more
information, see section 2.1 “System
Registration” on page 25.

About WorkStation Click to display the name and version number
for WorkStation.
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21.23 Help Menu – Help Settings Submenu
Use the Help Settings submenu to select the help you want to use.

Figure – Help Settings submenu

Table – Help Settings Submenu

Command Description

Automatic Click to make WorkStation check if you are
connected to the Internet. If you are
connected, WebHelp opens. If you are not
connected, the System Reference Guide
opens.

Building Operation help Click to always open WebHelp. If you are not
connected to the Internet, you get an error
message.

Building Operation guide Click to always open the System Reference
Guide, regardless of whether you are
connected to the Internet or not.
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21.24 User Menu
Use the User menu to access useful shortcuts from various menus in Workstation.

Figure – User menu

Table – User Menu

Command Description

Save workspace layout Click to save workspace layout changes you
have made to the workspace on the local
computer. For more information, see the
Workspace Components and Customization
topic on WebHelp.

Reset workspace layout Click to reset workspace layout to the default
workspace on the local computer. For more
information, see the Workspace Components
and Customization topic on WebHelp.

Set the current workspace as default Click to set the current workspace layout as
the default workspace on the local computer.
For more information, see the Workspace
Components and Customization topic on
WebHelp.

Show invalid objects Select to view invalid objects. For more
information, see the Invalid Objects Workflow
topic on WebHelp.

Enable session notifications Select to view session notifications.

Only use classic mode for Function Block
Programs

Select to only use classic mode for Function
Block Programs.

Change password Click to open the Change Password dialog
box where you change your password. For
more information, see the Change Password
Dialog Box topic on WebHelp.

Language Click to open the Language submenu where
you select a different WorkStation language.
For more information, see section 21.25 “User
Menu –Language Submenu” on page 233.
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Command Description

Measurement system Click to open the Measurement system
submenu where you select a different local
measurement system. For more information,
see section 21.26 “User Menu –
Measurement System Submenu” on page
234.

Log off Click to log off WorkStation. Your session
ends and you are sent to the Welcome
Window where you can log in again with the
same or another user account. For more
information, see section 21.2 “Building
Operation WorkStation Window” on page 194.
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21.25 User Menu –Language Submenu
Use the Language submenu to select a language for your WorkStation.

Figure – Language submenu

Table – Language Submenu

Command Description

Language list Click a language to change your WorkStation
language. For more information, see the
Language Packages topic on WebHelp.
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21.26 User Menu – Measurement System Submenu
Use the Measurement submenu to choose the measurement system for your
Workstation.

Figure – Measurement system submenu

Table – Measurement System Submenu

Command Description

As in Microsoft Windows Click to change the measurement system of
your Workstation to the measurement system
of the local Microsoft Windows.

As configured in object Click to change the measurement system of
your Workstation to the measurement system
of the local Microsoft Windows.

International System of Units (Metric) Click to change the measurement system of
your Workstation to the international system
of units.

United States Customary Units (US) Click to change the measurement system of
your Workstation to the United States
customary units.
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21.27 Registering Your System Offline Dialog Box
Use the Registering Your System Offline dialog box to register a system that is not
connected to the Internet.

Figure – Registering your system offline dialog box

Table – Registering Your System Offline Dialog Box

Component Description

Print instructions Click to print the instructions for the offline
registration of the EcoStruxure BMS.

Register now Click to complete the offline registration of the
EcoStruxure BMS. For more information, see
section 2.5 “Offline Registration” on page 27.

Register later Click to postpone the offline registration of the
EcoStruxure BMS. For more information, see
section 2.5 “Offline Registration” on page 27.
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21.28 Registration Information Dialog Box for Offline System
Use the Registration Information dialog box to view the system identifier and the
information to view the registration information of the system registered offline. You can
navigate to the Schneider Electric Privacy Policy page and also edit the registration
information.

Figure – Registration Information Dialog Box

Table – Registration Information Dialog Box

Component Description

Privacy Policy Click to navigate to Schneider Electric Privacy
Policy page.

Edit information Click to edit your system's registration
information.

Close Click to close the window.
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21.29 Registration Information Dialog Box for Online System
Use the Registration Information dialog box to view the system identifier. If the
system has been registered online, the dialog box displays the information to whom the
system is registered. If the system is connected to the Internet, you can view the
Schneider Electric Privacy Policy page and also edit the registration information.

Figure – Registration Information Dialog Box

Table – Registration Information Dialog Box

Component Description

System Identifier Displays the System Identifier for further
reference.

Registration data Displays the registration data of the system
registered online.

Privacy Policy Click to display the Schneider Electric Privacy
Policy page.

Edit information Click to edit your system information.

Close Click to close the dialog box.
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21.30 Editing Your System Registration Offline Dialog Box
Use the Editing Your System Registration Offline dialog box to view and print the
instructions for editing registration information of an offline system.

Figure – Editing your system offline window

Table – Editing Your System Offline Window

Component Description

Print instruction Click to print the instructions.
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21.31 Installation and System Information Page
Use the Installation and System Information page to enter the location of your
system and what type of application it is used for.

Figure – Installation and System Information page

Table – Installation and System Information Page

Property Description

Site/building name Type the site/building name.

Site company name Type the company name.

Site/building address Type the site/building address.

Country Select the country for the site/building.

State/province Select the state/province for the site/building.
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Property Description

City Select the city for site/building.

Zip/postal code Type the zip/postal code.

Email address Type your email address.

Confirm email Type the email address again.

Segment/application Select the business segments you belong to.

Submit Click to submit your system registration.

Cancel Click to interrupt the registration process.
Available for offline registrations only.
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21.32 Column Row Context Menu
Use the column row context menu to manage the presentation of information in an
Alarm, Event, or Watch pane or View or in the List View.

Figure – Column row context menu

Table – Column Row Context Menu

Command Description

Add/Remove columns Click to add or remove a column in a pane or
a View. For more information, see the
Add/Remove Columns Dialog Box topic on
WebHelp.

Auto fit to contents Click to see all, or as much as possible, of the
content displayed in each of the columns. For
more information, see section 8.20 “Fitting the
Column Width to the Contents” on page 71.

Group box Click to get a better overview of the objects,
for example, in a folder or a list. For more
information, see section 5.8 “Grouping
Objects” on page 47.



WorkStation User Interface

242 04-50007-01-en, December 2022

WorkStation

21.33 Drag and Drop Context Menu
Use the drag and drop context menu to copy, move, or create shortcuts for objects
selected in the List View or in the System Tree pane, and to mass create objects
selected in the List View.

Figure – Drag and drop context menu

Table – Drag and Drop Context Menu

Command Description

Copy Click to copy the objects selected in the List
View to the selected folder or object in the
System Tree pane.

New Click to open the New submenu where you
create or mass create alarms or trends based
on the selected value objects. For more
information, see section 21.34 “Drag and Drop
Context Menu – New Submenu” on page 243.

Move Click to move the objects selected in the List
View to the selected folder or object in the
System Tree pane.

Create Shortcut Click to create a shortcut for the objects
selected in the List View to the selected folder
or object in the System Tree pane.
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21.34 Drag and Drop Context Menu – New Submenu
Use the New submenu to create new alarms or trends. By default, the alarms or trends
are created in the same folder as the value they are based on.

Figure – New submenu

Table – New Submenu

Command Description

Alarm Select to open the Create Object wizard or the
Mass Create Object wizard where you create
one or several alarms. For more information,
see the Create Object Wizard – Naming the
Object Page topic on WebHelp.. For more
information, see the Mass Create Object
Wizard – Name Page topic on WebHelp.

Trend Select to open the Create Object wizard or the
Mass Create Object wizard where you create
one or several trends. For more information,
see the Create Object Wizard – Naming the
Object Page topic on WebHelp.. For more
information, see the Mass Create Object
Wizard – Name Page topic on WebHelp.
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21.35 Changing Value Dialog Box
Use the Changing Value dialog box to change or force a value using a graphic.

Figure – Changing value dialog box

Table – Changing Value Dialog Box

Component Description

Value Click to change, force or release a value.
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21.36 Object Property Dialog Box
Use the object property dialog box to view or change the properties of a bound object.
The link under each object opens a properties dialog box with a complete set of
properties for that object.

Figure – Object property dialog box

Table – Object Property Dialog Box

Component Description

Link Click to display the complete set of properties
of the bound object.
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21.37 Configure Dialog Box – Operation Tab
Use the Operation tab to select an object, force and release values, and to check the
unforced value.

Figure – The Operation tab displaying both the forced and unforced value

Component Description

Value Enter the path of the object you want to select
or the value that you want to use to override
the value of the property.

Force Click Force to force a value. For more
information, see section 6.7 “Forced Values”
on page 54.

Unforce Click to release the forced value. For more
information, see section 6.7 “Forced Values”
on page 54.
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21.38 Force and Unforce Buttons
Use the Force and Unforce buttons to force and release a value.

Table – Force and Release Buttons

Button Description

Force
Displays a non-forced value. Click to force the
value.

Unforce
Displays a forced value. Click to release the
value.
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21.39 Alarms Pane and Alarm View
Use the Alarms pane and Alarm View to survey and manage alarms.

Figure – Alarms pane

Table – Alarms Pane and Alarm View

Number Description

Use the toolbar to acknowledge, hide, show
and comment alarms. For more information,
see section 21.40 “Alarms Pane and Alarm
View Toolbar” on page 249.

Use the columns to sort, show, and hide
information about the triggered alarms. For
more information, see the Add/Remove
Columns Dialog Box topic on WebHelp.

Use the Detail view to get information about
the selected alarm. For more information, see
section 21.51 “Alarm and Event Detail View ”
on page 265.

Use the list to get information about a
triggered alarm and its current status. For
more information, see the Alarms Pane and
Alarm View Icons topic on WebHelp.
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21.40 Alarms Pane and Alarm View Toolbar
Use the Alarms pane and Alarm View toolbar to manage the alarms.

Table – Alarms Pane and Alarm View Toolbar

Button Description

Acknowledge
Click to acknowledge alarm state or reset
state.
For more information, see section 8.3 “Alarm
Acknowledgements ” on page 63.

Enable alarm
Click to enable the alarm. If the alarm state
changed, for example, from alarm state to
normal state during the time the alarm was
disabled, the alarm is given the new state
once it is enabled.
For more information, see section 10.6
“Disable and Enable Alarms” on page 77.

Disable alarm
Click to disable the alarm. The alarm is
inactivated and cannot be acknowledged or
reset until it is enabled.
For more information, see section 10.6
“Disable and Enable Alarms” on page 77.

Unhide alarm
Click to show the alarm.
For more information, see section 10.2 “Hide
and Show Alarms” on page 76.

Hide alarm
Click to hide the alarm in the Alarms pane or
Alarm View. The alarm is still logged in the
Event log.
For more information, see section 10.2 “Hide
and Show Alarms” on page 76.

Add comment
Click to add a comment to the alarm.
For more information, see section 9.2 “Alarm
Comments” on page 73.

Add cause note
Click to add a cause note to the alarm.
For more information, see section 9.5 “Cause
Notes” on page 73.

Add action note
Click to add an action note to the alarm.
For more information, see section 9.8 “Action
Notes” on page 74.
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Continued

Button Description

Checklist
Click to view the checklist for the alarm.
For more information, see section 9.11
“Checklists” on page 75.

Show disabled alarms
Click to toggle between showing and hiding
disabled alarms.
For more information, see section 10.6
“Disable and Enable Alarms” on page 77.

Show hidden alarms
Click to toggle between hiding alarms and
showing hidden alarms.
For more information, see section 10.2 “Hide
and Show Alarms” on page 76.

Go to alarm object
Click to open the settings of the alarm in the
Work Area.

Edit user filter
Click to select the conditions for the temporary
alarm display in the Alarms pane. When you
close the view, the filter conditions are lost.
For more information, see the Alarm Filters
topic on WebHelp.

Favorites
Click to open the Favorites menu where you
select, add, and manage favorites.
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21.41 Select Conditions Dialog Box
Use the Select Conditions dialog box to sort out the alarms of interest in the Alarms
pane or an Alarm View, or the events in the Events pane or an Event View.

Figure – Select Conditions dialog box

Table – Select Conditions Dialog Box

Component Description

Add condition
Select the alarm filter conditions for the
alarms you want to include.

Remove condition
Remove the alarm filter conditions for the
alarms you want exclude.

Add row
Click to add an additional row with the same
condition.

Remove row
Click to remove a condition row.
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Component Description

Exclude
Click to inverse the condition in the alarm
filter.

Clear all
Click to clear the selected conditions.
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21.42 Add/Remove Conditions Dialog Box
Use the Add/Remove Conditions dialog box to add or remove conditions from the
Alarms pane, Alarm View, Events pane, Event View, Alarm Triggered Notification View,
Assignment View, or Sum Alarm View.

Figure – Add/Remove Conditions dialog box
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21.43 Add Comment Dialog Box
Use the Add comment dialog box to add a comment to an alarm.

Figure – Add comment dialog box
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21.44 Cause Notes Dialog Box
Use the Cause notes dialog box to add a cause note to an alarm.

Figure – Cause notes dialog box
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21.45 Action Notes Dialog Box
Use the Action notes dialog box to add an action note to an alarm.

Figure – Action notes dialog box
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21.46 Checklist Dialog Box
Use the Checklist dialog box to add a checklist to an alarm.

Figure – Checklist dialog box
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21.47 Assign Dialog Box
Use the Assign dialog box to assign an alarm to a user or a user group.

Figure – Select User or Group dialog box

Table – Select User or Group Dialog Box

Component Description

User or group Enter the user or user group you want to
assign the alarm to.

Amount of time until automatically
rejected

Select to automatically reject after a
predefined time.
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21.48 Alarms Pane Context Menu
Use the Alarms pane context menu to manage the alarms in the Alarms pane.

Figure – Alarms pane context menu

Table – Alarms Pane Context Menu

Command Description

Acknowledge Click to acknowledge the alarm state or reset
state.
For more information, see section 8.3 “Alarm
Acknowledgements ” on page 63.

Enable alarm Click to enable the alarm. If the alarm state
changed, for example from alarm state to
normal state during the time the alarm was
disabled, the alarm is given the new state
once it is enabled.
For more information, see section 10.6
“Disable and Enable Alarms” on page 77.

Disable alarm Click to disable the alarm. The alarm is
disabled and cannot be acknowledged or
reset until it is enabled.
For more information, see section 10.6
“Disable and Enable Alarms” on page 77.

Recheck Click to update the current alarm state.
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Command Description

Show alarm Click to show the alarm.
For more information, see section 10.2 “Hide
and Show Alarms” on page 76.

Hide alarm Click to hide the alarm from the Alarms pane.
The alarm is still logged in the event log.
For more information, see section 10.2 “Hide
and Show Alarms” on page 76.

Enable state-change logging Click to start logging an event each time the
alarm is changing its state.
For more information, see section 11.1 “Alarm
State-Change Logging ” on page 80.

Disable state-change logging Click to stop logging an event every time the
alarm is changing its state.
For more information, see section 11.1 “Alarm
State-Change Logging ” on page 80.

Self-assign Click to assign the alarm to yourself.
For more information, see section 8.5 “Alarm
Assignments” on page 63.

Assign Click to assign the alarm to another user.
For more information, see section 8.5 “Alarm
Assignments” on page 63.

Reject Click to reject the alarm.
For more information, see section 8.5 “Alarm
Assignments” on page 63.

Accept Click to accept the alarm.
For more information, see section 8.5 “Alarm
Assignments” on page 63.

Release Click to release an alarm that is assigned to
you.
For more information, see section 8.5 “Alarm
Assignments” on page 63.

Add comment Click to add a comment to the alarm.
For more information, see section 9.2 “Alarm
Comments” on page 73.

Add cause note Click to add a cause note to the alarm.
For more information, see section 9.5 “Cause
Notes” on page 73.

Add action note Click to add an action note to the alarm.
For more information, see section 9.8 “Action
Notes” on page 74.

Checklist Click to view the checklist of the alarm.
For more information, see section 9.11
“Checklists” on page 75.

Turn off visual and audible alert Click to turn off visual and audible alert.
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Command Description

Attachments Click to open the file or document that is
attached to the alarm.
For more information, see section 8.11 “Alarm
Attachments” on page 66.

Go to alarm object Click to open the settings of the alarm in the
Work area.

Go to source object Click to open the object that triggered the
alarm in the Work area.

View Click to view the history, comments, cause
notes, action notes, or checklists of an alarm
in the work area. For more information, see
section 21.49 “Alarms Pane Context Menu -
View Submenu” on page 262.

Alarm View settings Click to open the Alarm View settings
submenu where you can make a number of
Alarm View settings for the current Alarms
pane or Alarm View. For more information,
see section 21.50 “Alarms Pane Context
Menu - Alarm View Settings Submenu” on
page 263.
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21.49 Alarms Pane Context Menu - View Submenu
Use the View submenu to view the history, comments, cause notes, action notes, or
checklists of an alarm.

Figure – View submenu

Table – View Submenu

Command Description

View history Click to display the historical events of the
alarm. For more information, see section
21.57 “Events Pane and Event View” on page
271.

View comments Click to display comments linked to the alarm.
For more information, see section 9.2 “Alarm
Comments” on page 73.

View cause notes Click to display cause notes linked to the
alarm. For more information, see the Cause
Notes topic on WebHelp.

View action notes Click to display action notes linked to the
alarm. For more information, see the Action
Notes topic on WebHelp.

View checklist Click to display checklists linked to the alarm.
For more information, see the Checklists topic
on WebHelp.
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21.50 Alarms Pane Context Menu - Alarm View Settings
Submenu

Use the Alarm View Settings submenu to change the way alarms are presented.

Figure – Alarm View settings submenu

Table – Alarm View Settings Submenu

Command Description

Display Alarm View on alarm Click to display an Alarm View in a new
window when an alarm is triggered. For more
information, see the Displaying an Alarm View
when an Alarm is Triggered topic on
WebHelp.

Edit standard filter Click to open the Select Conditions dialog
box, where you sort out the information in the
Alarms pane or an Alarm View. For more
information, see section 21.41 “Select
Conditions Dialog Box” on page 251.

Save as standard layout Click to save the current Alarms pane or
Alarm View layout as the standard layout for
all users and for the Alarms pane or the
specific Alarm View.

Reset standard layout to factory default Click to reset the Alarms pane or Alarm View
standard layout to factory default.

Add/Remove columns Click to open the Add/Remove columns
dialog box to add or remove columns from the
Alarms pane or Alarm View. For more
information, see the Add/Remove Columns
Dialog Box topic on WebHelp.

Properties Click to open the Alarm View properties
dialog box to view and edit the properties of
the Alarms pane or Alarm View. For more
information, see the Alarm View Properties
topic on WebHelp.

Alarm state sort order Click to open the Alarm state sort order
dialog box to determine how alarms will be
sorted when the column State is used for
sorting the alarms in the Alarms pane or an
Alarm View. For more information, see section
5.6 “Changing the Alarm State Sort Order” on
page 45.
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Command Description

Detail view Click to open a detailed view for the selected
alarm. For more information, see section
21.51 “Alarm and Event Detail View ” on page
265.
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21.51 Alarm and Event Detail View
Use the Detail view to view all properties of a selected alarm or event.

Figure – Detail view (here, in the Alarms pane)

Table – Alarm and Event Detail View

Component Description

Quick filter Enter a word or a character to filter on. For
more information, see section 5.11 “Quick
Filter ” on page 49.

Property Displays all possible columns of the selected
alarm or event.

Value Displays the value.
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21.52 Alarm State Sort Order Dialog Box
Use the Alarm State Sort Order dialog box to change the order in which alarms of
different states are displayed in the Alarms pane or the Alarm Views in the EcoStruxure
Building Operation software.

Figure – Alarm State Sort Order dialog box

Table – Alarm State Sort Order Dialog Box

Component Description

Click to move the selected alarm state up.

Click to move the selected alarm state down.
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21.53 Favorites Menu
Use the Favorites menu to apply, add, or manage Alarms pane, Events pane, Alarm
View, Event View layout and filter conditions, or List View layout.

Figure – Favorites menu

Table – Favorites Menu

Command Description

Standard Click to return to the Standard layout and filter
conditions.

Favorite name Click to apply the favorite selected in the list.
For more information, see section 8.15
“Favorites” on page 68.

Add to favorites Click to open the Save Favorite dialog box
where you save the current pane or view
layout and filter conditions. For more
information, see section 21.55 “Save Favorite
Dialog Box” on page 269.

Manage favorites Click to open the Manage Favorites dialog
box where you edit the favorite name or delete
a favorite. For more information, see section
21.54 “Manage Favorites Dialog Box” on page
268.
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21.54 Manage Favorites Dialog Box
Use the Manage Favorites dialog box to open the Edit Favorite dialog box where you
edit a favorite name or to delete a favorite from the list of favorites.

Figure – Manage Favorites dialog box

Table – Manage Favorites Dialog Box

Component Description

Delete
Click to delete a selected favorite from
Favorites.

[Quick filter] Enter a favorite name or a part of a favorite
name to limit the number of displayed
favorites in the list. For more information, see
section 5.11 “Quick Filter ” on page 49.
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21.55 Save Favorite Dialog Box
Use the Save Favorite dialog box to save a new Alarms pane, Events pane, Alarm
View, or Event View favorite layout and filter conditions, or to overwrite an existing pane
or View layout and filter conditions by saving it under an existing name.

Figure – Save Favorite dialog box

Table – Save Favorite Dialog Box

Component Description

Name Type a name for the new favorite.

Current favorites Select an existing favorite from the list.
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21.56 Edit Favorite Dialog Box
Use the Edit Favorite dialog box to rename a favorite.

Figure – Edit Favorite dialog box

Table – Edit Favorite Dialog Box

Component Description

Name Type a new name for the favorite.
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21.57 Events Pane and Event View
Use the Events pane and Event Views to view system or individual point events.

Figure – Events pane

Table – Events Pane and Event View

Number Description

Use the paus/play button to pause or resume
showing new events. For more information,
see section 21.58 “Events Pane and Event
View Toolbar” on page 272.

Click to open the period selector where you
select the time and date period for the events
you want to display.

Use the Quick filter to enter a word to filter on.
For more information, see section 5.11 “Quick
Filter ” on page 49.

Use the columns to sort, hide, or show
information about the events. For more
information, see the Add/Remove Columns
Dialog Box topic on WebHelp.

Use the Detail view to display all information
about a selected event.
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21.58 Events Pane and Event View Toolbar
Use the Events pane and Event View toolbar to manage the events.

Table – Events Pane and Event View Toolbar

Button Description

Click to stop showing new events.

Click to start showing new events.

Event filter
Click to select the conditions for the event
display. For more information, see section
21.41 “Select Conditions Dialog Box” on page
251.

Favorites
Click to open the Favorites menu where you
select, add, and manage favorites.

Click to open the period selector where you
select the time and date period for the events
you want to display.

Quick filter Enter a word or a character to filter on. For
more information, see section 5.11 “Quick
Filter ” on page 49.
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21.59 Events Pane Context Menu
Use the Events pane context menu to pause or resume the reading of events and to
access the Event View settings.

Figure – Events pane context menu

Table – Events Pane Context Menu

Command Description

Pause Click to pause the reading of events.

Resume Click to resume the reading of events.

Find related events Click to find events related to an event that
occurred on an object that uses Change
Control. For more information, see the
Change Control topic on WebHelp.

Event View settings Click to open the Event View Settings
submenu where you can make a number of
Event View settings for the current Events
pane or Event View. For more information,
see section 21.60 “Events Pane Context
Menu - Event View Settings Submenu” on
page 274.
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21.60 Events Pane Context Menu - Event View Settings
Submenu

Use the Event View settings submenu to change the way events are presented.

Figure – Event View settings submenu

Table – Event View Settings submenu

Command Description

Edit event filter Click to open the Select conditions dialog
box where you sort the information in the
Events pane or an Event View. For more
information, see section 21.41 “Select
Conditions Dialog Box” on page 251.

Save as standard layout Click to save the current Events pane or Event
View layout as the standard layout for all
users and for the Events pane or the specific
Event View.

Reset standard layout to factory default Click to reset the Events pane or Event View
standard layout to factory default.

Add/Remove columns Click to open the Add/Remove columns
dialog box to add or remove columns from the
Events pane or Event View. For more
information, see the Add/Remove Columns
Dialog Box (Events) topic on WebHelp.

Properties Click to open the Event View dialog box to
view and edit the properties of the Events
pane or Event View. For more information,
see the Event View Properties topic on
WebHelp.

Edit the style of associated events Click to open the Event Styles dialog box
where you edit the style of a certain event. For
more information, see the Event Styles Dialog
Box topic on WebHelp.

Detail view Click to open a detail view for the selected
event. For more information, see section
21.51 “Alarm and Event Detail View ” on page
265.
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21.61 Trend Chart View
Use the Trend Chart view to graphically display trend log records and events.

Figure – Trend chart view

Table – Trend Chart View

Number Description

Use the Series tab shortcut menu to manage
the appearance of a trend log series. For
more information, see the Series Tab Context
Menu topic on WebHelp.

Use the trend chart toolbar to adjust the
visible trend chart area. For more information,
see section 21.62 “Trend Chart Toolbar” on
page 276.

Use the trend log event icons to get
information about a specific record. For more
information, see section 21.63 “Trend Chart
Event Icons” on page 278.

Use the navigation bar to horizontally adjust
the visible trend chart area. For more
information, see section 21.64 “Trend Chart
Navigation Bar” on page 281.
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21.62 Trend Chart Toolbar
Use the Trend Chart toolbar to manage the trend chart and its series.

Table – Trend Chart Toolbar

Button Description

Reset zoom
Click to reset the trend chart to its original size
in the database.

Pointer
Click to point to log records in the trend chart
or to scroll vertically with the mouse wheel.

Scroll trend chart vertical
Click to activate vertical scroll. Drag the chart
area upwards or downwards to scroll the y-
axis vertically.

Zoom in
Click to increase the scale of the trend chart
or drag to magnify an area in the trend chart.

Zoom out
Click to decrease the scale of the trend chart.

Show one hour
Click to set the scale of the x-axis to one hour.

Show one day
Click to set the scale of the x-axis to one day.

Show one week
Click to set the scale of the x-axis to one
week.

Show one month
Click to set the scale of the x-axis to one
month.

Show one year
Click to set the scale of the x-axis to one year.

Show nearest information on every series
Click to show values of every trend chart
series at a specific time.

Show events
Click to display or hide the events.
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Button Description

Open trend chart settings
Opens the Trend chart settings dialog box
for the trend chart where you can configure
the trend chart series, axes, and calculations.
For more information, see the Trend Chart
Settings Dialog Box – Axes Tab topic on
WebHelp.
For more information, see the Trend Chart
Settings Dialog Box – X Axis Tab topic on
WebHelp.

View in multi trend log list
Opens the trend chart in a multi trend log list.
For more information, see the Multi Trend Log
List View topic on WebHelp.
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21.63 Trend Chart Event Icons
Use the Trend Chart event icons to get information on different trend log events.

Table – Trend chart event icons

Icon Description

Log was started
Indicates that the trend log started recording
values.

Log was stopped
Indicates that the trend log stopped recording
values.

The log is not configured
Indicates that the trend log is not correctly
configured or preferences are missing, so the
trend log cannot start recording values.

A log value was missed
Indicates that one or more records were
missed due to interrupted communication,
hardware failure, or software failure.

The log configuration was updated
Indicates that the settings of the trend log
were updated. The change is described in the
ToolTip of the event.

Record was added
Indicates that a record was manually added.
The new value is described in the event
ToolTip.

Record was edited
Indicates that a record was manually edited.
The change is described in the ToolTip of the
event.

Record was added and commented
Indicates that a record was manually added
and commented. The new value and
comment are described in the ToolTip of the
event.

Record was edited and commented
Indicates that a record was manually edited
and commented. The changes are described
in the ToolTip of the event.

Record was commented
Indicates that a record was commented. The
comment is shown in the ToolTip of the event.

Log was cleared
Indicates that a trend log was cleared.
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Icon Description

Meter was changed
Indicates that the meter was changed or that
the settings were configured. This icon only
applies to the meter trend log.

Values exist outside the viewable area
Indicates that values exist before the values
displayed in the trend chart area.

Values exist outside the viewable area
Indicates that values exist after the values
displayed in the trend chart area.

INF value was logged
Indicates that a positive Infinity value was
logged.

-INF value was logged
Indicates that a negative Infinity value was
logged.

NaN value was logged
Indicates that an unknown value ("Not a
Number") was logged.

Null value was logged
Indicates that a Null value was logged.

System clock changed
Indicates that the system date and time of the
EcoStruxure BMS server where the trend log
is located has been changed. For more
information, see the Time and Time Zone
topic on WebHelp.

Override
Indicates that the recorded value is overridden
by the hardware and is not the measured
value. For more information, see the Output
Override Status topic on WebHelp.
Forced
Indicates that the recorded value is forced by
the software and is not the measured value.
For more information, see the Forced I/O
Point Values topic on WebHelp.

Log database restored
Indicates that the log database has been
restored and that, when the log restarts, there
can be a time gap in the log series.

Log reset by extended log
Indicates that the log has been cleared by the
extended trend log due to a log database
restore.
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Icon Description

Transfer was missed
Indicates that the extended trend log has miss
records between fetches. That is, the
monitored log has created and lost records
before the extended trend log has been able
to fetch the records.
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21.64 Trend Chart Navigation Bar
Use the Trend Chart navigation bar to horizontally scroll the trend chart.

Table – Trend Chart Navigation Bar

Component Description

Log start
Click to scroll back to the first value of the
trend chart in WorkStation.

Fast backward
Click to scroll fast backward.

Backward
Click to scroll back.

Live update Select to have the trend chart automatically
adjust itself according to the latest trend log
record in WorkStation.

Forward
Click to scroll forward.

Fast forward
Click to scroll fast forward.

Current time
Click to scroll forward to the latest value of the
trend chart in WorkStation.
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21.65 Schedule Editor – Basic View
Use the Basic view to create weekly and exception events for a schedule.

Figure – Basic Schedule Editor

Table – Basic Schedule Editor

Number Description

Calendar view
Displays the calendar with exception events in blue. For more information, see
section 16.2 “Basic View of the Schedule Editor” on page 152.

Basic View toolbar
Displays the toolbar to manage schedules. For more information, see section
21.66 “Basic Schedule Editor Toolbar ” on page 283.

Event grid
Displays weekly and exception events in Graphic view.
An Unable to display events error message displays when there is any
scheduled event (weekly or exception) less than 5 minutes in length on a
particular day. To view or change this scheduled event, use the Text view in
the Advanced Tab. For more information, see the Modifying a Schedule Using
the Text View topic on WebHelp.
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21.66 Basic Schedule Editor Toolbar
Use the Basic Schedule Editor toolbar to manage schedules.

Table – Basic Schedule Editor Toolbar

Button Description

New schedule event
Click to create a new schedule event.

Edit schedule events
Click to edit a selected event.

Delete
Click to delete events in the schedule.

View all schedule events
Click to display weekly and exception events for the selected week.

View weekly schedule events
Click to display weekly events.
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21.67 Edit Exception Dialog Box
Use the Edit Exception dialog box to add or edit an exception event in the Advanced
Schedule Editor.

Figure – Edit Exception dialog box

Table – Edit Exception Dialog Box

Component Description

Exception name Type a name for the exception event.

Exception
priority

Select a priority for the exception event. Valid values are from 1-16, 1
being the highest priority.

Period type Select a time category to associate with the schedule event.

Period object Enter the event associated with the period type.
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21.68 Analog Schedule Properties – Basic Tab
Use the Basic tab to view the schedule status information and to configure the
schedule.

Figure – Analog Schedule properties – Basic tab

Table – Analog Schedule Properties – Basic Tab

Component Description

Value Select the value associated with the event.

Previous transition time Displays the date and time the value most
recently changed.

Time since previous transition (min) Displays the amount of time in minutes that
has elapsed since the value last changed,
rounded to the next minute.

Next transition valuea Displays what the Value property will be when
it next changes.

Next transition timea Displays the date and time the value will
change.

Time to next transition (min)a Displays the amount of time in minutes before
the value changes.
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Continued

Component Description

Following transition valuea Displays the subsequent value following the
next transition value.

Following transition timea Displays the subsequent date and time
following the next transition time.

Time to following transition (min)a Displays the amount of time in minutes before
the value changes to the following transition
value.

Remove past events Select True to enable the system to delete
events older than 72 hours.

Effective period Enter the range of time a schedule is in
service.

Default value Select the value of the schedule when there
are no events in effect.

Lead object Select a lead schedule to reference.

a) The schedule only looks 8 days into the future to obtain this value. If there is no transition in the next 8
days, the maximum date and time will be displayed.
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21.69 Schedule Event Properties Dialog Box – Weekly View
Use the Weekly View in the Schedule Event Properties dialog box in the Basic
Schedule Editor to create a new weekly event for an existing schedule.

Figure – Schedule Event Properties dialog box - weekly view

Table – Schedule Event Properties Dialog Box – Weekly View

Component Description

Event type Click Weekly to select a weekly event type.

Days of week Select the days of the week that apply to this
schedule.

Click to add a line to the Times and values
box.

Click to delete an entry from the Times and
values box.
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Continued

Component Description

All day Select to create an all day event.
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21.70 Schedule Event Properties Dialog Box – Single Date
Exception View

Use the Single Date Exception view in the Schedule Event Properties dialog box to
schedule a single date exception.

Figure – Schedule Event Properties dialog box - Single date exception view

Table – Schedule Event Properties Dialog Box – Single Date Exception View

Component Description

Event type Click Exception to display the exception
types.

Exception type Select Single date for the exception type to
apply to the schedule.

Click to add a line to the Times and values
box.
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Component Description

Click to delete an entry from the Times and
values box.

All Day Select to create an all day event.

Name Type a name for the exception event.

Priority Select a priority number between 1 (highest
priority) and 16 (lowest priority).

Year Select a year. You can use Any year as a
valid entry.

Month Select a month for the exception event or Odd
month, Even month, Any month.

Day of month Select a value for the day of the month. You
can use Any Day, Last day, Odd days or
Even days as valid entries.

Day of week Select a day of the week. Setting the value to
Any Day ensures consistency with the rest of
the date specification, this is the
recommended setting.
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21.71 Schedule Event Properties Dialog Box – Date Range
Exception View

Use the Date Range Exception view in the Schedule Event Properties dialog box to
schedule a date range exception.

Figure – Schedule Event Properties dialog box - Date range exception view

Table – Schedule Event Properties Dialog Box – Date Range Exception View

Component Description

Event type Click Exception to display the exception
types.

Exception type Select Date range as an exception type to
apply to the schedule.

Click to add a line to the Times and values
box.
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Continued

Component Description

Click to delete an entry from the Times and
values box.

All Day Select to create an all day event.

Name Type a name for the event.

Priority Select a priority number between 1 (highest
priority) and 16 (lowest priority).

Year Select a year. You can use Any year as a
valid entry.

Month Select a month for the exception event or Odd
month, Even month, Any month.

Day of month Select a value for the day of the month. You
can use Any Day, Last day, Odd days or
Even days as valid entries.

Day of week Select a day of the week. Setting the value to
Any Day ensures consistency with the rest of
the date specification, this is the
recommended setting.
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21.72 Schedule Event Properties Dialog Box – Calculated
Exception View

Use the Calculated Exception view in the Schedule Event Properties dialog box to
schedule recurring exceptions.

Figure – Schedule Event Properties dialog box - Calculated exception view

Table – Schedule Event Properties Dialog Box – Calculated Exception View

Component Description

Event type Click Exception to display the exception
types.

Exception type Select Calculated for an exception type to
apply to the schedule.

Click to add a line to the Times and values
box.
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Component Description

Click to delete an entry from the Times and
values box.

All Day Select to create an all day event.

Name Type a name for the event.

Priority Select a priority number between 1 (highest
priority) and 16 (lowest priority).

Year Displays Any Year which is the default for the
calculated exception view.

Month Select a month for the exception event or Odd
month, Even month, Any month.

Week of month Select a week of the month for the exception
event or First week, Second week, Third
week, Fourth week, Last week, Any week.

• First week – the first through the
seventh day of the month. The second
week is then considered day of month
eight through fourteen and so on. Since
the dates do not necessarily correspond
to the first row of the calendar, they may
include dates from both the first and
second row of the calendar.

• Fifth week – days 29 through 31 if they
exist. It is always less than seven days
and is non-existent in February except in
a leap year.

• Last week – the last seven days of the
month. It differs from the Fifth week.

Week of month Select a week of the month for the exception
event or First week, Second week, Third
week, Fourth week, Last week, Any week.

• First week – the first through the
seventh day of the month. Be aware that
it does not necessarily correspond to the
first row of the calendar since it may
include dates from both the first and
second row of the calendar.

• Fifth week – days 29 through 31 if they
exist. It is always less than seven days
and is non-existent in February except in
a leap year.

• Last week – the last seven days of the
month. It differs from the Fifth week.

Day of week Select a day of the week. Setting the value to
Any Day ensures consistency with the rest of
the date specification, this is the
recommended setting.
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21.73 Schedule Event Properties Dialog Box – Calendar
Reference View

Use the Calendar Reference view in the Schedule Event Properties dialog box to
reference a calendar to apply to your schedule.

Figure – Schedule Event Properties dialog box - Calendar reference view

Table – Schedule Event Properties Dialog Box – Calendar Reference View

Component Description

Event type Click Exception to display the exception
types.

Exception type Select Calendar to initiate a calendar
reference.

Click to add a line to the Times and values
box.
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Component Description

Click to delete an entry from the Times and
values box.

All Day Select to create an all day event.

Name Type a name for the event.

Priority Select a priority number between 1 (highest
priority) and 16 (lowest priority).

Calendar Select a calendar to reference.
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21.74 Calendar Editor View
Use the Calendar Editor view to manage the calendar events for the calendar.

Figure – Calendar Editor view

Table – Calendar Editor View

Number Description

Click to expand the list of calendar events that are included in the calendar. For
more information, see section 18.3 “Calendar Events” on page 179.

Use the Calendar Editor toolbar to add and delete calendar events. For more
information, see section 21.75 “Calendar Editor Toolbar” on page 298.

Select the year you want the calendar to display.

Click to scroll the calendar one month at the time.

Displays the calendar for the selected twelve-month period with the dates for
the calendar events shown in blue. For more information, see section 18.2
“Calendar Editor Overview” on page 178.
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21.75 Calendar Editor Toolbar
Use the Calendar Editor toolbar to manage calendars.

Table – Calendar Editor Toolbar

Button Description

Add Date
Click to add an event that occurs on a single day. For more information, see
section 21.76 “Edit Calendar Entry Dialog Box – Add Date” on page 299.

Add Date Range
Click to add an event that contains a date range. For more information, see
section 21.77 “Edit Calendar Entry Dialog Box – Date Range ” on page 300.

Add Calculated Date
Click to add an event that recurs on a regular basis. For more information, see
section 21.78 “Edit Calendar Entry Dialog Box – Calculated Date ” on page
301.

Delete
Click to delete events in the schedule.
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21.76 Edit Calendar Entry Dialog Box – Add Date
Use the Edit Calendar Entry dialog box to configure a calendar entry for a single date
exception event.

Figure – Edit Calendar Entry dialog box - add date

Table – Edit Calendar Entry Dialog Box – Add Date

Component Description

Entry name Type an entry name for the calendar entry.

Year Select a Year for the date calendar entry. You can also use Any Year as
a valid entry.

Month Select a month for the exception event or Odd month, Even month, Any
month.

Day of month Select a value for the day of the month. You can use Any Day, Last day,
Odd days or Even days as valid entries.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.
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21.77 Edit Calendar Entry Dialog Box – Date Range
Use the Edit Calendar Entry dialog box to configure a date range calendar entry for an
exception event.

Figure – Edit Calendar Entry dialog box - date range

Table – Edit Calendar Entry Dialog Box – Date Range

Component Description

Entry name Type an entry name for the calendar entry.

Start year Select a year. You can use Any year as a valid entry.

Start month Select a month for the exception event or Odd month, Even month, Any
month.

Day of month Select a value for the day of the month. You can use Any Day, Last day,
Odd days or Even days as valid entries.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.

Year Select a year. You can use Any year as a valid entry.

Month Select a month for the exception event or Odd month, Even month, Any
month.



WorkStation User Interface

30104-50007-01-en, December 2022

WorkStation

21.78 Edit Calendar Entry Dialog Box – Calculated Date
Use the Edit Calendar Entry dialog box to create a calendar entry for a recurring
exception event.

Figure – Edit Calendar Entry dialog box - calculated date

Table – Edit Calendar Entry Dialog Box – Calculated Date

Component Description

Entry name Type an entry name for the calendar entry.

Month Select a month for the exception event or Odd month, Even month, Any
month.

Week of month Select a week of the month for the exception event or First week,
Second week, Third week, Fourth week, Last week, Any week.

• First week – the first through the seventh day of the month. Be
aware that it does not necessarily correspond to the first row of the
calendar since it may include dates from both the first and second
row of the calendar.

• Fifth week – days 29 through 31 if they exist. It is always less than
seven days and is non-existent in February except in a leap year.

• Last week – the last seven days of the month. It differs from the
Fifth week.

Day of week Select a day of the week. Setting the value to Any Day ensures
consistency with the rest of the date specification, this is the
recommended setting.
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21.79 Graphics Toolbar
Use the Graphics toolbar to navigate, zoom, and print a graphic.

Table – Graphics Toolbar

Button Description

Reset Zoom
Click to restore the graphic to its original size.

Navigate
Click to activate the pointer in the graphic.
Use the pointer to change values, change the
status of a digital value, or open links and
attachments.

Scroll
Click to move the graphic vertically or
horizontally.

Zoom In
Click to increase the scale of the graphic.

Zoom Out
Click to decrease the scale of the graphic.

Print
Click to print a graphic.

Print Setup
Click to open the Print setup dialog box.

Print Preview
Click to preview a printout of a graphic.

21.80 Commit Page
The Commit Page displays the progress indication.
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Figure – Commit page

Table – Commit Page

Component Description

[Progress bar] Displays the progress indication.



WorkStation User Interface

304 04-50007-01-en, December 2022

WorkStation

21.81 Building Operation WorkStation Error
Use the Building Operation WorkStation Error dialog box to send a file with
information about the cause of the crash to Schneider Electric.

Figure – Building Operation WorkStation Error

Table – Building Operation WorkStation Error

Component Description

More info Click to get more information on the cause of
the crash.

Copy to Clipboard Click to copy information about the cause of
the crash to the Windows clipboard.

Send report Click to send the crash report to Schneider
Electric.

Close program Click to close the program without sending
any crash report.

Continue Click to resume the program. This option is
only available when the program is able to
resume after a crash, which is not typically the
case.
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